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About this Guide

This publication is part of a document suite that supports the Hewlett-Packard (HP) 
StorageWorks Director 2/64, Director 2/140, Edge Switch 2/16, Edge Switch 2/32, 
Edge Switch 2/24, and High Availability Fabric Manager (HAFM) application.

Intended Audience
This publication is intended for data center administrators, LAN administrators, 
operations personnel, and customer support personnel who administer user access to 
this application and monitor and manage product operation.

Related Documentation
For a list of corresponding documentation, see the Related Documents section of the 
Release Notes that came with the product.

For the latest information, documentation, and firmware releases, please visit the 
following StorageWorks website:

http://h18006.www1.hp.com/storage/saninfrastructure.html

For information about Fibre Channel standards, visit the Fibre Channel Association 
website, located at http://www.fibrechannel.org.

http://h18006.www1.hp.com/storage/saninfrastructure.html

http://www.fibrechannel.org
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Document Conventions
The conventions included in Table 1 apply.

Symbols in Text
These symbols may be found in the text of this guide. They have the following 
meanings.

WARNING:  Text set off in this manner indicates that failure to follow directions 
in the warning could result in bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow directions could 
result in damage to equipment or data.

IMPORTANT:  Text set off in this manner presents clarifying information or specific instructions.

NOTE:  Text set off in this manner presents commentary, sidelights, or interesting points of 
information.

Table 1:  Document Conventions

Element Convention

Cross-reference links Blue text: Figure 1

Key names, menu items, buttons, and 
dialog box titles

Bold

File names, application names, and text 
emphasis

Italics

User input, command names, system 
responses (output and messages)

Monospace font

COMMAND NAMES are uppercase 
unless they are case sensitive

Variables Monospace, italic font

Website addresses Sans serif font (http://thenew.hp.com)

http://thenew.hp.com
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Symbols on Equipment

Any enclosed surface or area of the equipment marked with these 
symbols indicates the presence of electrical shock hazards. Enclosed 
area contains no operator serviceable parts. 

WARNING: To reduce the risk of injury from electrical shock hazards, do 
not open this enclosure.

Any RJ-45 receptacle marked with these symbols indicates a network 
interface connection.

WARNING: To reduce the risk of electrical shock, fire, or damage to the 
equipment, do not plug telephone or telecommunications connectors into 
this receptacle.

Any surface or area of the equipment marked with these symbols 
indicates the presence of a hot surface or hot component. Contact with 
this surface could result in injury. 

WARNING: To reduce the risk of injury from a hot component, allow the 
surface to cool before touching.

Power supplies or systems marked with these symbols indicate the 
presence of multiple sources of power. 

WARNING: To reduce the risk of injury from electrical shock, 
remove all power cords to completely disconnect power from the 
power supplies and systems.
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Any product or assembly marked with these symbols indicates that the 
component exceeds the recommended weight for one individual to 
handle safely.

WARNING: To reduce the risk of personal injury or damage to the 
equipment, observe local occupational health and safety requirements 
and guidelines for manually handling material.

Rack Stability

WARNING:  To reduce the risk of personal injury or damage to the equipment, be 
sure that:
• The leveling jacks are extended to the floor.
• The full weight of the rack rests on the leveling jacks.
• In single rack installations, the stabilizing feet are attached to the rack.
• In multiple rack installations, the racks are coupled.
• Only one rack component is extended at any time. A rack may become 

unstable if more than one rack component is extended for any reason.

Getting Help
If you still have a question after reading this guide, contact an HP authorized service 
provider or access our website: http://thenew.hp.com.

HP Technical Support

In North America, call technical support at 1-800-652-6672, available 24 hours a day, 
7 days a week.

NOTE:  For continuous quality improvement, calls may be recorded or monitored.

Outside North America, call technical support at the nearest location. Telephone 
numbers for worldwide technical support are listed on the HP website under support: 
http://thenew.hp.com/country/us/eng/support.html.

Be sure to have the following information available before calling:

• Technical support registration number (if applicable)

http://thenew.hp.com

http://thenew.hp.com/country/us/eng/support.html
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• Product serial numbers

• Product model names and numbers

• Applicable error messages

• Operating system type and revision level

• Detailed, specific questions

HP Website

The HP website has the latest information on this product, as well as the latest drivers. 
Access storage at: http://thenew.hp.com/country/us/eng/prodserv/storage.html. From this 
website, select the appropriate product or solution.

HP Authorized Reseller
For the name of your nearest HP Authorized Reseller:

• In the United States, call 1-800-345-1518

• In Canada, call 1-800-263-5868

• Elsewhere, see the HP website for locations and telephone numbers: 
http://thenew.hp.com.

http://thenew.hp.com/country/us/eng/prodserv/storage.html
http://thenew.hp.com
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1
Introduction and General Information

This chapter presents an overview of the High Availability Fabric Manager (HAFM).It 
includes:

• An introduction to using HAFM.

• Information on how to access HAFM.

Introduction to High Availability Fabric Management
The High Availability Fabric Manager (HAFM) is a Java-based graphical user 
interface (GUI) that enables the user to manage users and products, monitor products, 
and open Product Managers.

NOTE:  Although the HAFM and Product Managers are separate applications, the Product 
Managers are only accessible through the HAFM.

The HAFM and Product Managers are installed on the HAFM server to provide local 
access to managed products. These applications can also be installed on remote user 
workstations to provide remote access to the managed products through the HAFM 
server. A maximum of eight concurrent remote users (in addition to the local HAFM 
server user) can log in to the High Availability Fabric Manager application. For details 
on configuring remote workstations, refer to the appendix in this guide that covers 
your workstation operating system. 

Besides the HAFM and Product Managers on the HAFM server, out-of-band 
(non-Fibre Channel) management access to HP products is provided through the 
following:

• Management using simple network management protocol (SNMP). An SNMP 
agent is implemented through the HAFM application that allows administrators on 
SNMP management workstations to access product management information 
using any standard network management tool. Administrators can assign Internet 
Protocol (IP) addresses and corresponding community names for up to six SNMP 
workstations functioning as SNMP trap message recipients. 
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• Management through the Internet using the EWS interface installed on the 
Director or Switch. This interface supports configuration, statistics monitoring, 
and basic operation of the product, but does not offer all the capabilities of the 
corresponding Product Manager application. Administrators launch the web 
server interface from a remote PC by entering the product’s IP address as the 
Internet uniform resource locator (URL), then entering a user name and password 
at a login screen. The PC browser then becomes a management console.

• Management through a PC-based Telnet session using the command line interface 
(CLI). Any platform that supports Telnet client software can be used.

Figure 1–1 illustrates an example of out-of-band product management. In the figure, 
the managed product is a Director 2/64. The “customer intranet” could be as simple as 
an HP Ethernet hub to connect these devices.

Figure 1–1:  Out-of-Band product management

1 SNMP management workstation 
or remote user workstation

2 HAFM server

3 Web browser

4 Director 2/64

StorageWorks SAN 6064

SHR-2314

Customer Intranet
(10/100 Mbps)

Customer Intranet
(10/100 Mbps)

Internet

Connection

1
2

3

4
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HAFM Server Information

The HAFM server is a personal computer (PC) platform that provides a central point 
of control for managed Fibre Channel products. The HAFM server is required for 
installing, configuring, and managing these products. 

NOTE:  Although products can perform normal operations without an HAFM server, the HAFM 
server should operate at all times to monitor product operations, report failures, log event 
changes, and log configuration changes.

High Availability Fabric Manager Overview
This section provides a general overview of the HAFM features.

Logging in to the High Availability Manager

The HAFM starts automatically when the HAFM server is powered on. If it is 
necessary to start the application yourself, perform the following steps.

1. Turn on the HAFM server, or if the server is already turned on, double-click the 
HAFM icon on the desktop.

The High Availability Fabric Manager application opens.

2. In the HAFM Login dialog box (Figure 1–2 on page 1-4), enter your user name 
and password in the User Name and Password fields. User names and passwords 
are case-sensitive. 

NOTE:  If user names have not been established, you can use the default user name 
(Administrator) and password (password). The user name and password are case-sensitive. HP 
recommends that you change the default password as soon as possible.

To add or modify user names, passwords, and user rights, refer to the appropriate 
sections under Users on page 3-8.
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Figure 1–2:  High Availability Fabric Manager Login dialog box

3. In the HAFM Server field, type or choose the HAFM server to which you want to 
connect. If you are logging in to the local HAFM server, the HAFM server name 
is localhost.

The default address that displays in the HAFM Server box is the address of the 
last server accessed. Click the HAFM server arrow to see the network addresses of 
all HAFM servers that were accessed from the computer you are logged into.

If you want to connect to an HAFM server that is not listed, enter the server name 
or IP address in the HAFM server field.
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4. Click Login.

The main HAFM window displays the Product View (Figure 1–3).

Figure 1–3:  High Availability Fabric Manager main window

1 Menu Bar. For details, refer to Chapter 3, Using the Menu Bar.

2 Tool Bar. For details, refer to Tool Bar on page 2-3.
3 View Tabs. For details, refer to Main Panel on page 2-8.

4 Main Panel. For details, refer to Main Panel on page 2-8.

5 Status Panel. For details, refer to Status Bar on page 2-11.
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Accessing Remote HAFM Servers

To access remote HAFM servers, enter the server’s network address or DNS host 
name in the HAFM Login dialog box. If you are already logged in to the HAFM and 
want to access this dialog box, choose Logout from the Product menu.

Figure 1–4:  High Availability Fabric Manager Login dialog box

1. In the HAFM Login dialog box, enter your user name and password. 

NOTE:  If user names have not been established, you can use the default user name 
(Administrator) and password (password). The user name and password are case-sensitive. We 
recommend that you change the default password as soon as possible.

2. Delete the existing host name or IP address in the HAFM Server field, and enter or 
choose a valid HAFM server IP address or host name.

3. Click Login.

If the HAFM window displays, you have logged in to the server. The server network 
address you entered will remain in the HAFM server list for future logins. If you fail 
to connect to the HAFM server, the network address will not remain in the list.
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Managing Remote Access to the HAFM Server

Users at the HAFM server can open the HAFM and Product Managers loaded on the 
server itself. Users at remote PC workstations can also access the same HAFM server 
or other HAFM servers if the workstations meet minimum hardware and software 
requirements and are running the HAFM application. Workstations must also be 
configured to connect with the HAFM server over a TCP/IP network connection.

Figure 1–1 on page 1-2 illustrates a remote user workstation connected to the HAFM 
server through a LAN. Please note that this is an example configuration only. 

Operators at remote workstations can manage and monitor all products controlled by 
the HAFM server. Each active connection between a remote workstation and an 
HAFM server and managed products is called a session. A maximum of nine 
concurrent remote users (eight remote and one local HAFM server user) can log in to 
the HAFM application.

Requirements for Remote Workstations

The HAFM is downloaded and installed on user workstations from the HAFM server. 
The remote workstations can be Windows 95, Windows 98, Windows 2000, Windows 
XP, HP-UX, AIX, Linux, or Solaris systems.

For the minimum system requirements for remote workstations, refer to the appendix 
in this guide for the appropriate operating system:

• Appendix B for Windows.

• Appendix C for Solaris.

• Appendix D for HP-UX, AIX, and Linux.

Installing Software on Remote Workstations

For procedures to install HAFM software on remote user workstations and configure 
the workstations for connection to an HAFM server, refer to the appendix in this guide 
for the appropriate operating system.

• Appendix B for Windows.

• Appendix C for Solaris.

• Appendix D for HP-UX, AIX, and Linux.
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Displaying Remote Sessions

A maximum of nine concurrent users (eight remote and one local HAFM server user) 
can log in to the HAFM application. Display the current active sessions for the HAFM 
server that you are logged into via the User Sessions dialog box.

To display the User Sessions dialog box:

1. From the View menu, choose User Sessions. 

The User Sessions dialog box displays.

Figure 1–5:  User Sessions dialog box

The User Sessions dialog box displays active session information in this format:

• User — The name of the current user (in Figure 1–5, Administrator).

• Network Address — The network address of the current user.

• Connection Established — The date and time that the session was established.

Backing Up and Restoring Data

The backup and restore of critical HAFM data on the Windows system is provided by 
the Iomega QuikSync application, which is installed on the HAFM server when you 
install the Iomega Zip drive.

Backup

During installation, QuikSync is automatically configured to mirror the contents of the 
HAFMData directory to the Zip drive any time the contents of that directory change or 
the server is restarted. Therefore, whenever you make a configuration change, add or 
remove a managed product, or make any other changes through the HAFM, the data in 
this directory is automatically backed up. The existing backup file is updated; no 
separate versions of the backup file are maintained.

NOTE:  To ensure trouble-free backups, it is imperative that you leave the Zip drive installed in 
the HAFM server and leave a Zip disk in that drive.
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When you log into Windows on the HAFM server, QuikSync starts automatically. Any 
data that has changed in the HAFMData directory while you were logged out will 
automatically be backed up.

The backed up data includes: 

• All HAFM configuration (product definitions, user names, encrypted passwords, 
user rights, nicknames, session options, SNMP configuration, e-mail addresses, 
etc.).

• Logs, both for the HAFM and any Product Managers.

• Zoning library, including all zone sets and zone definitions.

• Firmware library.

• Call-home configuration information.

Since the configuration data for each individual product is stored in NVRAM on the 
product itself, there is a separate backup option provided in each Product Manager to 
save the product configuration to the HAFM server. If you perform a product 
configuration backup through the Product Manager, the configuration data is stored in 
the HAFMData directory and automatically mirrored to the QuikSync Zip disk.

The QuikSync application will not back up certain Windows configurations that need 
to be reconfigured on a newly-restored HAFM server, including:

• Windows user names and passwords.

• TCP/IP network configuration (IP address, Gateway address, DNS names, and so 
forth.)

You should use other means to back up this type of information.

The QuikSync application is included on the HAFM Applications CD, and 
automatically installed on the HAFM server during installation. A Zip disk dedicated 
to QuikSync is needed for each HAFM server and is included with the HAFM 
installation package.
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Using QuikSync

QuikSync is functioning to back up data when the QuikSync icon displays in the 
system tray in the right corner of the Windows task bar (Figure 1–6). This icon spins 
when data is writing to the Zip disk.

Figure 1–6:  QuikSync icon in Windows system tray

If an icon does not display, you must enable the application using the procedure in the 
next section, Enabling QuikSync.

Enabling QuikSync

1. From the Windows Start menu, choose Programs > Iomega QuikSync > 
QuikSync.

The Iomega QuikSync dialog box displays.

2. Click On to enable QuikSync.

3. Click OK.

QuikSync Settings

Do not change the default settings for automatic backup of the HAFMData directory. 
If you feel that QuikSync is not functioning properly, check the settings using the 
following steps:

1. Open the QuikSync dialog box using one of these steps.

— From the Windows Start menu, choose Programs > Iomega QuikSync > 
QuikSync.

— Double-click the QuikSync icon on the Windows system bar in the lower 
right corner of the Windows desktop.

— Right-click the QuikSync icon and choose Settings from the menu.

2. Verify that the dialog box shows the QuickSync On radio button enabled and the 
Source is c:\HAFMData.



Introduction and General Information

ha-fabric manager user guide 1–11

3. Click the Advanced tab. The following dialog box displays:

Figure 1–7:  Iomega QuikSync dialog box (Advanced tab)

4. Verify that the dialog box is configured exactly as displayed in Figure 1–7.

5. Click OK.

Restore

In the event of a system failure, you will be able to return your database to a known 
state. To restore data from the backup disk to the HAFM server:

1. Close down the HAFM application.

2. Click the Windows Start button, then click Programs > Windows Explorer.

The Exploring window displays.

3. Copy the contents of the HAFMData directory on the Zip disk to the HAFM root 
directory (typically c:\HAFMData).

4. Close the Exploring window. Leave the Zip disk in the drive for QuickSync 
backup.
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5. Restart the HAFM server:

a. On the Windows taskbar, click Start > Shut Down.

b. On the Shut Down Windows dialog box, click Restart the Computer and 
click Yes.

c. When prompted, simultaneously press Ctrl+Alt+Delete to display the Logon 
Information dialog box.

d. Type your user name and password and click OK.

6. When the HAFM Login screen displays, enter your user name and password. 
Make sure that localhost is selected in the HAFM server field.

7. Click Login to open the HAFM.

HAFM Menu Options

This user’s guide provides information on the management options on the HAFM 
application only. Information on the Product Manager application is provided in the 
Product Manager user guide for your Switch or Director. Following are lists of options 
available under navigation control panel menus in all three applications. References 
are provided to the correct publication for detailed information on these options.

High Availability Fabric Manager

The following options are available through the HAFM. For more information about 
these options, refer to Chapter 3, Using the Menu Bar.

View Tabs

• Products

• Fabrics

Products Menu

• New

• Open

• Delete

• Modify

• Properties
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• Logout

• Exit

Fabrics Menu

• Rename

• Persist Fabric Topology

• Unpersist Fabric Topology

• Export Fabric Topology

• Show Route

• Hide Route

• Show Zone Members

• Show View Port

• Show Fabric Tree

• Enterprise Fabrics Mode (active if SANtegrity installed)

• Fabric Binding (active if SANtegrity installed)

View Menu

• User Sessions

• Zoom

— In

— Out

— Default

— Fit in View

• Arrange Icons

— By Name

— By Severity

• Layout Icons

— Circular

— Spring
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• Center in Topology

• Clear ISL Alert

• Clear All ISL Alerts

• Enable Fly Over Display

Configure Menu

• Users

• Nicknames

• Sessions

• SNMP Agent

• Activate Zone Set

• Zoning Library

• Advanced Zoning

— Deactivate Zone Set

— Configure Default Zone

Logs Menu

• Audit Log

• Event Log

• Session Log

• Product Status Log

• Fabric Log

Maintenance Menu

• Configure E-Mail

• Test Remote Notification

• Configure Ethernet Events

• Configure Call Home Event Notification
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Help Menu

• Contents

• About

Product Manager

The following options are available through the Product Manager application for your 
Switch or Director. For more information on these options, refer to the “Menu Bar” 
section of Chapter 1 in the Product Manager user guide for your Switch or Director. 

View Tabs

• Hardware 

• Node List

• Port List 

• Performance

• FRU List

Product Menu

• Port (options available when port is selected)

— Port Properties

— Node Properties

— Port Technology

— Block Port

— Enable Beaconing

— Port Diagnostics

— Channel Wrap (S/390 mode only)

— Swap Ports (S/390 mode only)

— Clear Link Incident Alert(s)

— Reset Port

— Port Binding
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— Clear Threshold Alerts(s)

— Display Options (Nickname and World Wide Name)

• FRU (options depend on FRU selected)

— Open Port Card View (Director only)

— FRU Properties

— Switchover (Director only)

— Enable Beaconing

— Block All Ports

— Unblock All Ports

— Diagnostics

• Clear System Error Light

• Enable Unit Beaconing

• Properties

• Close

Configure Menu

• Identification

• Operating Mode 

• Operating Parameters

— Switch

— Fabric

• Switch Binding

— Change State (only active if SANtegrity installed)

— Edit Membership List (only active if SANtegrity installed)

• Ports
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• Addresses (S/390 mode only)

— Active

— Stored

• SNMP Agent

• Management Server (only available if a management server feature is installed)

• Features

• Date/Time

• Threshold Alerts

• Export Configuration Report

• Enable Web Server

• Enable Telnet

Logs Menu

• Audit Log

• Event Log

• Hardware Log

• Link Incident Log

• Threshold Alert Log

Maintenance Menu

• Port Diagnostics

• Swap Ports (S/390 mode only)

• Data Collection

• IPL

• Set Online State

• Firmware Library

• Enable E-Mail Notification

• Enable Call Home Notification
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• Backup & Restore Configuration

• Reset Configuration

Help Menu

• Contents

• About
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2
Using the HAFM Window

This chapter provides a description of the High Availability Fabric Manager main 
window, except for the menu bar, which is covered in Chapter 3.

Window Overview
This section provides an over view of the HAFM main window.

Illustrations Used in this Manual

Figures containing HAFM and Product Manager screens are included for illustration 
purposes only. These illustrations may not match exactly what you see on your server 
or workstation. Title bars have been removed from the illustrations, and fields in the 
illustrations may contain different data than in screens displayed on your system.

Layout of Elements

The HAFM main window is shown in Figure 2–1 on page 2-2. The Microsoft 
Windows title bar displays above the HAFM window. The HAFM main window is 
divided as follows:

• Title bar for the product, which is not shown in the illustrations.

• Menu bar, under the title bar and above the tool bar.

• Tool bar, under the menu bar and above the main panel.

• Main panel, which has two tabs: Products and Fabrics. When the Fabrics tab is 
selected, the main panel is divided into two panels (left and right). 

• Status bar, at the bottom of the window.
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Figure 2–1:  High Availability Fabric Manager main window

Window Elements

The HAFM main window elements are shown in Figure 2–1, High Availability Fabric 
Manager main window.

Title Bar

The title bar identifies the product.

Menu Bar

The menu bar provides actions for working with products, fabrics, views, 
configurations, logs, maintenance. A help menu is also provided. For a detailed 
description of the menu bar, refer to Chapter 3.



ha-fabric manager user guide 2–3

Using the HAFM Window

Tool Bar

The tool bar provides a number of icons for quick access to frequently used menu 
items, namely, commands to work with a product or to work with a fabric.

Main Panel

The main panel has two tabs available at the top left for choosing a view: Products or 
Fabrics. 

In the Fabrics view, the main panel is divided into two panels (left and right). The left 
panel shows the Fabric Tree. The right panel contains the view area. The right panel 
has tabs at the lower left of the view area for choosing between a Topology tab view or 
a Zone Set tab view. Figures and detailed descriptions appear later in this chapter.

Status Bar

The status bar has icons for product status, fabric status, and HAFM server (HAFM) 
status, as well as a text area for messages.

Tool Bar
The tool bar has a number of icons for quick access to frequently used menu items; 
namely, commands to work with a product or to work with a fabric.

New Product Icon

The New Product icon (Figure 2–2) is available only in the Products view. This icon 
has the same functionality as choosing the Products > New option. It allows you to 
add a product to the HAFM manager.

Figure 2–2:  New Product icon

Open Product Icon

The Open Product icon (Figure 2–3 on page 2-4) is available in both the Products 
view and the Fabrics view:

• In the Products view, the Open Product icon is available when a product icon is 
selected.
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• In the Fabrics view, the Open Product icon is available when the Topology tab is 
selected and a product icon is selected.

This button has the same functionality as choosing the Product > Open option. It 
allows you to open the Product Manager for a selected product.

Figure 2–3:  Open Product icon

Properties Icon

The Properties icon (Figure 2–4) is available in the Products view when you click a 
product icon. The icon is also available in the Fabrics view when the Topology tab is 
chosen. Click the product icon and then click the Properties icon to display the 
Properties dialog box for the selected product. In the Fabrics view, click outside the 
product icons before clicking the Properties icon to display the Properties dialog box 
for the selected fabric. Refer to Properties on page 4-6 for a description of the Product 
Properties dialog box; refer to Properties on page 5-6 for a description of the Fabric 
Properties dialog box.

Figure 2–4:  Properties icon

Display Drop-Down List

The Display drop-down list (Figure 2–5) contains five options: Product Name, 
Network Address, World Wide Name, Domain ID, and Nickname. This section 
describes these options.

Figure 2–5:  Display drop-down list
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• Product Name — The name of the product configured through the Configure 
Identification dialog box in the Product Manager.

• Network Address — The internet protocol (IP) address or DNS host name of the 
product.

• World Wide Name — The product’s 8-byte WWN. 

• Domain ID — The product’s domain identification number (1-31) assigned by 
the fabric.

• Nickname — The nickname if configured through the Configure Nicknames 
dialog box (Configure menu on menu bar). If the nickname is not configured, the 
WWN displays instead.

Refer to Display Options on page 4-4 for details about the Display Option drop-down 
list in the Products view. Refer to Display Drop-Down Box on page 5-27 for details in 
the Fabrics view.

Persist Fabric Topology Icon

In the Fabrics view, the Persist Fabric Topology icon (Figure 2–6) is available when 
the Topology tab is selected. Choose the Persist Fabric Topology icon to display the 
Persist Fabric dialog box for the selected fabric. Enter a name for the fabric and click 
OK. 

A persisted fabric is a “snapshot” of the current fabric. When the fabric configuration 
of interswitch links (ISLs) and products change from this snapshot, status indicators 
display in the Topology tab view area, and entries about fabric changes appear in the 
Fabric Log. Refer to Persistent Fabrics on page 5-14 for information about persisted 
fabrics. 

Figure 2–6:  Persist Fabric Topology icon
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Export Fabric Topology Icon

In the Fabrics view, the Export Fabric Topology icon (Figure 2–7) is available when 
the Topology tab is selected. Click the Export Fabric Topology icon to display the 
Export Fabric Topology dialog box. Enter a name for the .xml file in the File Name 
field, select a folder on your C: drive or network drive where you want to save the .xml 
file, and then click Save. For additional information about this .xml file, refer to 
Export Fabric Topology on page 5-18.

Figure 2–7:  Export Fabric Topology icon

Show Zoning Library Icon

The Show Zoning Library icon (Figure 2–8) is available both in both the Products 
view and the Fabrics view. Click the Show Zoning Library icon to open the Zoning 
Library dialog box. 

Figure 2–8:  Show Zoning Library icon

Use this dialog box to perform the major tasks for configuring zoning on the fabric:

• Configure zone sets by combining zone members (attached nodes)

• Configure zone sets by combining zones

• Clear zones

• Delete zones and zone sets

• Import and export zone sets

• Display zone properties

• Copy zones and zone sets

• Find zone members in zones

• Find zones in zone sets

• Display zone sets, zones, and zone members in the library

Refer to Using the Zoning Library on page 6-11 for details on zoning and the use of 
this dialog box.
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Layout Icons

In the Fabrics view, the Layout Icons icon (Figure 2–9) is available when the 
Topology tab is selected. Click the Layout Icons icon to arrange the icons in the 
Topology tab view area in the default layout, either circular or spring. To change the 
original default layout (circular), choose the Layout Icons icon, and click Spring.

Spring shortens the length of the ISLs in the Topology tab view area, and springs the 
product icons closer together. Circular displays the fabric in a more spread out, 
circular layout.

Figure 2–9:  Layout Icons icon

Show View Port Icon

In the Fabrics view, the Show View Port icon (Figure 2–10) is available when the 
Topology tab is selected. Click the Show View Port icon to see a magnified view of 
the entire fabric that is in the Topology tab view area. 

Click inside the view port, and move the mouse in any direction to adjust what you see 
in the Topology tab view area. The view port makes navigation easier when a large 
fabric is displayed in the Topology tab view area.

Figure 2–10:  Show View Port icon

Zoom In Icon

In the Fabrics view, the Zoom In icon (Figure 2–11) is available when the Topology 
tab is selected. Choose the Zoom In icon to increase the size of the fabric elements. 
Return to the original size by choosing View > Zoom Default.

Figure 2–11:  Zoom In icon
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Zoom Out Icon

In the Fabrics view, the Zoom Out icon (Figure 2–12) is available when the 
Topology tab is selected. Choose the Zoom Out icon to decrease the size of the fabric 
elements in the Topology tab view area. Return to the original size by choosing View 
> Zoom Default.

Figure 2–12:  Zoom Out icon

Fit Topology in View Icon

In the Fabrics view, the Fit Topology in View icon (Figure 2–13) is available when 
the Topology tab is selected. Choose the Fit Topology in View icon to display the 
entire fabric in the Topology tab view area. Note that for larger fabrics, text and icons 
may be difficult to see. Return to the original size by choosing View > Zoom Default. 

Figure 2–13:  Fit Topology in View icon

Main Panel
The HAFM main panel contains two views, which are displayed by choosing either 
the Products tab or the Fabrics tab.

Products View

When you first access the HAFM, the Products view displays, as shown in 
Figure 2–14 on page 2-9. To access the Products view from the Fabrics view, click 
the Products tab.
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Figure 2–14:  Products view

The Products view provides a graphical overview of all the products that you can 
manage and monitor through the HAFM. In a full-screen environment on an 800 x 600 
resolution monitor, this panel displays up to 48 product icons.

Right-click a product icon or a blank part of the view to display a pop-up menu. The 
options on the product icon menu enable you to administer the product for the HAFM. 
The options on the menu available in the background part of the view enable you to 
change product display options.

The Products view also provides access to the Product Manager application for each 
displayed product. Double-click a product icon to display its Product Manager 
application. 

For a complete description of the Products view, refer to Chapter 4.
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Fabrics View

To access the Fabrics view, click the Fabrics tab. The Fabrics view displays, as 
shown in Figure 2–15, Fabrics view.

Figure 2–15:  Fabrics view

The Fabrics view is divided into two panels. The left panel, the Fabric Tree, contains 
an expandable list of fabrics, products in fabrics, and nodes connected to products. 
The tree displays all fabrics currently known to the HAFM server.

The right panel is the view area. At the bottom of the view area are two tabs that 
change the view of the fabric: the Topology tab and the Zone Set tab.

In the Topology tab view area, right-click a product icon for a menu of options for the 
particular product. Right-click a blank part of the view to display a menu of options 
for the fabric.

In the Zone Set tab, the currently active zone set for fabrics that you chose in the 
Fabric Tree is displayed in the view area.

For a complete description of the Fabrics view, refer to Chapter 5.
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Status Bar
The products, fabrics, and HAFM status elements use the symbols in table Table 2–1 
to indicate their operational state:

Table 2–1:  Operational States and Symbols

Operational State Symbol

Operational

Network communication is established. All 
products, fabrics, and the server are 
operational and no failures are indicated.

Degraded

At least one product, fabric, or the server 
under management is operating in a 
degraded mode and requires service. This 
condition typically occurs when a redundant 
FRU fails and the backup FRU is operational.

Failed

A product, fabric, or the server under 
management has failed and requires 
immediate service.

Unknown

The HAFM cannot determine product status 
because of a network communication failure 
between the product and the HAFM server, or 
because the managed product or fabric is not 
responding. The link may never have been 
established, or the link may have 
malfunctioned.
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Products Status

The product status box, labelled Products, indicates the operational state of the most 
critical product status of all the products managed by the HAFM. To find the one or 
more products that are causing the non-operational status, examine the product icons 
in the Products view.

The colored icons indicate the product status:

• A blinking red and yellow diamond means that the product has failed and requires 
immediate service.

• A yellow triangle means that the product is degraded, but is still performing as 
designed.

• A green circle means that the product is fully operational.

• A gray square means that the HAFM cannot determine product status.

• Double-click the icon to display the product status. This log records information 
when managed products change status. Each entry displays the date and time that 
the change occurred, the product network address, and the new status, such as 
Unknown, Operational, Degraded, or Failed. For details, refer to High Availability 
Fabric Manger Product Status Log on page 7-6.

Fabrics Status

The fabrics status box, labelled Fabrics, indicates the operational state of the most 
critical status of all the persisted fabrics known to the HAFM. To find the one or more 
persisted fabrics that are causing the non-operational status, examine the fabrics in the 
Fabrics view.

The colored icons indicate the persisted fabric status:

• A blinking red and yellow diamond means that the fabric has split into two or 
more fabrics.

• A yellow triangle means that all fabric connections are in tact; however, attention 
indicators appear on one or more ISLs in the Topology tab for the fabric.

• A green circle means that the fabric is fully operational and no attention indicators 
appear in an ISL in the Topology tab for the fabric.

• A gray square means that no information can be determined for the fabric.
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Double-click the icon to display a fabric log. This log displays only if the fabric has 
been persisted. This log reflects the time and nature of significant changes in the 
managed fabric. Entries contain the date/time that the change took place, the type of 
change, and a description of the change. For details, refer to High Availability Fabric 
Manager Fabric Log on page 7-7.

HAFM Status

The HAFM status box indicates the operational state of the HAFM server into which 
the HAFM is logged. Position the mouse cursor over the status box to display one of 
the following messages in the text panel:

• Server status is Operational. The server is fully operational. The status symbol is a 
green circle.

• Server status is Degraded. The server is degraded and needs attention. The status 
symbol is a yellow triangle.

• Server status is Failed. The server has failed and requires immediate service. The 
status symbol is a red diamond.

• Server status is Unknown. The server status cannot be determined. The status 
symbol is a gray square.

Text Panel

The text panel gives additional information about a command when the mouse moves 
over a tool-bar icon or over a menu item. This information is available even if the 
Enable Fly Over Display option in the View menu is not checked.
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3
Using the Menu Bar

This chapter provides a description of the following High Availability Fabric Manager 
menus on the menu bar:

• Product

• Fabrics

• View

• Configure

• Logs

• Maintenance

• Help

Product
The Product menu displays options that are relevant to products.

New

When the Products tab in the main panel is selected, the New option is available to 
display the New Product dialog box.

To identify a product to the HAFM and add its icon to the Products view, follow the 
steps in New on page 4-4.

Open

The Open option is only available when a product icon is highlighted in either the 
Products view or the Fabrics view.

To open the Product Manager for a product:

1. Click the product icon in either the Products view or Fabrics view to highlight 
the icon.
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2. Click the Product menu.

3. Click the Open option.

Refer to Accessing a Product Manager on page 4-7 for more information about 
opening a Product Manager.

Delete

The Delete option is only available when the Products tab is selected.

To delete a product:

1. Click the product icon in the Products view to highlight the icon. 

2. Click the Product menu.

3. Click the Delete option.

4. When a Warning dialog box displays asking if you want to remove the item from 
the system, click Yes.

The product icon is deleted from the Products view.

CAUTION:  Deleting a product from the Products view removes all information about 
the product from the system. This includes configuration information, event logs, 
diagnostic information, and any other data maintained by the corresponding Product 
Manager.

Modify

The Modify option is only available when the Products tab is selected.

To open the Modify Network Address dialog box for a product:

1. Click a product icon in the Products view to highlight the icon.

2. Click the Product menu.

3. Click the Modify option.

The Modify Network Address dialog box displays.

4. Use this dialog box to modify the network address of the product. Refer to Modify 
on page 4-5 for information about entering the network address.
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Properties

The Properties icon is available in the Products view when you click a product icon. 
Click the product icon and then click the Properties icon to display the Properties 
dialog box for the selected product. 

The Properties dialog box is also available in the Fabrics view when the Topology 
tab is selected. Click a product icon, then choose the Fabrics view. Click the 
Properties icon to display the Properties dialog box for the selected fabric.

Refer to Properties on page 4-6 for a description of the Product Properties dialog 
box; refer to Properties on page 5-6 for a description of the Fabric Properties dialog 
box.

Logout

Choose this option to log out of the current session, close the HAFM, and close any 
open Product Managers. The HP StorageWorks HAFM Login dialog box displays.

Exit

Choose this option to close the HAFM and any open Product Managers.

Fabrics
When the Fabrics tab is selected, the Fabrics menu is available; the Fabrics menu is 
not available when the Products tab is selected. The Fabrics menu displays options 
that are relevant to fabrics.

Rename

Choose this option to rename a Persistent Fabric. Until the fabric has been persisted, 
this option is not available.

Choose this option to display the Rename Fabric dialog box. Enter a name in the 
dialog box to display in the Fabric Tree and at the top of the Topology and Zone Set 
tabs.
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Persist Fabric Topology

Choose this option to display the Persist Fabric dialog box. Enter a name for the 
fabric, and click OK to “persist” the fabric. This saves a snapshot of the fabric’s 
current configuration (Switches, Directors, and ISLs) that displays in the Topology 
tab. Visual indicators display in the Topology tab as products, and ISLs are deleted or 
added to help you monitor the fabric’s status over time. This also creates a Fabric Log 
(available from the Logs menu on the menu bar) that tracks changes to the fabric over 
time. For details, refer to Persistent Fabrics on page 5-14.

Unpersist Fabric Topology

Choosing this option displays a warning that the Fabric Log will be lost if the fabric is 
unpersisted. Click Yes to unpersist the fabric, and the current view of the fabric 
displays in the tab’s view area without the fabric status indicators. The name of the 
fabric in the Fabric Tree changes back to the fabric’s WWN. A fabric status icon will 
not appear by the WWN.

Export Fabric Topology

Choose this option to export the current fabric topology into an XML-formatted file. 
You can name the output file in the Export Fabric Topology dialog box that this 
option displays.

Show Route

Choose this option to display the Show Route dialog box. Use this dialog box to view 
the path that Fibre Channel frames must take between two end devices in a 
multiswitch fabric. Refer to Show Route on page 5-9 for the requirements to show a 
route and how to interpret the display.

Hide Route

If a route has been displayed, the Hide Route option is available. Choose this option 
to remove the route currently displayed in the Topology tab view area.
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Show Zone Members

Choose this option to display the Show Zone Members dialog box. This dialog box 
displays a tree of all products in the selected fabric in the left panel. Click an icon by a 
product to expand the list of attached nodes. Choose a node, and the WWNs or 
nicknames (if configured) of nodes that are members of the same zone as the selected 
node display in the right panel. Refer to Chapter 6 for details on zoning and zoning 
configuration.

Show View Port

Click the check box to remove or display a checkmark. With a checkmark displayed, 
the View Port secondary window displays. Click inside the window and move the 
mouse to adjust the view of the fabric in the tab’s view area. 

Click the check box by the menu option when it contains a checkmark to remove the 
checkmark and remove the View Port secondary window from the screen.

Show Fabric Tree

Click the check box to display a checkmark. With a checkmark displayed, the Fabric 
Tree displays on the left side of the Fabrics tab. 

Click the check box when it contains a checkmark to remove the checkmark; the 
Fabric Tree is removed from the left side of the Fabrics tab.

Enterprise Fabric Mode

This option is active only if the SANtegrity feature key is installed on each Switch in 
the fabric. For general instructions on enabling feature keys, refer to Chapter 3 in the 
appropriate Product Manager user manual for your Switch or Director product. 
Choose this option to display the Enterprise Fabric Mode dialog box. Use this dialog 
box to enable and disable Enterprise Fabric mode. Activating Enterprise Fabric Mode 
automatically enables the following features and operating parameters:

• Fabric Binding — SANtegrity feature.

• Switch Binding — SANtegrity feature.

• Rerouting Delay — parameter available through the Configure Switch 
Parameters dialog box. Refer to Enable/Disable and Online State Functions on 
page 8-6 for more information.
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• Domain RSCNs — parameter available through the Configure Switch 
Parameters dialog box. Refer to Enable/Disable and Online State Functions on 
page 8-6 for more information.

• Insistent Domain ID — parameter available through the Configure Switch 
Parameters dialog box. Refer to Enable/Disable and Online State Functions on 
page 8-6 for more information.

For complete instructions on using this option and the SANtegrity features, refer to 
Enterprise Fabric Mode on page 8-12.

Fabric Binding

This option is only active if the SANtegrity feature key is installed on each in the 
fabric. For general instructions on enabling feature keys, refer to Chapter 3 in the 
Product Manager user manual for your Switch or Director product. Once SANtegrity 
is installed and enabled, you can configure fabric binding for a specific fabric by 
selecting the fabric in Fabrics tab, then selecting Fabric Binding option from the 
Fabrics menu. This displays the Fabric Binding dialog box. Use this dialog box to 
enable and disable Fabric Binding and restrict unspecified Switches from attaching to 
the selected fabric. 

For complete instructions on using this option, refer to Fabric Binding on page 8-6.

View
The View menu displays options that alter the view of application components.

User Sessions

Choose the User Sessions option to display the User Sessions dialog box 
(Figure 3–1). This dialog box lists all the current management sessions, including the 
name of each user connection, the network address of the user, and the time when the 
connection was established. Click Close when you have finished reviewing the 
sessions.

Figure 3–1:  User Sessions dialog box



ha-fabric manager user guide 3–7

Using the Menu Bar

Zoom

Choose the In and Out options from the Zoom option to increase and decrease the 
size of fabric elements. Return to the original view by selecting the Default option.

Choose the Fit In View option to display the entire fabric in the view area. Note that 
for larger fabrics, text and icons may be difficult to see. Choose Default from the 
Zoom menu to return to the original view, or use the Out option to selectively reduce 
the view.

Arrange Icons

The Arrange Icons option is available only when the Products tab is selected.

Choose the by Name option from the Arrange Icons option to sort the product icons 
alphabetically by product name in the Products tab view area.

Choose the by Severity option from the Arrange Icons option to sort the product 
icons by status in the Products tab view area. The products are displayed from most to 
least critical: failed products, products with degraded status, and products with 
unknown operational status. Within these groupings, icons appear alphabetically by 
their network address (IP address or DNS host name) or product name, depending on 
the selected display option.

Layout Icons

Choose the Spring option from the Layout Icons option to shorten the length of the 
ISLs in the view area and “spring” in the product icons closer together. Click the 
Circular option to display the fabric in the more spread-out, circular layout.

Center in Topology

Choose a product icon in the Topology tab view area, and then select this option to 
center the product and surrounding portion of the fabric in the view area. Choosing 
this option without selecting an icon centers the entire fabric in the view area.

Clear ISL Alert

Choose an ISL in the Topology tab view area, and then choose this option to clear the 
alert. This option is not available when there is no alert for the currently selected ISL. 
An alert only occurs in persisted fabrics when an ISL is removed from the fabric.
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Clear All ISL Alerts

Choose this option to clear all ISL alerts, as shown in the Topology View. This option 
is not available when there are no ISL alerts. An alert only occurs in persisted fabrics 
when an ISL is removed from the fabric.

Enable Fly-Over Display

When the Enable Fly-Over Display option is enabled, move the cursor over fabric 
products in the tab’s view area to display the product identification under the product 
icon. Moving the cursor over the ISL lines between products displays the actual 
number of ISLs between the products. 

Disable the fly-over display by selecting and removing the check mark by the Enable 
Fly-Over Display option.

Configure
The Configure menu displays options for managing the fabric.

Users

To grant access to the HAFM, the administrator can assign user names, passwords, 
and access rights to users. The administrator can configure up to sixteen users in the 
HAFM, but no more than nine users (eight remote and one the local user) can 
simultaneously access one HAFM server.

User Rights

Specific levels of access, called “user rights,” are assigned to Product Manager users 
by the HAFM’s system administrator in the HAFM application.

NOTE:  The HAFM’s system administrator has view rights only while operating in a specific 
Product Manager application. Conversely, a Product Manager’s product administrator has 
view rights only while operating in the HAFM application.

There are five levels of access or “user rights” that can be assigned to specific users:

• System Administrator

• Product Administrator

• Maintenance

• Operator

• View
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By default, all users have View rights, which allow the viewing of configurations, but 
not the changing of configurations. View rights cannot be removed.

The users with System Administrator rights can make all control and configuration 
changes implemented through the HAFM application. 

User Rights for Specific Functions

Table 3–1 lists the specific functions available to HAFM users who have been 
assigned the user rights of System Administrator, Product Administrator, 
Maintenance, or Operator. If a user’s assigned rights do not include the right to 
perform a specific operation, a Not Authorized message displays when the 
operation is attempted.

Table 3–1:  User Rights for HAFM Functions

Rights
System 

Administrator
Product 

Administrator Maintenance Operator

Clear Logs X

Configure 
Call-Home 
Event 
Notification

X X

Configure 
E-Mail

X X

Configure 
Ethernet 
Events

X X

Configure 
Nicknames

X

Configure 
Product

X

Configure 
Session 
Options

X

Configure 
SNMP

X

Configure 
User

X

Configure 
Zoning

X
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Open the Configure User Dialog Box

1. Choose Configure > Users.

The Configure Users dialog box displays (Figure 3–2 on page 3-11). 

2. Use the appropriate buttons along the bottom of the dialog box to administer 
users. 

Display 
Options

X X X

Enterprise 
Fabric Mode

X

Export Fabric 
Topology

X

Export Logs X

Fabric Zoom X

Persist Fabric X

Remote 
Notification

X X 

Show Route X

Show Zone X

View Logs X X

Table 3–1:  User Rights for HAFM Functions (Continued)

Rights
System 

Administrator
Product 

Administrator Maintenance Operator
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Figure 3–2:  Configure Users dialog box

Add New User

Use the New User dialog box (Figure 3–3) to create new users for the HAFM. Assign 
a user name, a password, and certain permissions, or “rights,” to each user configured.

1. Choose Configure > Users.

The Configure Users dialog box displays (Figure 3–2 on page 3-11).

2. Click New.

The New User dialog box displays (Figure 3–3).

Figure 3–3:  New User dialog box
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3. In the User name field, enter a user name of 16 characters or less. 

The user name is case-sensitive.

4. In the Password box, enter a password of 16 characters or less for the new user. 

The password is case-sensitive.

5. In the Confirm Password box, re-enter the password exactly as you entered it in 
the Password box.

6. (Optional) In the Description field, provide a description of the user (such as 
employee number, department, and function).

Assign rights to the new user using the Add and Remove buttons. Select a right in 
the Rights Available list, and click Add to display the right in the Rights Granted 
list. For a discussion of user rights, refer to Managing Remote Access to the 
HAFM Server on page 1-7.

By default, view rights are granted to all users. 

7. Click OK to activate the administration and close the New User dialog box.

8. Click Close to close the Configure Users dialog box.

Open the Modify User Dialog Box

1. Choose Configure > Users.

The Configure Users dialog box displays (Figure 3–2 on page 3-11).

2. In the User column, select the user whose parameters are to be changed.

3. Click Modify.

The Modify User dialog box displays, with the name of the selected user in the 
User name field (Figure 3–4). 
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Figure 3–4:  Modify User dialog box

Modify User Parameters

The Modify User dialog box (Figure 3–4) is used to change the password, 
description, and rights for those users already configured in the HAFM.

1. In the Password field, delete the current password and enter another password of 
16 characters or less. 

The password is case-sensitive.

2. In the Confirm Password field, re-enter the new password exactly as it was 
entered in the Password field.

3. (Optional) In the Description field, change the description of the user (such as 
employee number, department, and function) as necessary.

4. Re-assign rights to the user, using the Add and Remove buttons to display the 
right in the Rights Granted list. Refer to User Rights on page 3-8 for definitions of 
user rights.

By default, view rights are granted to all users. 

5. Click OK to activate the administration and close the dialog box.

6. Click Close to close the Configure Users dialog box.
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Delete User

Delete users from the system through the Configure Users dialog box (Figure 3–2 on 
page 3-11).

1. From the Configure menu, choose Users. 

The Configure Users dialog box displays (Figure 3–2 on page 3-11).

2. In the User column, select the user to be deleted.

3. Click Delete.

A Warning dialog box opens confirming the deletion (Figure 3–5).

Figure 3–5:  Delete User Warning 

4. Click Yes to delete the user from the HAFM.

5. Click Close to close the Configure Users dialog box.

Nicknames

Nicknames replace the standard 8-byte World Wide Names of Switches, Directors, 
and attached nodes. By setting a nickname, you can assign a more meaningful name 
than a WWN. When you assign a nickname, the nickname replaces the World Wide 
Name in the HAFM views.

NOTE:  Nicknames may have a maximum of 32 characters.

To add a nickname:

1. Choose Configure > Nicknames.

The Configure Nicknames dialog box displays with existing nicknames that have 
already been configured (Figure 3–6).



ha-fabric manager user guide 3–15

Using the Menu Bar

Figure 3–6:  Configure Nicknames dialog box

The left column in the dialog box shows the selected WWN, while the right 
column shows the assigned nickname.

2. Click New to add a new nickname.

The Add Nickname dialog box displays (Figure 3–7).

Figure 3–7:  Add Nickname dialog box (Detached Node)

3. To add a detached node (node currently not connected to a product port):

a. Choose Manually type in World Wide Name.

b. Click OK. A blank row is added to the list in the Configure Nicknames 
dialog box.
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c. In the World Wide Name column, enter the 8-byte World Wide Name, in the 
standard format. For example, 10:00:08:00:88:40:20:B1

d. In the right column, enter the nickname you want to assign.

e. Click OK.

4. To add an attached node (node currently connected to a product port):

a. Click New. The list of attached products and nodes displays, as shown in 
Figure 3–8. 

Figure 3–8:  Add Nickname dialog box (Attached Node)

b. Select a node or managed product from the list.

— If needed, click the button to the left of fabric name or WWN to display 
the WWN (or nicknames, if configured) of all products, such as Switches 
and Directors, included in the fabric. A product status icon will display by 
each product in the tree. If the product is not managed by the HAFM 
server that you are using, no status icon displays. 

— Click the button to the left of the product folder labeled with a WWN or 
nickname to display all nodes, such as servers or storage devices, attached 
to the product. Status is not available for the nodes. 

c. Click OK.

d. The World Wide Name now displays in the World Wide Name column of the 
Configure Nicknames dialog box. You cannot assign more than one 
nickname to the same World Wide Name.

e. In the Nickname column, enter the nickname that you want to assign.
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5. Click OK to close the Configure Nicknames dialog box.

To delete a nickname:

1. In the Configure Nicknames dialog box, select the nickname that you want to 
delete (Figure 3–6 on page 3-15).

2. Click Delete.

3. Click Yes to confirm that you want to delete the nickname.

4. Click OK to close the Configure Nicknames dialog box.

Sessions

Sessions allow access to the HAFM server from all workstations or only from specific 
remote workstations through the Configure Sessions dialog box. A maximum of nine 
concurrent users (eight remote and one local HAFM server user) can log in to the 
HAFM application.

1. Choose Configure > Sessions.

The Configure Sessions dialog box (Figure 3–9) displays.

Figure 3–9:  Configure Sessions dialog box



3–18 ha-fabric manager user guide

Using the Menu Bar

2. Click the Allow remote management sessions check box (a check mark 
displays) to allow remote access from remote workstations. If you do not choose 
this option, remote access is blocked even if you provide access information in 
other parts of this dialog box. Use this check box as a method to prohibit remote 
access while saving the current access administration in this dialog box.

NOTE:  If this option is not selected, existing sessions will not terminate, but future sessions will 
be prohibited.

3. Select the number of remote management sessions to be allowed from the 
Maximum number of remote management sessions list.

4. If you do not want to restrict access to the HAFM, click Allow any network 
address to connect and click OK. 

5. If you want to restrict access to an address:

a. Click Restrict access to the following network addresses.

b. Click Add. The New Network Address dialog box displays.

c. Enter the IP address of the remote workstation to be authorized in the 
Network Address field.

d. Click OK. The New Network Address dialog box closes.

e. Click OK on the Configure Sessions dialog box.

6. If you want to remove the access currently granted to a remote workstation:

a. Click Restrict access to the following network addresses. The IP addresses 
display in the Network Address Restrictions area.

b. Select the address to be deleted.

c. Click Remove.

d. Click Yes in the Warning dialog box. 

e. Click OK to save the required changes.
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SNMP Agent

Choose the SNMP Agent option to open the Configure SNMP dialog box that allows 
you to configure the SNMP agent that runs on the HAFM server and implements the 
Fibre Alliance MIB. 

The HAFM server software contains a simple network management protocol (SNMP) 
agent component. The HAFM SNMP agent instruments the objects defined in the 
Fibre Channel Management (FCMGMT) Management Information Base (MIB) 
Version 2.2 and a small number of objects defined in MIB II. Through instrumentation 
of these MIB objects, the agent acts as a translator of information stored on the HAFM 
server and attached Directors into a form usable by SNMP management stations such 
as HP OpenView. Refer to the hp StorageWorks SNMP reference guide for directors 
and edge switches.

Use these steps to configure the SNMP agent that runs on the HAFM server and 
implements the Fibre Alliance MIB. 

You can configure network addresses and community names for up to 12 SNMP trap 
recipients, which receive messages through SNMP for specific events that occur on 
the HAFM server.

When configuring SNMP, you can configure just the community names of valid 
SNMP management stations. In this case, you do not need to fill in the Trap 
Recipient column or the UDP Port Number column.

To configure and enable SNMP traps, use the following steps:

1. Choose Configure > SNMP Agent.

The Configure SNMP dialog box displays (Figure 3–10).

Figure 3–10:  Configure SNMP dialog box
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2. Click in the Community Name column and enter the SNMP community name for 
a trap recipient. This name defines the community name that SNMP managers use 
for reading variables from or writing variables to the HAFM server. This name 
must be 64 characters or less.

To modify existing fields in this dialog box, click in the field and enter your 
changes. 

3. Select the Write Authorization check box to grant or deny the configured SNMP 
management station write authorization. When this option is selected, an 
administrator at an SNMP management station has write permissions for writable 
MIB objects on the HAFM server.

4. Click in the Trap Recipient column, and enter the IP address or DNS host name 
for a trap recipient (SNMP management station). This must be 64 characters or 
less.

5. If you want the trap recipient to be an active recipient, click the check box in the 
Active column to add a checkmark. If you want to configure the recipient and then 
activate the recipient at a later time, leave the check box empty.

6. To override the default User Datagram Protocol (UDP) port number for a trap 
recipient with any legal, decimal UDP number, enter the UDP port number in the 
UDP Port Number column.

7. To enable or disable the SNMP agent to capture events, select the Enable SNMP 
Agent on server check box.

8. To enable or disable authorization traps to be sent when unauthorized 
management stations try to access SNMP information through the HAFM server, 
select the Enable Authorization Traps check box.

9. Click OK to accept and activate the data.

Activate Zone Set

Opens the Activate Zone Set dialog box that allows you to select and activate 
configured zone sets. Only one zone set in the fabric can be active at one time. 
Activating a zone set replaces the current active zone set with the one you activate.

The dialog box displays all zone sets currently configured for the fabric. You can click 
Next to display additional screens that help you through the activation process or 
Previous to view previous screens. Refer to Activate Zone Sets on page 6-26 for 
details on zoning and use of this dialog box.
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Zoning Library

Opens the Zoning Library dialog box. Use this dialog box to perform the major tasks 
for configuring zoning on the fabric:

• Configure zone sets by combining zone members (attached nodes)

• Configure zone sets by combining zones

• Clear zones

• Delete zones and zone sets

• Import and export zone sets

• Display zone and zone set properties

• Copy zones and zone sets

• Find zone members in zones

• Find zones in zone sets

• Display zone sets, zones, and zone members in library

Refer to Using the Zoning Library on page 6-11 for details on zoning and use of this 
dialog box.

Advanced Zoning

Choose this option to open a secondary menu with the following options:

• Deactivate Zone Set — Click this option to display the Deactivate Zone Set 
dialog box. Use this dialog box to deactivate the current active zone set. Click 
Start to begin the process. Messages display to indicate deactivation status. When 
the Close button displays, you can close the dialog box. Refer to Default Zone on 
page 6-7 for details on zoning and use of this dialog box.

• Configure Default Zone — Click this option to display the Configure Default 
Zone dialog box. Use this dialog box to enable and disable the default zone. Click 
Start to begin the process. Messages display to indicate process status. When the 
Close button displays, you can close the dialog box. Refer to Default Zone on 
page 6-7 for details on zoning and use of this dialog box.
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Logs
Sorting log entries is the same for all logs. Sort log entries in columns by clicking a 
column heading. For columns that contain text, the columns are sorted alphabetically. 
For columns with data, such as date and time, the columns are sorted by date. The 
default view for all logs is to show the most current event based on date and time when 
the event occurred.

A down arrow in the header indicates sorting in descending order. An up arrow 
indicates sorting in ascending order. Click once to sort. Click again to reverse the sort.

Audit Log

Choose this option to display the Audit Log, which contains a history of user actions 
performed through the HAFM. Refer to High Availability Fabric Manager Audit Log 
on page 7-2 for a detailed description of the Audit Log.

Event Log

Choose this option to display the Event Log, which lists errors related to HAFM 
operation. Refer to High Availability Fabric Manager Event Log on page 7-3 for a 
detailed description of the Event Log.

Session Log

Choose this option to display the Session Log, which lists the users who have logged 
in and logged out of the HAFM server. Refer to High Availability Fabric Manager 
Session Log on page 7-5 for a detailed description of the Session Log.

Product Status Log

Choose this option to display the Product Status Log, which records the operational 
status changes of each managed product. Refer to High Availability Fabric Manger 
Product Status Log on page 7-6 for a detailed description of the Product Status Log.

Fabric Log

Choose this option to display the Fabric Log, which records all the significant changes 
that have occurred in the managed fabric. This only displays if a fabric was persisted. 
Refer to High Availability Fabric Manager Fabric Log on page 7-7 for a detailed 
description of the Fabric Log.
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Maintenance

The Maintenance menu provides tools for setting remote communication options.

Configure E-Mail

Configure up to five e-mail addresses for administrators or others who should be 
notified of significant product events. The events that initiate e-mail notification are 
specific to each managed product. Some examples of events that initiate e-mail 
notification are:

• Change in system operational status.

• Problem detection, such as a failed field-replaceable unit (FRU).

• Problem correction.

• State change that requires user attention or a report to product administrator or 
service representative.

To display and modify e-mail notification:

1. Choose Maintenance > Configure E-Mail.

The Configure E-Mail dialog box displays (Figure 3–11).

Figure 3–11:  Configure E-Mail dialog box

2. Enter an IP address or DNS host name for your SMTP server.

3. Enter up to five e-mail addresses for personnel who should be notified 
automatically of system events.
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4. To enable or disable e-mail notification, choose the Enable E-Mail Event 
Notification check box.

5. This will enable e-mail notification for all Product Managers if e-mail notification 
is enabled through each Product Manager’s Enable E-Mail Notification option. 
If the Enable E-Mail Event Notification check box is not selected, e-mail 
notification is disabled for all Product Managers.

6. Click OK to confirm the information that you have entered.

The SMTP server address and e-mail addresses can be up to 64 characters.

Test Remote Notification

Use the test remote notification feature to test the call-home feature and the current 
configuration parameters for the e-mail notification feature. 

• To use this feature you must first configure telephone numbers and other 
information for the Call-Home feature. In LAN-based environments, call home 
event notification requires installation of Proactive Service software. This service 
is offered at no additional charge for susbsystems covered under an on-site 
warranty or an on-site storage hardware support contract. To register or order 
Proactive Service software, contact your HP Customer Service representative.

• Configure Call-Home event notification through the HAFM Maintenance menu 
(refer to Configure Call-Home Event Notification on page 3-26).

• Configure e-mail through the HAFM Maintenance menu (refer to Configure 
E-Mail on page 3-23).

• Enable Call-Home event notification through the Product Manager Maintenance 
menu.

Once you have run the test, you should contact the call-home recipient or the e-mail 
recipient to confirm that a message was received.

1. Choose Maintenance > Test Remote Notification.

The Test Remote Notification dialog box displays (Figure 3–12).

Figure 3–12:  Test Remote Notification dialog box
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You can check remote notification for one or both remote communication 
methods.

2. To test the call-home feature, click the Call Home check box.

3. To test the e-mail notification feature, click the E-Mail check box.

4. Click Send Test.

A message box displays indicating that the test was initiated (Figure 3–13).

Figure 3–13:  Results of Remote Notification Test

5. Click OK to close the message box.

Configure Ethernet Events

An Ethernet event occurs when the Ethernet link between the HAFM server and the 
managed product is dropped. You can configure Ethernet events for all managed 
products and set a specific time interval for an event to be generated after the 
communication drops.

1. Choose Maintenance > Configure Ethernet Events.

The Configure Ethernet Events dialog box displays (Figure 3–14).

Figure 3–14:  Configure Ethernet Events dialog box

2. To enable Ethernet events, click the Enable ethernet events check box.

3. To change the default timeout of 30 minutes, enter a new value in the Ethernet 
timeout field. The value must be between 10 and 120.
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4. Click OK to accept and activate the data.

If e-mail notification is also enabled, an e-mail will be sent if the HAFM cannot 
communicate with a product. 

If call-home notification is also enabled, a call-home notification will be generated if 
the HAFM cannot communicate with a product.

Configure Call-Home Event Notification

Call-home notification, which you configure for each product through the Product 
Manager, enables the HAFM server to automatically contact a support center to report 
system problems. The support center server accepts calls from the HAFM server, logs 
reported events, and can notify one or more support center representatives.

To use this feature, you must first configure telephone numbers and other information 
for the modem-based call-home feature through the Windows dial-up networking 
application. Refer to the HAFM server installation guide for details.

To enable and disable call-home notification for system problems, use the following 
procedure:

1. Choose Maintenance > Enable Call Home Event Notification. 

The Enable Call Home Event Notification dialog box displays. 

2. Check the Enable Call Home Event Notification check box to enable the 
feature. 

3. To test call-home notification, click Send Test; otherwise, click OK.

Note that after you enable call-home in the HAFM, you must enable the feature for 
each specific Switch or product that will use this feature in the Product Manager 
application for that product.

Help
The Help menu provides access to two options:

• Contents — Choose this option to open the HAFM Online Help window. The 
Contents, Index, and Glossary items in the left frame of the Help window are 
hyperlinked to topic text and graphics in the right frame.

• About — Choose this option to display version and copyright information for the 
HAFM application.
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4
Using the Products View

This chapter provides information to help you use features in the Products tab. 

Overview
Display the Products view by clicking the Products tab on the High Availability 
Fabric Manager window. This is the default tab for the HAFM. It displays icons of all 
products, such as Switches and Directors, that you can manage through the HAFM and 
Product Manager applications. 

The following figure illustrates the Products tab displayed in the HAFM window.

Figure 4–1:  Products view
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Product Icon Display
The Products view can display up to 48 product icons. Use the scroll bar to display 
any icons that are out of view.

The view in Figure 4–1 displays Director and Edge Switch product icons. You can 
also determine the product represented by the icon by right-clicking the icon and 
choosing Properties or double clicking the icon to display the product’s HAFM 
Properties dialog box. When the dialog box displays, verify the product listed in the 
Product Type field. 

The icon in Figure 4–2 is an icon for the Director 2/64. 

Figure 4–2:  Director 2/64 Product icon

Icon Description

Information in each product icon includes:

• Product data speed setting (upper left corner). This speed, either 1 or 2 Gb/sec, is 
configured through the Product Manager application for a specific Director. 
Switches have 1 or 2 GB/sec speeds that you cannot configure.

• Attention indicator (upper right corner). A yellow triangle in the upper right 
corner means that product requires attention. Open the Product Manager 
application for the Director by double-clicking on the icon to find out more 
information. 

• Port count. The port count displayed is the maximum number of ports for the 
product, not the enabled number of ports.
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• Status indicator. This is the colored symbol behind the product’s illustration in the 
icon.

— A blinking red and yellow diamond means that the product has failed and 
requires immediate service.

— A yellow triangle means that the product is degraded, but is still performing as 
designed.

— A green circle means that the product is fully operational.

— A gray square means that the HAFM cannot determine product status.

If a status symbol does not display behind the product, the product is not managed 
by the HAFM server to which you are logged in.

The product name or network address displays at the bottom of the icon. Switch 
between the name and address through Display Options in the view pop-up menu. 
Refer to View Pop-Up Menu in the next section for details. 

NOTE:  If the product name displays inside the icon, moving the cursor over the icon displays 
the network address below the icon. If the network address displays inside the icon, moving the 
cursor over the icon displays the product name below the icon. 

The most critical status reflected by a product in the view is also reflected in the 
Products status bar in the left corner of the HAFM status bar. For example, if a 
product is degraded, a yellow triangle displays in the status bar.

View Context Menus
Two pop-up menus are available by right-clicking in the view. One is available when 
you right-click the view, away from a product icon, and the other when you right-click 
a product icon. Refer to Product Icon Pop-Up Menu on page 4-5.

View Pop-Up Menu

The pop-up menu that displays when you right-click the view area (away from a 
product icon) enables you to add products, change product icon labels, and sort 
product icons in the view. Use the following procedures to use these menu options.
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New

Choose this option to display the New Product dialog box. Use this dialog box to 
identify a product to the HAFM and add its icon to the Product view.

Figure 4–3:  New Product dialog box

1. Enter a valid IP address or domain name server (DNS) host name in the Network 
Address field. A valid IP address is in the form nnn.nnn.nnn.nnn, where nnn is a 
decimal in the range 0-255.

2. Select the product type from the Product Type list. 

3. Click OK.

A new icon for the product displays in the Products view.

NOTE:  You can also choose the New option while in the Products view from the Product 
menu on the menu bar at the top of the HAFM window.

Display Options

This option displays additional options for displaying the label beneath the icon.

• Product Name — Choose this option to display the product’s name in the icon 
label. Change a product’s name through the Product Manager application. Refer 
to the Product Manager user guide for your Switch or Director model for 
instructions.

• Network Address — Choose this option to display the product’s IP address or 
DNS (domain name server) host name in the icon label. Configure network 
addresses through the New Product dialog box. 
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Sort Options

This option displays additional options for displaying product icons.

• By Name — Arrange icons alphabetically, by product name.

• By Severity — (Default). Arrange icons according to the product’s operating 
status. Failed products appear first, followed by products with degraded, then 
unknown, then fully operational status. Within these groupings, icons appear 
alphabetically by their network address (IP address or DNS host name) or product 
name, depending on the selected display option.

Product Icon Pop-Up Menu

Access a menu for the product icon by right-clicking the icon.

Open

Choose this option to open the Product Manager for the selected product. Refer to 
Accessing a Product Manager on page 4-7 for more information.

Modify

Choose this option to display the Modify Network Address dialog box. Use this 
dialog box to modify the network address.

To modify existing product properties, use the following steps:

1. In the Products view, right-click a product icon for which you want to change 
administration and choose Modify.

The Modify Network Address dialog box displays (Figure 4–4). This dialog box 
contains the network address of the product.

Figure 4–4:  Modify Network Address dialog box

2. Change the address in the Network Address field.

3. Click OK.
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Delete

1. Choose this option to delete the product from the Products view. 

2. When a Warning dialog box displays asking if you want to remove the item from 
the system, click Yes.

The product icon is deleted from the Products view.

CAUTION:  Deleting a product from the Products view removes all information about 
the product from the system. This includes configuration information, event logs, 
diagnostic information, and any other data maintained by the corresponding Product 
Manager.

Properties

Click this option to display the product’s Properties dialog box, which lists the 
product name, location, contact person, description, product type, network address, 
and operational status for the product. The product name, location, contact person, and 
description are configured through the Product Manager. Refer to the Product 
Manager user guide for your Switch or Director for instructions. The network address 
is configured in the New Product dialog box in the HAFM. 

You can display product properties through the Products view. To display information 
about a managed product:

1. Right-click a product’s icon in the Products view and choose Properties.

The product’s Properties dialog box displays (Figure 4–5 on page 4-6). 

Figure 4–5:  Product Properties dialog box
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The Switch or Director Properties dialog box displays information about a product 
managed by the HAFM including the following:

• Name of the product as configured through the Configure Identification dialog 
box in the Product Manager application.

• Location of the product as configured through the Configure Identification 
dialog box in the Product Manager application.

• Contact person for the product as configured through the Configure 
Identification dialog box in the Product Manager application.

• Description of the product as configured through the Configure Identification 
dialog box in the Product Manager application.

• Product type, for example “Edge-32,” as configured through the HAFM’s New 
Product dialog box.

• Network address as configured through the HAFM’s New Product dialog box.

• Current product operational status:

— Operational — Product is fully operational.

— Degraded — Product needs attention. Typically, this displays when a 
redundant FRU fails, but the product is still performing as designed.

— Failed — Product needs immediate attention.

— Unknown — The HAFM cannot determine product status because of a 
network communication failure between the product and the HAFM server, or 
because the managed product is not responding.

Accessing a Product Manager
There are three ways to access a product’s Product Manager through the Products 
view.

• Double-click the product icon.

• Right-click the product icon and choose Open.

• Click a product icon to select it, then click the Open Product icon from the tool 
bar.
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Figure 4–6:  Director 2/64 Product Manager window

The Product Manager provides several views for managing and monitoring individual 
Fibre Channel devices, including the Hardware, Node List, Port List, Performance, 
and FRU List views. Through the Product Manager Hardware view, for example, 
you can determine status and control operation of individual hardware components. 

Through a Product Manager, you can perform the following tasks for the product:

• Configure the device name, location, description, and contact person that is 
displayed in application panels and dialog boxes.

• Monitor operational status of the product and its hardware components.

• Control fiber optic port operation.

• Determine port performance.

• Control the system error indicator light emitting diode (LED) and beaconing 
operation for other product LEDs.

• Enable an initial program load (IPL).
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• Download firmware.

• Perform other configuration and monitoring tasks specific to the product.

NOTE:  A maximum of eight remote users (in addition to the local HAFM server user) can 
concurrently access Product Managers for a specific product.

The HAFM window is still available as a separate window when a Product Manager is 
open. You can drag the Product Manager window away from the HAFM window and 
view both on your desktop. You can also minimize each window.

To return to the HAFM, choose Close from the Close menu in the Product Manager.

Refer to the appropriate Product Manager user guide for your Switch or Director 
model for information on using the Product Manager.

Available Tool Bar Options
The following options are enabled on the tool bar at the top of the HAFM window 
when you select a product in the view to select it. For information on tool bar options 
that are not enabled, refer to Tool Bar on page 2-3.

• New Product — This performs the same function as the New option in the view 
pop-up menu by adding a managed product to the HAFM. Refer to New on 
page 4-4 for details.

• Open Product — This opens the Product Manager application for the product. 
Refer to Accessing a Product Manager on page 4-7 for details.

• Properties — This opens the Properties dialog box for the product. Refer to 
Properties on page 4-6 for details.

• Product Name and Network Address drop-down list — These options perform the 
same functions as the Display Options available through the view pop-up menu. 
Refer to Display Options on page 4-4 for details.

• Show Zoning Library — This displays the Zoning Library dialog box. Refer to 
Using the Zoning Library on page 6-11 for complete information.
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Available Menu Bar Options
The following options are active only in the Products view. For information on other 
menu options, refer to Chapter 3, Using the Menu Bar.

Product Menu

New — Choose this option to display the New Product dialog box. Use this dialog 
box to identify a product to the HAFM and add its icon to the Products view. You can 
also choose this option from the view pop-up menu by right clicking in the view away 
from product icons. For details on this option, refer to New on page 4-4 under the view 
pop-up menu.

Logout — Choose this option to log out of the current session, close the HAFM, and 
close any open Product Managers. The HAFM Login dialog box displays.

Exit - Choose this option to close the HAFM and any open Product Managers.

View Menu

User Sessions — This displays the User Session table. This table list all the current 
management sessions, including the name of each user connection, the network 
address of the user, and the time when the connection was established. 

Arrange Icons — Use this option to modify the display of product icons in the view. 

• By Name — Arrange icons alphabetically by product name.

• By Severity — (Default). Arrange icons according to the product’s operating 
status. Failed products appear first, followed by products with degraded, then 
unknown operational status. Within these groupings, icons appear alphabetically 
by their network address (IP address or DNS host name) or product name, 
depending on the selected display option.

You can also arrange icons by name and severity by selecting the Sort option from the 
view pop-up menu by right-clicking in the view, away from product icons.

Enable Fly-Over Display — When Fly-Over Display is enabled (View menu on 
menu bar), move the cursor over fabric products in the tab’s view area to display the 
product’s WWN over the product icon. Moving the cursor over the ISL lines between 
products displays the actual number of ISLs between the products. 

Disable the fly-over display by selecting and removing the check mark by the Enable 
Fly-Over Display option.
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5
Using the Fabrics View

This chapter provides information to help you use the Fabrics view in the High 
Availability Fabric Manager window.

Overview
Access the Fabrics view by clicking the Fabrics tab on the HAFM window. The left 
panel of this view is the Fabric Tree, which is the expandable list of fabrics, products 
in fabrics, and nodes connected to products. The view area for the tab is to the right of 
the Fabric Tree.

Click the Topology and Zone Set tabs at the bottom of the view area to change the 
views. The Topology tab (default) is illustrated in Figure 5–1.

Figure 5–1:  Fabrics view — Topology tab
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Topology Tab

The view area of the Topology tab provides details on all fabrics known to the HAFM 
server and HAFM application. This area displays product icons like those in the 
Products view, each representing Switches and Directors in fabrics that you select 
from a Fabric Tree on left panel of the view. Interswitch links (ISLs) display between 
the product icons as black lines. For details on the product icons, refer to Icon 
Description on page 4-2. Fabrics are initially listed in the Fabric Tree by the World 
Wide Name (WWN) of the fabric’s principal Switch, but if the fabric is “persisted,” 
they could have various names configured by the user (refer to Fabric Tree on page 5-3 
and Persistent Fabrics on page 5-14 for details). The selected fabric’s name displays 
above the icons at the top of the tab. 

Refer to Using the Topology Tab on page 5-4 for more details on this tab.

Zone Set Tab

The Zone Set tab is described in Using the Zone Set Tab on page 5-29. This tab 
displays the currently active zone set for fabrics that you select from the left side of the 
view. The zones and zone members that make up the zone set display in a scrollable 
tree structure below the name of the active zone set. Menu options available in this tab 
allow you to quickly determine fabric zoning structure (zone sets, zones, and zone 
members), determine logged in and logged out zone members, save active zones under 
another name, determine the default zone members, deactivate/activate zone sets, and 
change the default zone.
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Figure 5–2:  Fabrics view — Zone Sets tab

Fabric Tree

The scrollable panel on the left side of the Topology and Zone Set tabs contains a list 
of fabrics that you can select for display of information or to perform actions on in the 
left panel of the Topology and Zoning tabs. The tree displays all fabrics currently 
known to the HAFM server. The outermost leaf displays the fabric name, which 
initially will be the World Wide Name (WWN) of the fabric’s principal Switch, but if 
the fabric is “persisted,” it could have a name configured by the user. The name will be 
preceded by a fabric status icon if the fabric is a persisted fabric. (Refer to Persistent 
Fabrics on page 5-14 for details).

While viewing the Topology tab, click a fabric name or WWN in the Fabric Tree to 
display the Switches, Directors, and ISLs in the fabric in the view area to the right of 
the Fabric Tree. If you are viewing the Zone Set tab, click a fabric name or WWN to 
display zoning details about the fabric in the view area to the right of the Fabric Tree. 

Click the button to the left of fabric name or WWN to expand the tree and display the 
WWN or nicknames (if configured) of all products, such as Switches and Directors, 
included in the fabric. A product status icon will display by each product in the tree 
(Refer to Status Icons on page 5-4). If the product is not managed by the HAFM server 
that you are using, no status icon displays. 
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Click the button to the left of the product WWN or nickname to display all nodes, such 
as servers or storage devices, attached to the product. Status is not available for the 
nodes. 

Colored status symbols display before fabric names, if the fabrics are “persisted,” and 
before product names or product WWNs. Pop-up menus also display when you 
right-click fabrics, products, and nodes in the Fabric Tree. 

Status icons relate to your use of the Topology tab. Refer to Status Icons on page 5-4 
and Fabric Pop-Up Menu on page 5-5, under the “Using the Topology Tab” section for 
details.

Using the Topology Tab

Fabric Tree

The Fabric Tree on the left side of the Fabrics view displays a list of fabrics, products 
(Switches or Directors) in each fabric, and nodes attached to each product. Click a 
fabric name or WWN to display the Switches, Directors, and ISLs in the fabric in the 
Topology tab area. Click the icon to the left of a fabric to display the products in the 
fabric and click the icon by a product to display the nodes attached to the product. 

The status icons and pop-up menus that display in the Fabric Tree relate to the display 
in the Topology tab.

Status Icons

Colored icons reflecting the fabric and product (Switch or Director) operational status 
display by names and WWNs in the Fabric Tree.

Fabric

Colored icons reflecting the fabric status display before a fabric name only if the 
fabric is “persisted.”

• A blinking red and yellow diamond means that the fabric has split into two or 
more fabrics.

• A yellow triangle means that all fabric connections are in tact, however attention 
indicators appear on one or more ISLs in the Topology tab for the fabric.

• A green circle means that the fabric is fully operational and no attention indicators 
appear in an ISL in the Topology tab for the fabric.

• A gray square means that no information can be determined for the fabric.
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Product

Colored icons reflecting the product status display before each Switch or Director at 
all times.

• A blinking red and yellow diamond means that the product has failed and requires 
immediate service.

• A yellow triangle means that the product is degraded, but is still performing as 
designed.

• A green circle means that the product is fully operational.

• A gray square means that the HAFM cannot determine product status.

If a status icon does not display behind the product, the product is not managed by the 
HAFM server to which you are logged in.

Fabric Pop-Up Menu

Right-click a fabric name or WWN in the Fabric Tree to display a pop-up menu of 
options.

Rename

This option is available only if the fabric is persisted. Choose this option to display the 
Rename Fabric dialog box. Enter a name in the dialog box to display in the Fabric 
Tree and at the top of the Topology and Zone Set tabs.

Persist Fabric Topology

Choose this option to display the Persist Fabric dialog box. Enter a name for the 
fabric and click OK to “persist” the fabric. This saves a snapshot of the fabric’s 
current configuration (Switches, Directors, and ISLs) that displays in the Topology 
tab. Visual indicators display in the Topology tab as products and ISLs are deleted or 
added to help you monitor the fabric’s status over time. This also creates a Fabric Log 
(available from the Logs menu on the menu bar) that tracks changes to the fabric over 
time. For details, refer to Persistent Fabrics on page 5-14.
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Unpersist Fabric Topology

This option displays only if a fabric has been persisted. Choosing this option will 
display a warning that the fabric log will be lost if the fabric is unpersisted. Click Yes 
to unpersist the fabric and the current view of the fabric displays in the tab’s view area 
without the fabric status indicators. The name of the fabric in the Fabric Tree changes 
back to the fabric’s WWN. A fabric status icon will no longer appear by the WWN.

Properties 

Displays the Fabric Properties dialog box.

Figure 5–3:  Fabric Properties dialog box

This dialog box displays current information on the selected fabric including:

• Fabric Status — For persisted fabrics only, this is the status also reflected by the 
status symbol by fabric name in the Fabric Tree. Refer to the “Fabric” heading 
under Status Icons on page 5-4 for details. 

• Fabric Name — This is the name assigned to the principal Switch in the fabric, if 
configured through the Configure Nicknames dialog box. If the fabric is 
persisted, this is the name assigned in the Persist Fabric dialog box.

• Fabric Nickname — This is the nickname of the fabric’s principal Switch if 
assigned through the Configure Nicknames dialog box. 

• Fabric Binding — This field identifies whether or not Fabric Binding is enabled 
or disabled for the selected fabric. For more information about Fabric Binding, see 
SANtegrity Features on page 8-6.
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Product Pop-Up Menu

Right-click a product WWN or name (if configured through the Configure 
Nicknames dialog box) to display a pop-up menu of options.

Open

Click this to open the Product Manager for the selected product (Figure 5–4).

Figure 5–4:  Director 2/64 Product Manager window

The Product Manager provides several views for managing and monitoring individual 
Fibre Channel devices, including the Hardware, Node List, Port List, Performance, 
and FRU List views. Through the Product Manager Hardware view, for example, 
you can determine status and control operation of individual hardware components. 

Through a Product Manager, you can perform the following tasks for the product:

• Configure the device name, location, description, and contact person information 
that displays in application panels and dialog boxes.

• Monitor operational status of the product and its hardware components.

• Control fiber optic port operation.

• Determine port performance.



5–8 ha-fabric manager user guide

Using the Fabrics View

• Control the system error indicator light emitting diode (LED) and beaconing 
operation for other product LEDs.

• Enable an initial program load (IPL).

• Download firmware.

• Perform other configuration and monitoring tasks specific to the product.

NOTE:  A maximum of eight remote users (in addition to the local HAFM server user) can 
concurrently access Product Managers for a specific product.

The HAFM window is still available as a separate window when a Product Manager is 
open. You can drag the Product Manager window away from the HAFM window and 
view both on your desktop. You can also minimize each window.

To return to the HAFM, choose Close from the Product menu in the Product 
Manager.

Refer to the Product Manager user guide for your Switch or Director for information 
on using the Product Manager.

Center in Topology

Click this option to center the product and surrounding portion of the fabric in the 
view area.

Properties

Click to display the Properties dialog box for the product. Refer to Properties on 
page 4-6 for more information.
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Node Pop-Up Menu

Right-click a node’s WWN or name (if configured through the Configure Nicknames 
dialog box) to display a pop-up menu of options.

Properties

Click to display the Node Properties dialog box.

Figure 5–5:  Node Properties dialog box

This dialog box contains the following information:

• Port WWN

World Wide Name of port on the attached device.

• Port Number

The physical port number on the product to which the node is connected.

Show Route

Click to display the Show Route dialog box with the selected node listed in the Select 
Source Node field. Use this dialog box to view the path that Fibre Channel frames 
must take between two end devices in a multiswitch fabric. This option is also 
available under the Fabrics menu on the menu bar. For details, refer to Show Route on 
page 5-20.

Nickname

Click to display the Configure Nicknames dialog box. Use this dialog box to add, 
modify, or delete nicknames for a Director, Switch, or attached node’s WWN. For 
example, you might assign the nickname Director 1 to a Director instead of using the 
8-byte WWN. This nickname will be used throughout the HAFM and Product 
Manager instead of the WWN.
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The dialog box displays a list of product and node WWNs in the left panel and the 
assigned nicknames in the right panel. Use the New button to assign new nicknames 
for WWNs; use the Delete button to delete nicknames. Modify the nickname by 
clicking by the nickname in the dialog box and changing the name. For details on 
using this dialog box, refer Nicknames on page 3-14.

Show Zone Members

Click to display the Show Zone Members dialog box. This dialog box displays a tree 
of all products in the fabric in the left panel. Click an icon by a product to expand the 
list of attached nodes. Select a node and the WWNs or nicknames (if configured) of 
nodes that are members of the same zone as the selected node display in the right 
panel. Refer to Chapter 6 for details on zoning and zoning configuration.

Topology View Area

Click a fabric WWN (this is the WWN of the fabrics principal Switch) or the fabric 
name (persisted fabrics only) in the Fabric Tree to display the products and ISL 
connections included the multiswitch fabric in the Topology tab view area. By default, 
only the products (Switches and Directors) in the fabric display. For details on the 
product icons, refer to Icon Description on page 4-2. 

In multiswitch fabrics (fabrics consisting of two or more Switches), interswitch links 
(ISLs) between each product are represented by a solid black line. If more than one 
ISL exists between Switches, the line is thicker. Menu options, available when you 
right-click icons, ISLs, and the view area of this tab, allow you to determine status of 
Switches and ISLs, display fabric properties, adjust the fabric display in the tab, show 
routes between nodes in the fabric, determine fabric changes over time by creating 
persistent fabrics, open Product Managers for specific Switches, and perform other 
tasks. For details on these options, refer to Available Menu Bar Options on page 5-17.

Fly-Over Display

When Fly-Over Display is enabled (View menu on menu bar), move the cursor over 
fabric products in the tab’s view area to display the product’s WWN over the product 
icon. Moving the cursor over the ISL lines between products displays the actual 
number of ISLs between the products. 

Disable the fly-over display by selecting and removing the check mark by the Enable 
Fly-Over Display option.

Pop-Up Menus

Right Click a product icon, ISL, or blank area in the view area to display a menu of 
options. 
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Product Icon

Right-click a product icon in the Topology view area to display the following menu 
options:

• Open. Click to open the Product Manager application for the product. You can 
also choose this option from the product pop-up menu by right-clicking a product 
name in the Fabric Tree. Refer to Open on page 5-7 for more details on this 
option.

• Center in Topology. Choose a product icon in the tab’s view area and click this 
option to center the product and surrounding portion of the fabric in the view area. 
Selecting this option without selecting an icon centers the entire fabric in the view 
area.

• Properties. Click to display the Properties dialog box for the product. Refer to 
Properties on page 4-6 for more information.

ISL

Right-click an ISL line between products in the Topology view area to display the 
following menu options:

• Clear ISL Alert. Click to clear all alerts for the ISL. Note that if the ISL does not 
have an alert, the Alert column is blank. An alert only occurs in persisted fabrics 
when an ISL is removed from the fabric. You can also clear an ISL alert by 
selecting the ISL and clicking Clear ISL Alert from the View menu on the menu 
bar. Clear all ISL alerts in the view by choosing Clear All ISL Alerts from the 
menu bar.

• Properties. Displays the ISL Properties dialog box. You can also double-click 
the ISL to display this box. This dialog box displays the domain ID and port 
number for both products where the ISL is attached. The Alert column indicates 
whether ISLs were added or deleted. Note that ISL alerts only occur if the fabric is 
persisted.

Figure 5–6:  ISL Properties dialog box
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View Area

Right-click a blank area in the Topology view area, away from an ISL line or product 
icon, to display the following menu options:

• Clear All ISL Alerts. Click to clear all ISL alerts (yellow triangles) from the view 
of the persisted fabric.

• Display Options. Click to display a secondary menu that allows you to change the 
label under the product icons. 

— Product Name. The name of the product configured through the Configure 
Identification dialog box in the Product Manager.

— Network Address. The internet protocol (IP) address or DNS host name of 
product.

— World Wide Name. Displays the products 8-byte WWN. 

— Domain ID. The product’s domain identification number (1-31) assigned by 
the fabric.

— Nickname. The nickname, if configured through the Configure Nicknames 
dialog box (Configure menu on menu bar). If the nickname is not configured, 
the WWN displays instead.

• Persist Fabric Topology. This persists the currently selected fabric. If the fabric 
was not persisted previously, this option displays the Persist Fabric dialog box, 
where you can provide a name for the persisted fabric. A persisted fabric is a 
“snapshot” of the current fabric. When the fabric configuration of ISLs and 
products change from this snapshot, status indicators display in the tab view, and 
entries on fabric changes appear in the Fabric Log. For details, refer to Persistent 
Fabrics on page 5-14.

• Unpersist Fabric Topology. This option only displays if a fabric has been 
persisted. Clicking will display a warning that the fabric log will be lost if the 
fabric is unpersisted. Click Yes to unpersist the fabric and the current view of the 
fabric displays in the tab’s view area without the fabric status indicators. The 
name of the fabric in the Fabric Tree changes back to the fabric’s WWN. A fabric 
status icon will not appear by the WWN.

• Properties. Click to display the Properties dialog box for the product. Refer to 
Properties on page 4-6 for more information.
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Adjusting the Fabric Display

You can manipulate the fabric in the tab’s view area for a better display, especially of 
larger fabrics by clicking and dragging the fabric in the view area, using menu options, 
and using options on the tool bar at the top of the HAFM window. You can use these 
methods to adjust the view:

• Click and drag product icons in the tabs view area. Clicking and dragging one icon 
drags that icon and changes the length of the ISL line. Move larger sections of the 
fabric by selecting more than one icon then clicking and dragging one of the 
selected icons. Select multiple icons by holding the left mouse key and dragging a 
box around them or using the holding the Ctrl button and clicking on each icon.

• Right-click a product icon, then choose Center in Topology from the pop-up 
menu to center the product and surrounding portion of the fabric in the view. 
Choosing this option without selecting an icon centers the entire fabric in the 
view.

• Click and drag the border separating the Fabric Tree and the view area to widen 
the view area. Eliminate the Fabric Tree entirely from the tab by selecting and 
removing the check mark by Show Fabric Tree on the Fabrics menu on the menu 
bar.

• Click the Layout Icons, Show View Port, Zoom In, Zoom Out, and Fit 
Topology Into View buttons on the right side of the tool bar at the top of the 
HAFM window. These options manipulate the fabric in the view area and are also 
available under the View menu on the menu bar.

• Use the horizontal and vertical scroll bars on the edges of the view area.

• Use view port which provides a magnified view of the entire fabric where you can 
adjust your view of the fabric in the tab’s view area. Access view port by clicking 
the View Port button on the tool bar or by choosing Fabrics > Show View Port. 
Click inside the view port and move the mouse in any direction to adjust what you 
see in the tab’s view area.

• Use options from the View menu on the menu bar.

— Choose the In and Out options from the Zoom menu to increase and decrease 
the size of fabric elements. Return to the original view by choosing the 
Default option.



5–14 ha-fabric manager user guide

Using the Fabrics View

— Choose the Fit In View option to display the entire fabric in the view area. 
Note that for larger fabrics, text and icons may be difficult to see. Choose 
Default from the Zoom menu to return to the original view or use the Out 
option to selectively reduce the view.

— Choose the Spring option from the Layout Icons menu to shorten the length 
of the ISLs in the view area and “spring” in the product icons closer together. 
Click the Circular option to display the fabric in the more spread out, circular 
layout.

Persistent Fabrics

The Persist Fabric Topology menu option is available through the Fabrics menu on 
the menu bar, the Persist Fabric Topology button on the tool bar, the right-click fabric 
pop-up menu in the Fabric Tree, and the right-click view pop-up menu in the 
Topology view area.

Click this option to take a “snapshot” of the current Switches, Directors, and ISL 
connections in the fabric. Choosing this option displays the Persist Fabric dialog box 
where you must enter a name for the “persisted” fabric. This name then displays in 
place of the fabric’s WWN in the Fabric Tree panel and at the top of the tab’s view 
area.

This snapshot will persist in the Topology view and real-time changes to the fabric 
will be reflected by graphic indicators such as alert indicators (yellow triangles), 
dimmed product icons, and dashed yellow lines as shown in Figure 5–7. You can 
persist a fabric whenever you want to refresh the view to the current fabric state and 
track changes from the new persisted view. 
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Figure 5–7:  Persisted fabric in Topology view

Graphic Indicators in View 

Changes to a persisted fabric are indicated in the Topology view area as the following:

• If a Switch or Director is removed from or added to the fabric, the product 
displays in a dimmed state and ISL(s) that connected the product to the fabric will 
appear as dashed yellow lines. 

— A minus sign (-) displays in the lower right corner of the product’s icon if the 
Switch or Director was removed.

— A plus sign (+) displays in the lower right corner of the product’s icon if the 
Switch or Director was added.

• If more than one ISL is connected to a product and all ISLs are disconnected, the 
ISLs change to a yellow, dashed lines with alert indicators (yellow triangles). If 
one or some of the ISLs are disconnected (but not all), the disconnected ISLs will 
appear as black lines with alert indicators (yellow triangles).
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• If an ISL is added, the ISL displays as a black line with an alert indicator (yellow 
triangle). 

If you persist the fabric again, a product displays in the view if added and disappears 
from the view if removed. Added ISL lines remain in black and yellow-dashed ISL 
lines disappear. All alert indicators also disappear. 

• Clear an ISL alert by clicking the ISL and choosing Clear ISL Alert from the 
pop-up menu. You can also clear an ISL alert by selecting the ISL and clicking 
Clear ISL Alert from the View menu on the menu bar. 

• You can clear all ISL alert indicators by right-clicking on the Topology tab’s view 
area, away from a fabric element, and choosing Clear ISL Alert from the pop-up 
menu. You can also clear all ISL alerts in the view by choosing Clear All ISL 
Alerts from the View menu on the menu bar.

Fabric Log

Changes to the fabric are reflected in the Fabric Log (Logs menu on menu bar). 

This log tracks the following changes:

• Zone sets becoming active.

• Switch added/removed.

• ISL added/removed.

• Fabric renamed.

• Fabric persisted.

• Fabric status changes.

The following is recorded in the log:

• Date and time of the change.

• Change in the fabric status: 

— Operational — no attention indicators in view.

— Degraded — All fabric connections are intact, however one or more ISLs have 
attention indicators.
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— Failed — Fabric has split into two or more fabrics. 

— Unknown — No information is known about the fabric.

Note that this status is also reflected by colored icons by the fabric name in the 
Fabric Tree (refer to Status Icons on page 5-4).

• Description of the change. 

NOTE:  Unpersisting the fabric will remove all data from the Fabric Log.

Unpersisting Fabrics

You can a unpersist a fabric by choosing Fabric > Unpersist Fabric Topology, the 
right-click fabric pop-up menu in the Fabric Tree, or the right-click view pop-up menu 
in the Topology view area. 

Choosing this option displays a warning that the fabric log will be lost if the fabric is 
unpersisted. Click Yes to unpersist the fabric and the current view of the fabric 
displays in the tab’s view area without the fabric status indicators. The name of the 
fabric in the Fabric Tree changes back to the fabric’s WWN. A fabric status icon will 
not appear by the WWN.

Available Menu Bar Options

This section provides detail on the options that are active in the Product, Fabrics, 
View, and Configure menus on the menu bar when you are using the Topology tab. 
For information on other menu options, refer to Chapter 3, Using the Menu Bar.

Product 

Choose the Product menu on the menu bar to display the following options:

Open

Click this to open the Product Manager for the product. Also open a product through 
the right-click product pop-up menu in the Fabric Tree. Refer to Open on page 5-7 for 
more information.

Properties

Click this to display a Properties dialog box for elements selected in the Topology tab 
view area. If a product is selected, the Properties dialog box for the Switch or 
Director displays (refer to Properties on page 4-6.) If nothing is selected, the 
Properties dialog box for the fabric displays (refer to Properties on page 5-6).
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Logout

Click this to log out of the current session, close the HAFM, and close any open 
Product Managers. The HAFM Login dialog box displays and allows you to log in to 
another HAFM server.

Exit

Exits the HAFM application.

Fabrics 

Choose the Fabrics menu on the menu bar to display the following options.

Rename

This option is only active if a fabric is persisted. Click this to display the Rename 
Fabric dialog box. Enter a new name to change the name displayed in the Fabrics 
view.

Persist Fabric Topology

This persists the currently selected fabric. If the fabric was not persisted previously, 
this option displays the Persist Fabric dialog box, where you can provide a name for 
the persisted fabric. A persisted fabric is a “snapshot” of the current fabric. When the 
fabric configuration of ISLs and products changes from this snapshot, status indicators 
display in the tab view and entries on fabric changes appear in the Fabric Log. For 
details, refer to Persistent Fabrics on page 5-14. 

Unpersist Fabric Topology

This option is only enabled if a fabric has been persisted. Selecting this option will 
display a warning that the fabric log will be lost if the fabric is unpersisted. Click Yes 
to unpersist the fabric and the current view of the fabric displays in the tab’s view area 
without the fabric status indicators. The name of the fabric in the Fabric Tree changes 
back to the fabric’s WWN. A fabric status icon will no longer appear by the WWN.

Export Fabric Topology

Click to display the Export Fabric Topology dialog box. Use this dialog box to create 
an .xml file containing fabric topology information and an associated Fabric Toplogy 
.dtd file. The .dtd file is required for reading the .xml file in browsers. 

Enter a name in the dialog box for the .xml file in the File Name field, select a folder 
on your C: drive or network drive where you want to save the file, then click Save.
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You can open this file and read its contents using any ASCII editor, such as Notepad. 
Information is grouped under the WWN of each fabric member (Switch or Director). 
Information includes:

• WWN and domain ID of the Switch or Director.

• Output port on the Switch or Director where an ISL is attached.

• Link identification number for the ISL.

• Port number on the remote Switch or Director where the ISL is attached.

An example of an exported file follows.

.XML File Example

Following is a partial exported file showing two members in a fabric.

<FabricTopology FabricWWN=”McDATA-10:00:08:00:88:00:21:00”>

   <FabricMember WWN=”McDATA-10:00:08:00:88:00:21:00” DomainId=”1”>

      <FabricMemberConnection OutputPort=”16” RemotePort=”4” 
LinkId=”11”/>

      <FabricMemberConnection OutputPort=”4” RemotePort=”12” 
LinkId=”2”/>

      <FabricMemberConnection OutputPort=”24” RemotePort=”8” 
LinkId=”12”/>

      <FabricMemberConnection OutputPort=”28” RemotePort=”4” 
LinkId=”3”/>

      <FabricMemberConnection OutputPort=”8” RemotePort=”8” 
LinkId=”4”/>

      <FabricMemberConnection OutputPort=”20” RemotePort=”4” 
LinkId=”5”/>

      <FabricMemberConnection OutputPort=”12” RemotePort=”20” 
LinkId=”6”/>

      <FabricMemberConnection OutputPort=”44” RemotePort=”0” 
LinkId=”7”/>

      <FabricMemberConnection OutputPort=”0” RemotePort=”0” 
LinkId=”8”/>

      <FabricMemberConnection OutputPort=”36” RemotePort=”4” 
LinkId=”9”/>

      <FabricMemberConnection OutputPort=”32” RemotePort=”0” 
LinkId=”10”/>

      <FabricMemberConnection OutputPort=”52” RemotePort=”4” 
LinkId=”19”/>
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      <FabricMemberConnection OutputPort=”48” RemotePort=”4” 
LinkId=”20”/>

   </FabricMember>

   <FabricMember WWN=”10:00:08:00:88:00:21:0A” DomainId=”11”>

      <FabricMemberConnection OutputPort=”4” RemotePort=”16” 
LinkId=”1”/>

      <FabricMemberConnection OutputPort=”0” RemotePort=”24” 
LinkId=”12”/>

      <FabricMemberConnection OutputPort=”20” RemotePort=”8” 
LinkId=”2”/>

      <FabricMemberConnection OutputPort=”12” RemotePort=”12” 
LinkId=”21”/>

      <FabricMemberConnection OutputPort=”8” RemotePort=”12” 
LinkId=”22”/>

      <FabricMemberConnection OutputPort=”28” RemotePort=”4” 
LinkId=”23”/>

      <FabricMemberConnection OutputPort=”24” RemotePort=”8” 
LinkId=”24”/>

      <FabricMemberConnection OutputPort=”32” RemotePort=”4” 
LinkId=”13”/>

      <FabricMemberConnection OutputPort=”36” RemotePort=”8” 
LinkId=”14”/>

      <FabricMemberConnection OutputPort=”40” RemotePort=”4” 
LinkId=”15”/>

      <FabricMemberConnection OutputPort=”44” RemotePort=”16” 
LinkId=”16”/>

      <FabricMemberConnection OutputPort=”48” RemotePort=”4” 
LinkId=”17”/>

      <FabricMemberConnection OutputPort=”56” RemotePort=”8” 
LinkId=”18”/>

Show Route

Click to display the Show Route dialog box. Use this dialog box to view the path that 
Fibre Channel frames will take between two end devices in a multiswitch fabric. You 
can also display this dialog box by right-clicking on a node in the Fabric Tree and 
choosing Show Route from the pop-up menu.

To view the route between two devices, the following must be true:

• All Switches or Directors in the route must be managed by HAFM and attached to 
the same HAFM server.
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• All Switches or Directors in the route must be Director 2/140, Director 2/64, Edge 
Switch 2/32, Edge Switch 2/24, Edge Switch 2/16, or other models that support 
Show Route and must be running firmware version 1.3 or higher.

• All attached devices in the route must be in the same zone.

The Show Route dialog box (Figure 5–8) displays products (Switches and Directors) 
that support route reporting and are managed by this HAFM server in the Select 
Source Node panel.

Figure 5–8:  Show Route dialog box

To show the route for two specific nodes, perform the following steps:

1. Click the icon by a product in the Select Source Node panel to expand the list of 
nodes attached to the product.

2. Click a source node to select it.

3. A list of products displays in the Select Destination Node panel.

4. Click the icon by a product in the Select Destination Node panel to expand the list 
of nodes attached to the product.

5. Click a destination node to select it.

6. Click OK.

The route between the destination nodes (indicated by a small circle with an N in 
the center) displays in the Topology tab’s view area (Figure 5–9 on page 5-22). 

The route continues to be displayed until there is a change to the fabric, the route 
is changed, or the hide route option is selected.
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Figure 5–9:  Route displayed in Topology tab

The route between the nodes and through the products display as a thick blue line 
between two node icons. Right click the line to display the following menu 
options:

• Hide Route. Click to remove the route from the display.

• Properties. Click to display a dialog box that details route information. This 
dialog box contains the following information:

— WWN or nickname of source node. This depends on the setting for the 
Display Options (right-click menu on Topology tab’s view area).

— WWN or nickname of destination node. This depends on the setting for 
the Display Options (right-click menu on Topology tab’s view area).

— The in ports and out ports on the Switches and Directors where the route 
passes.

Hide Route

This option is only active if the tab’s view area is displaying a route between nodes in 
the fabric. Click this option to remove the route from the display that was enabled with 
the Show Route menu option.
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Show Zone Members

Click to display the Show Zone Members dialog box. This dialog box displays a tree 
of all products in the fabric in the left panel. Click an icon by a product to expand the 
list of attached nodes. Select a node and the WWNs or nicknames (if configured) of 
nodes that are members of the same zone as the selected node display in the right 
panel. Refer to Chapter 6 for details on zoning and zoning configuration.

Show View Port

Click the check box to display the View Port secondary window. Click inside the 
window and move the mouse to adjust the view of the fabric in the tab’s view area. 

Clear the check box to remove the View Port window from the screen.

Show Fabric Tree

Select the check box to display the Fabric Tree on the left side of the Fabrics tab. 

Clear the check box to remove the Fabric Tree from the left side of the Fabrics tab.

Enterprise Fabric Mode

This option is only available if the SANtegrity feature is installed on each Switch in 
the fabric. Click to display the Enterprise Fabric Mode dialog box. Use this dialog 
box to enable and disable Enterprise Fabric Mode. Enabling this mode automatically 
enables SANtegrity fabric and Switch binding, as well as the rerouting delay, domain 
RSCNs, and insistent domain ID parameters for each Switch in the fabric. For details 
on using this option, refer to Enterprise Fabric Mode on page 8-12.

Fabric Binding

This option is only available if SANtegrity features are installed on each Switch in the 
fabric. Click to display the Fabric Binding dialog box. Use this dialog box to enable 
and disable Fabric Binding and add Switches and Directors to the Fabric Binding 
Membership List. Switches in this list are allowed to connect to the fabric. For details 
on using this option, refer to Fabric Binding on page 8-6.
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View 

Choose the View menu on the menu bar to display the following options:

User Sessions

Click this to display the User Sessions dialog box. This lists sessions with the HAFM 
server from remote workstations. The dialog box lists user names, remote workstation 
address, and the date/times that users established a connection. For details, refer 
Chapter 3, Using the Menu Bar.

Zoom

• In. Each time that you click this option, fabric elements in the view area increase 
in size. Return to the original view by selecting the Default option.

• Out. Each time that you click this option, fabric elements in the view area 
decrease in size. Return to the original view by selecting the Default option.

• Fit In View. This displays the entire fabric in the view area. This enlarges 
elements of smaller fabrics and reduces elements of large fabrics. Note that for 
larger fabrics, text and icons may be difficult to see. 

• Default. Click to return to the original view.

Layout Icons

• Spring. Click to shorten the length of the ISLs in the view area and “spring” the 
product icons closer together. 

• Circular. Click to display the fabric in the more spread out, circular layout.

Center in Topology

Select a product icon in the tab’s view area and click this option to center the product 
and surrounding portion of the fabric in the view area. Selecting this option without 
selecting an icon centers the entire fabric in the view area.

Clear ISL Alert

This option is only enabled if you have persisted a fabric. You can clear an ISL alert 
on a specific ISL by clicking the ISL and selecting this option.

Clear All ISL Alerts

This option is only enabled if you have persisted a fabric. Selecting this will clear all 
ISL alerts in the view.
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Enable Fly Over Display

Enable the fly-over display of product identification and the number of ISLs between 
products when you move the cursor over elements in the view area by selecting the 
check box.

Disable the fly-over display by clearing the check mark.

Configure 

Choose the Configure menu on the menu bar to display the following options:

Users

Opens the Configure Users dialog box that allows you to administer HAFM users. 
For details, refer to Users on page 3-8. 

Nicknames

Opens the Configure Nicknames dialog box that allows you to provide nicknames for 
product and node WWNs. For details, refer to Nicknames on page 3-14. 

Sessions

Opens the Configure Sessions dialog box that allows you to configure remote access 
to the HAFM server from remote management stations. You can allow access from all 
management stations, restrict access to those stations with specific network addresses, 
or restrict access from all stations. You can also set the maximum allowed sessions 
from one to eight. For details, refer to Sessions on page 3-17.

SNMP Agent

Opens the Configure SNMP dialog box that allows you to configure the SNMP agent 
that runs on the HAFM server and implements the Fibre Alliance MIB. 

The HAFM server software contains a simple network management protocol (SNMP) 
agent component. The HAFM SNMP agent instruments the objects defined in the 
Fibre Channel Management (FCMGMT) Management Information Base (MIB) 
Version 2.2 and a small number of objects defined in MIB II. Through instrumentation 
of these MIB objects, the agent acts as a translator of information stored on the HAFM 
server and attached Directors into a form usable by SNMP management stations such 
as HP OpenView. Refer to the hp StorageWorks SNMP reference guide for directors 
and edge switches.

You can configure network addresses and community names for up to twelve SNMP 
trap recipients, which receive messages through SNMP for specific events that occur 
on the HAFM server.
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When configuring SNMP, you can configure just the community names of valid 
SNMP management stations. 

For details on using the Configure SNMP dialog box, refer to SNMP Agent on 
page 3-19.

Activate Zone Set

Opens the Activate Zone Set dialog box that allows you to select and activate 
configured zone sets. Only one zone set in the fabric can be active at one time. 
Activating a zone set replaces the current active zone set with the one you activate.

The dialog box displays all zone sets currently configured for the fabric. You can click 
Next to display additional screens that help you through the activation process or 
Previous to view previous screens. Refer to Activate Zone Sets on page 6-26 for 
details on zoning and use of this dialog box.

Zoning Library

Opens the Zoning Library dialog box. Use this dialog box to perform the major tasks 
for configuring zoning on the fabric:

• Configure zone sets by combining zone members (attached nodes)

• Configure zone sets by combining zones

• Clear zones

• Delete zones and zone sets

• Import and export zone sets

• Display zone and zone set properties

• Copy zones and zone sets

• Find zone members in zones

• Find zones in zone sets

• Display zone sets, zones, and zone members in library

Refer to Using the Zoning Library on page 6-11 for details on zoning and use of this 
dialog box.
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Advanced Zoning

Choose this option to open a secondary menu with the following options:

• Deactivate Zone Set. Click this option to display the Deactivate Zone Set dialog 
box. Use this dialog box to deactivate the current active zone set. Click Start to 
begin the process, and messages display to indicate deactivation status. When the 
Close button displays, you can close the dialog box. Refer to Default Zone on 
page 6-7 for details on zoning and use of this dialog box.

• Configure Default Zone. Click this option to display the Configure Default 
Zone dialog box. Use this dialog box to enable and disable the default zone. Click 
Start to begin the process, and messages display to indicate process status. When 
the Close button displays, you can close the dialog box. Refer to Default Zone on 
page 6-7 for details on zoning and use of this dialog box.

Active Tool Bar Options

Certain options on the tool bar are active in the Topology tab to provide quick access 
to frequently-used options that are also in tab menus. For information on other tool bar 
options, refer to Tool Bar on page 2-3.

Open Product

This tool bar option is available only when you select a product in the Topology tab 
view area. Click this to open the Product Manager for the product. Also open a 
product through the right-click product pop-up menu in the Fabric Tree. Refer to Open 
on page 5-7 for more information.

Properties

Click this to display a Properties dialog box for elements selected in the Topology tab 
view area. If a product is selected, the Properties dialog box for the Switch or 
Director displays (refer to Properties on page 4-6. If nothing is selected, the 
Properties dialog box for the fabric displays (refer to Properties on page 5-6).

Display Drop-Down Box

Click this drop-down list to change the product label under the product icon in the 
Topology tab’s view area. This display can be changed to Product Name, Network 
Address, World Wide Name, Domain ID, Nickname. These same options are 
available under the Display Option submenu on the right-click pop-up menu in the 
tab’s view area. Refer to View Area on page 5-12.
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Persist Fabric Topology

Click to persist the current fabric configuration. If the fabric is not persisted already, 
the Persist Fabric Topology dialog box displays so that you can enter a name for the 
fabric. Refer to Persistent Fabrics on page 5-14.

Export Fabric Topology

Click to display the Export Fabric Topology dialog box. This option is also available 
under the Fabrics menu on the menu bar. For details, refer to Export Fabric Topology 
on page 5-18.

Show Zoning Library

Click to display the Zoning Library dialog box. This option is also available under 
the Configure menu on the menu bar. For details, refer to Configuring Zoning through 
the HAFM on page 6-11

Layout Icons

Click this to change the fabric layout to the default layout for the view area between 
circular or spring. This option is also available under the View menu on the menu bar. 
Refer to Layout Icons on page 5-24 for details.

Show View Port

Opens up the view port window so that you can adjust the display of the fabric in the 
tab’s view area. This option is also available under the Fabrics menu on the menu bar. 

Click inside the View Port window and move the mouse to adjust the view of the 
fabric in the tab’s view area. 

Zoom In

Click this to zoom in and enlarge the view of fabric elements in the view area. This 
option is also available in the Zoom secondary menu under the View menu on the 
menu bar.

Zoom Out

Click this to zoom out and reduce the view of fabric elements in the view area. This 
option is also available in the Zoom secondary menu under the View menu on the 
menu bar.
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Fit Topology in View

This option is also available in the Zoom secondary menu under the View menu on the 
menu bar. This displays the entire fabric in the view area. This enlarges elements of 
smaller fabrics and reduces elements of large fabrics. Note that for larger fabrics, text 
and icons may be difficult to see. 

Using the Zone Set Tab
Click the Zone Set tab in the Fabrics view to open the Zone Set tab. Select a fabric in 
the Fabric Tree on the left side of the tab to display information on the currently active 
zone set for the fabric in the right view area. Initially, a tree structure of zones and 
zone members in the active zone set is completely expanded in the display area. An 
expanded tree of zone members will also display for the default zone if it is currently 
enabled.

Expand and compress the lists of zones and zone sets in the display area by clicking 
the icons to the left of the zone and zone set names. You can display all zone members 
for each zone, only zone members logged in, or only zone members not logged in 
using the drop-down list above the display area.

View Area Features

This section describes the buttons, drop-down lists, and messages that display in the 
view area.

• Click the Save Active Zone Set As button to display the Save Active Zone Set As 
dialog box. Enter a name for the zone set and click OK to save the active zone set 
under a different name in the zone set library.

• Click Refresh to refresh the display area with current zone set data.

• Right-click in the view area to display the Display Options menu. Choose 
Nickname to display zone members by nickname (if configured). Choose World 
Wide Name to display members by their 16-digit WWN.

• The information area at the bottom of the tab will display one of three messages:

— The Default Zone is ENABLED. If the default zone is enabled, members 
in the default zone appear in the tree structure of zones and members in the 
display area.
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— The Default Zone is DISABLED. If disabled, members of the default 
zone will not appear in the tree structure in the display area.

— The active zone set does not currently match any of the 
stored zone sets. This displays if the active zone set does not match any 
zone sets in the zoning library.

Available Menu Bar Options

All menu bar options that are enabled in the menu bar are covered in Chapter 3, Using 
the Menu Bar of this guide. You can also show or hide the Fabric Tree on the left side 
of the tab by clicking the Show Fabric Tree check box under the Fabrics menu. This 
expands the view area for displaying the active zone, zones, and members.

For More Information

For details on configuring zoning, including activating and deactivating zone sets and 
disabling and enabling the default zone, refer to Chapter 6.
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6
Fabric Zoning

This chapter explains how to:

• Zone fabrics

• Use zoning features and dialog boxes

Zoning Basics
NOTE:  Designing zoning can be a complex task, especially for multiswitch fabrics. Refer to 
HP’s professional services organization before configuring zoning.

This section is designed to help you understand the following concepts so that you can 
more efficiently use HAFM features to configure and manage zones across a 
multiswitch fabric:

• Benefits of zoning.

• How zoning works to control access to storage devices and servers across a fabric.

• Other methods of controlling access at the Switch, server, and device (such as 
binding).

• Merging zoned fabrics.

• Basic concepts of zoning that you must deal with in configuring zoning such as 
zones, zone sets, active zones, default zones, and zoning libraries.

Controlling Access Across a Fabric

The fabric zoning feature enables you to partition devices attached to managed Fibre 
Channel products into groups called zones. A zone contains devices that can access 
one another through port-to-port connections. Devices in the same zone can recognize 
and communicate with one another; devices in different zones cannot. 

System administrators create zones to increase security measures and prevent data loss 
or corruption by controlling access between devices (such as servers and data storage 
units), or between separate user groups (such as engineering or human resources). 
Zoning allows an administrator to:
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• Establish barriers between devices that use different operating systems. For 
example, it is often critical to separate servers and storage devices with different 
operating systems because accidental transfer of information from one to another 
can delete or corrupt data. Zoning prevents this accidental transfer of information 
by grouping devices that use the same operating systems into zones.

• Create logical subsets of closed user groups. Administrators can authorize access 
rights to specific zones for specific user groups, thereby protecting confidential 
data from unauthorized access.

• Create groups of devices that are separate from devices in the rest of a fabric. 
Zoning allows certain processes (such as maintenance or testing) to be performed 
on devices in one group without interrupting devices in other groups.

• Allow temporary access between devices for specific purposes. Administrators 
can remove zoning restrictions temporarily (for example, to perform nightly data 
backup), then restore zoning restrictions to return to normal processes.

Figure 6–1 illustrates three zones established on a single managed product with four 
devices in each zone. Devices in each zone can communicate with and access devices 
only in their respective zones.

Figure 6–1:  Zoning through a single Fibre Channel managed product
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Figure 6–2 illustrates how zones can consist of ports and/or devices installed on ports 
in three managed products in a multiswitch fabric.

Figure 6–2:  Zoning through a multiswitch fabric
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Controlling Access at the Switch

A port binding feature is available on Switches and Directors that allows you to “bind” 
a specific Switch or Director port to the WWN of an attached device for exclusive 
communication. This WWN binding feature is available through the Configure Ports 
option in the Product Manager application’s Configure menu. This feature is also 
available through the pop-up menu when you right click a port in the Hardware View, 
Port Card View, Port List View, and Performance View.

Controlling Access at the Server or Storage Device

Features available at the server or storage device can add methods, beyond zoning, to 
increase network security measures, differentiate between operating systems, and 
prevent data loss or corruption by controlling access between devices or between 
separate user groups (such as Engineering or Human Resources).

Server-level access control is called persistent binding. Persistent binding uses 
configuration information stored on the server and is implemented through the 
server’s host bus adapter (HBA) driver. The process binds a server device name to a 
specific Fibre Channel storage volume or logical unit number (LUN), through a 
specific HBA and storage port WWN. In essence, this feature creates a reliable route 
across the fabric that sustains the small computer system interface (SCSI) connection 
between a server and storage device. 

For persistent binding:

• Each server HBA is explicitly bound to a storage volume or LUN, and access is 
explicitly authorized (access is blocked by default).

• The process is compatible with open system interconnection (OSI) standards. The 
following are transparently supported:

— Different operating systems and applications.

— Different storage volume managers and file systems.

— Different fabric devices, including disk drives, tape drives, and tape libraries.

• If the server is rebooted, the server-to-storage connection is automatically 
re-established.

• The connection is bound to a storage port WWN. If the fiber optic cable is 
disconnected from the storage port, the server-to-storage connection is 
automatically re-established when the port cable is reconnected. The connection is 
also automatically re-established if the storage port is cabled through a different 
managed product port.
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Access can also be controlled at the storage device as an addition or enhancement to 
redundant array of independent disks (RAID) controller software. Data access is 
controlled within the storage device, and server HBA access to each LUN is explicitly 
limited (access is blocked by default). Storage-level access control:

• Provides control at the storage port and LUN level, and does not require 
configuration at the server.

• Is typically proprietary and protects only a specific vendor’s storage devices. 
Storage-level access control may not be available for many legacy devices.

NOTE:  Refer to HP’s professional services organization before establishing persistent binding 
and when establishing access control features at the storage device.

Zoning Concepts

Zoning is configured by authorizing or restricting access to name server information 
associated with device ports that attach to product ports. A zone member is specified 
by the number of the product port to which a device is attached, or by the 8-byte World 
Wide Name assigned to the host bus adapter or Fibre Channel interface installed in a 
device. A device port can belong to multiple zones.

Zoning concepts include:

• Zones 

• Default Zone

• Zone Sets

• Zone Library

• Active Zone Set

Naming Conventions for Zones and Zone Sets

The following naming conventions apply to zones and zone sets:

• All names must be unique and may not differ by case only. For example, myzone 
and MyZone are both valid individually, but the are not considered to be unique.

• The first character of a zone set name must be a letter (A-Z, a-z).

• A zone set name cannot contain spaces.

• Valid characters are a-a, A-A, 0-9, ^, -, _, and $.

• A zone set name can have a maximum of 64 characters.
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Zones

A zone comprises a set of members that can access each other. Refer to Table 6–2 on 
page 6-12 for details on the number of members that you can configure in a zone and 
the number of zones that you can configure in the HAFM zoning library. 

A zone member can be a product port or the WWN of the device. Ports and devices 
spread throughout multiple managed products in a multiswitch fabric may be grouped 
into the same zone. Members of a zone can communicate with one another; members 
in different zones cannot. The number of members that you can configure for a zone 
varies according to the number of zones in the zone set, the length of the zone names, 
and other factors, but is essentially bounded by the available nonvolatile 
random-access memory (NVRAM) in the managed product.

NOTE:  Port numbers cannot be used for zone members if the interoperability mode for the 
Switch or Director is set to Open Fabric 1.0 mode. In this case, you must use node WWNs as 
zone members.

The type of zone members identified for a zone may be mixed and matched. For 
example, two members may be specified by a port number and the third member by 
the WWN of the device.

Using WWNs

To identify a zone member by WWN, use the 16-digit WWN of the device. For 
example:

10:00:08:00:88:40:C0:D4

In the HAFM and Product Manager, the WWN is preceded with the Switch or 
Director manufacturer’s name. The WWN is assigned to the Fibre Channel interface 
or HBA installed in devices such as servers or storage devices. Although the device 
may also have a node WWN, this WWN is not used for zoning identification. If you 
have assigned a nickname to the WWN through the Configure Nicknames dialog 
box, that nickname displays when you point to the WWN. In this case, you will assign 
the nickname as the zone member.

The advantage of identifying a zone member as the WWN of the attached device is 
that the identification will not change if fiber cable connections to ports are 
rearranged. This is especially important if you are using spare ports. You can simply 
move the fiber cable to a spare port from a failed port and still maintain the zoning 
configuration.

The disadvantage of identifying a zone member by the WWN is that removal and 
replacement of a device HBA or Fibre Channel interface (thereby changing the device 
WWN) disrupts zone operation and may incorrectly include or exclude a device from 
a zone.
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Using Port Numbers

To identify a zone member by port number, use the domain identification number of 
the managed product and the port number on that managed product. For example:

Domain 1, Port 1

NOTE:  Port numbers cannot be used for zone members if the interoperability mode for the 
Switch or Director is set to Open Fabric 1.0 mode.

Port numbers can be 0-n, with n representing the number of ports on the managed 
product minus one. When you define a zone member by a port number, any device 
attached through that port is included in the zone. A port number that you assign as a 
zone member is automatically prefixed with the domain identification number of the 
managed product. 

The advantage of identifying a zone member by port number is that if the HBA on an 
attached device fails, you do not have to identify the member with the WWN of the 
replacement HBA. 

A disadvantage of port zoning is that someone may rearrange cable connections to 
ports (because of port failures or other reasons) and inadvertently allow devices to 
communicate that should not have access to each other. 

NOTE:  If a managed product’s Domain ID changes, you must reconfigure all zones that 
contained the managed product’s port as a zone member. HP recommends assigning unique 
preferred Domain ID’s to each Switch in the fabric using the Configure Switch Parameters 
dialog box in the Product Manager.

Default Zone

A default zone consists of all devices that have not been configured as members of a 
zone in a currently-active zone set. Here are some important points to remember about 
zone sets:

• While viewing the Fabrics tab, you can enable or disable the default zone 
separately from the active zone set by selecting the Configure Default Zone 
option from the Advanced Zoning options in the Configure menu. Enabling the 
default zone allows all devices and ports not configured as members of the active 
zone set to communicate. If the default zone is disabled, these ports and devices 
cannot communicate. 

• When no zone set is activated, then all devices are considered to be in the default 
zone. 

• If a zone set is active, then all connected devices that are not included as a 
members of a zone in the active zone set are included in the default zone.
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Zone Sets

A zone set is a group of zones that you can activate or deactivate as a single entity 
across all managed products in either a single Switch or a multiswitch fabric. Only one 
zone set can be active at one time. Devices that are members of zones in the zone set 
can only communicate with members of zones in the same zone set. However, devices 
can be included as members of more than one zone set. By activating a zone set, you 
are making all zones in the set active. 

Refer to Table 6–2 on page 6-12 for details on the number of zones and zone members 
that you can configure in a zone set and the number of zone sets that you can configure 
in the HAFM zoning library.

Here are some important points to remember about zone sets:

• If no zone set is active, and the default zone is disabled, then no devices can 
communicate.

• If you activate a zone set when there is already an active zone set, that set will 
replace the currently active zone set. 

• If you deactivate the current active zone set, then all devices connected in the 
fabric become members of the default zone.

Active Zone Set

An active zone set is a zone set that is currently active on a single-switch fabric or 
across all managed products in a multiswitch fabric. At any time, you can disable 
zoning by deactivating the active zone set and enabling the default zone, or you can 
enable zoning by activating a zone set. When a zone set is active, all zones that are 
members of that zone set are active. Only one zone set can be active for the fabric at 
one time. If no zones are active, then all devices are considered to be in the default 
zone.

Zoning Library

The Zoning Library contains all of the zone members, zones, and zone sets configured 
through the HAFM. Any zone set in the library may be selected and activated on a 
fabric. You can view components of this library through dialog boxes and panels in the 
Zones and Zone Sets tabs of the Zoning Library dialog box. 

Merging Zoned Fabrics

Managed products are linked through ISLs to form multiswitch fabrics. In a 
multiswitch fabric, the active zoning configuration applies to the entire fabric. Any 
change to the configuration applies to all Switches in the fabric. 
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Configurations of Merged Zoned Fabrics

When fabrics join through an ISL, adjacent managed products exchange active zone 
configurations and determine if the configurations are compatible and can merge. If 
the configurations can merge, the fabrics join. The resulting configuration will be a 
single zone set containing zone definitions from each fabric.

If configurations cannot merge, the expansion ports (E_Ports) on each product become 
segmented. Segmented E_Ports cannot carry traffic from attached devices (class 2 or 3 
traffic), but can carry management and control traffic (class F traffic) between 
managed products.

Zoning configurations are compatible if the active zone names in each fabric are 
unique. If there are identical zone names in each fabric, then the zones must have 
identical members for the fabrics to join.

Rules for Merging Zoned Fabrics

Certain rules are enforced to ensure that zoning is consistent across the fabric. 
Table 6–1 on page 6-10 summarizes rules for joining two fabrics through an ISL. The 
following terms are used in the table:

• Not zoned 

No zone set is active in the fabric and the default zone is enabled. In other words, 
all devices in the fabric are visible to all other devices in the fabric. 

• Zoned 

A zone set is active in the fabric and/or the default zone is disabled. In this case, 
devices can discover other devices that are members of the same zone.

• Zoning configuration

Combination of the active zone set definition and the default zone state (enabled 
or disabled)
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Table 6–1:  Merging Fabrics — Results for Zone Configurations

NOTE:  If merging zones will result in segmented E_Ports and the fabrics will not join, you can 
join the fabrics by deactivating the active zone set on one of the fabrics (default zone is 
enabled). This eliminates any conflicts because the fabrics will then join using only the active 
zone set. After the fabrics join, you can make adjustments to zoning configurations as you 
desire.

Fabric A Fabric B Result

Not zoned Not zoned Fabrics join successfully. The new 
fabric remains not zoned.

Not zoned Zoned Fabrics join successfully and the 
active zone set will propagate across 
the fabric. Fabric A inherits zoning 
configuration from Fabric B.

Zoned Not zoned Fabrics join successfully and the 
active zone set will propagate across 
the fabric. Fabric B inherits zoning 
configuration from Fabric A.

Zoned Zoned Fabrics can merge if the zone names 
in each fabric are unique. The 
resulting active zone set is a union of 
the zones from each fabric. Once 
you have merged the two zoned 
fabrics, click the Save active zone 
set as button in the Zoning view to 
save the active zone set to the zone 
set library.

If there is a zone name conflict (the 
same zone name in each fabric) 
then the zones must have identical 
members for the fabrics to join. 

If the two zones have the same 
name but contain different members, 
then the E_Ports will segment and 
the fabrics will not join.
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Configuring Zoning through the HAFM
This section provides procedures for using the menu options available through the 
HAFM Fabrics tab to configure and manage zoning. For information on other menu 
options, refer to Chapter 3, Using the Menu Bar.

To configure new zones and a zone set, then activate a new zone set for the fabric, 
follow these three steps:

1. Create zones. Follow steps under Configure Zones on page 6-14 under 
Configuring Zoning through the HAFM.

2. Create a zone set. Follow steps under Configure Zone Sets on page 6-17 under 
Configuring Zoning through the HAFM.

3. Activate the zone set. Follow steps under Activate Zone Sets on page 6-26.

NOTE:  Designing zoning can be a complex task, especially for multiswitch fabrics. You should 
obtain help from HP’s professional services organization before configuring zoning.

Using the Zoning Library

Open the Zoning Library dialog box in either the Products or Fabrics tab by 
choosing Zoning Library from the Configure menu on the menu tab. 

Figure 6–3:  Zoning Library dialog box
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Use this dialog box to perform major tasks for configuring zoning on the fabric:

• Display zone sets, zones, and zone members in library

• Configure zones by adding zone members (attached nodes)

• Configure zone sets by adding zones

• Clear zones

• Delete zones and zone sets

• Import and export zone sets

• Display zone and zone set properties

• Copy zones and zone sets

• Find zone members in zones

• Find zones in zone sets

The following table lists the configuration limits for zone members, zones, and zone 
sets in the HAFM.

Table 6–2:  Zoning Configuration Limits for High Availability Fabric Manager

The supported number of zones is based on a zone name with a maximum of 32 
characters. On all products except the Director 2/140, the maximum number of zones 
decreases if full 64 character names are used. The supported limits are based on two 
members per zone.

Zoning Configuration Limit

Number of zones in Zoning Library 2,000

Number of zone sets in Zoning 
Library

64

Number of members in zone 1,024

Number of zones 1,024 (1,023 plus the default zone)

Number of unique zone members in 
a zone set

1,024

Number of members in a zone set 
(with duplicate members allowed)

8,192

Characters per zoning name 64
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Menus

The following menus and options are available in the Zoning Library dialog box. 
Page numbers are provided for procedures in using these options. Options under 
specific menus may only be enabled or perform different functions depending on 
whether the Zones or Zone Sets tab is selected.

Table 6–3:  Menu Options in Zoning dialog boxes 

Menu Menu Option Procedures 

File (menu bar) New (Zones Tab) Configure Zones, page 6-14

File (menu bar) New (Zone Sets Tab) Configure Zone Sets, page 6-17

File (menu bar) Open Modify Zones and Zone Sets, 
page 6-19

File (menu bar) Rename Rename Zones and Zone Sets, 
page 6-21

File (menu bar) Delete Delete Zones and Zone Sets, 
page 6-21

File (menu bar) Import Zone Set Import and Export Zone Sets, 
page 6-22

File (menu bar) Export Zone Set Import and Export Zone Sets, 
page 6-22

File (menu bar) Properties Display Zone and Zone Set 
Properties, page 6-22

File (menu bar) Close Closing the Zoning Library, 
page 6-26

Edit (menu bar) Copy Zone Set (Zone 
Sets tab)

Copy Zones and Zone Sets, 
page 6-20

Edit (menu bar) Copy Zone (Zones 
tab)

Copy Zones and Zone Sets, 
page 6-20

Edit (menu bar) Find Zone (Zones 
tab)

Find Zones, page 6-24

Edit (menu bar) Find Member Find Zone Members, page 6-25

Right-click menu 
(zoning library)

Open (Zones tab) Modify Zones and Zone Sets, 
page 6-19

Right-click menu 
(zoning library)

Rename Rename Zones and Zone Sets, 
page 6-21
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Display Configured Zone Sets and Zones

Click the Zone Sets tab (default) to display all configured zone sets. 

Click the Zones tab (default) to display all configured zones. 

Click a zone set or zone to select it. Once selected, use options from the File menu to 
modify, rename, delete, or obtain properties for zones and zone sets. Use options from 
the Edit menu to copy zone sets, copy zones, find zones in zone sets, and find 
members in zones.

Configure Zones

A zone is a set of members. These members can be physical ports of managed 
products in a fabric or nodes attached to managed products. Ports are identified by the 
managed product domain and physical port member. Devices are identified by the 
WWN of the device. You can configure up to 4,096 members in a single zone.

Use the following steps to configure a zone:

1. Open the Zoning Library by choosing Configure > Zoning Library.

2. Click the Zones tab.

3. Choose File > New. The New Zone dialog box displays (Figure 6–4 on 
page 6-15).

4. Enter a name for the zone in the Zone Name field. 

NOTE:  Names for zones and zone sets must follow specific rules. Refer to Naming 
Conventions for Zones and Zone Sets on page 6-5 for details.

5. Select the fabric for which zoning is being configured from the drop-down menu.

6. In the Attached ports/nodes area, click the icon to the left of a numbered domain 
folder to display a list of ports and attached nodes for the Director or Switch. Note 
that the WWN for the Switch or Director displays to the right of the product’s 
domain number. 

A list of ports with attached nodes expands under the selected domain.

Right-click menu 
(zoning library)

Delete Delete Zones and Zone Sets, 
page 6-21

Right-click menu 
(zoning library)

Properties Display Zone and Zone Set 
Properties, page 6-22

Menu Menu Option Procedures 
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Figure 6–4:  New Zone dialog box

NOTE:  The icon that you click to expand the list of ports may not appear by a domain where no 
nodes attached to ports. 

7. Add members to the new zone using the following steps:

a. Decide if you want to add members by port number or WWN of attached 
node.

— If you want to add zone members by port number only (not supported in 
Open Fabric 1.0 interop mode), click the Add by Port radio button at the 
bottom of the display area. Click the icon next to the domain folder again 
to display only the products in the Attached ports/nodes area. If the 
operating mode is set to Open Fabric Mode and you select the Add by 
port number option, a message will display indicating that “Zoning 
may be configured by port but will actually be 
enforced by WWN in Open Fabric Mode”

— If you want to add zone members by the WWNs of attached nodes, click 
the Add by WWN radio button, then click the icon by the domain folder 
again. This displays all ports and the WWNs of nodes attached to those 
ports in the Attached ports/nodes area. To display nodes by their WWN 
or nicknames (if configured), click the Display Options button and select 
either Nickname or World Wide Name from the Display Options dialog 
box. Click the icon by the domain folder again to expand the list of nodes.
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b. Click a node or port in the expanded list to highlight it. To select multiple 
members individually, press Ctrl and click members. To select multiple 
members in order, press Shift and click the first and last members of the group 
you want to move. 

8. Click the Add >> button to move the selections to the Members in zone area on 
the right side of the screen.

Figure 6–5 illustrates members added to the new zone. The first two items in the 
Members in zone area were added with Add by port selected. The next two 
items were added with Add by WWN selected.

Figure 6–5:  New Zone dialog box — Adding Zone Members

9. To add nodes that are not listed in the Attached ports/nodes area (for example, 
detached nodes), click Add Detached Nodes at the bottom of the Members in 
zone area. The Add Detached Nodes dialog box displays. 

Figure 6–6:  Add Detached Nodes dialog box
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10. Either click World Wide Name and enter a valid 16-digit WWN or click 
Nickname and enter a configured nickname for the WWN into the corresponding 
field. (Note that the nickname must have been configured through the Configure 
Nicknames dialog box first.)

11. To remove members from the zone, select them and click the << Remove button. 
To remove all of the members, click Clear Zone at the bottom of the Members in 
zone area. Click Yes when the Warning dialog box displays.

12. To accept the zone, click OK. The New Zone dialog box closes and the new zone 
displays in the Zones tab of the Zoning Library dialog box.

Configure Zone Sets

A zone set is a collection of zones that you can activate or deactivate as a single entity 
across all managed products in a multiswitch fabric or on one product in a single 
Switch fabric. Members in each zone are identified using the steps in Configure Zones 
on page 6-14.

For specifications on the number of zones in a zone set and the number of zone sets 
that you can configure in the HAFM library, refer to Table 6–2 on page 6-12.

1. Open the Zoning Library by choosing Configure > Zoning Library.

2. The Zone Sets tab should display as the default. If not, click the Zone Sets tab. 

3. Choose File > New. The New Zone Set dialog box displays (Figure 6–7 on 
page 6-18).
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Figure 6–7:  New Zone Set dialog box

Configured zones should display in the Zones in Library area. If zones do not 
display, you must first configure zones before you can configure any zone sets.

To view members in the zones displayed, click a zone to select it, then click View 
Members at the bottom of the Zones in Library field.

4. Enter a name for the new zone set in the Zone Set Name field. 

Names for zones and zone sets must follow specific rules. Refer to Naming 
Conventions for Zones and Zone Sets on page 6-5 for details.

5. Add zones to the new zone set by selecting a zone in the Zones in Library section 
and click Add >>.

NOTE:  To move multiple zones, press the Ctrl or Shift key while clicking the zones. 

6. Remove zones from the Zones in Zone Set section by selecting the zones and 
clicking <<Remove.

Figure 6–8 on page 6-19 shows zones added to the Zones in Zone Set section.
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Figure 6–8:  New Zone Set dialog box — Adding Zones

7. To accept the zone set, click OK. The New Zone Set dialog box closes and the 
new zone set displays in the Zone Set tab of the Zoning Library dialog box.

Modify Zones and Zone Sets

Use the following procedures to modify existing zones and zone sets using the Open 
option in the File menu.

Zones

1. Choose the Zones tab in the Zoning Library dialog box.

2. Click a zone in the library to select it.

3. Click File > Modify or right-click the zone and choose Modify from the pop-up 
menu.

The Modify Zone dialog box displays.

4. Use steps, starting with Step 5 under Configure Zones on page 6-14, to add zone 
members, remove zone members, or clear zones. Note that the zone name cannot 
be changed in this dialog box. Choose the zone in the Zoning Library dialog box, 
then choose Rename from the File menu to do this.



6–20 ha-fabric manager user guide

Fabric Zoning

Zone Sets

1. Choose the Zone Sets tab in the Zoning Library dialog box.

2. Click a zone set to select it in the library.

3. Click File > Modify.

The Modify Zone Set dialog box displays.

4. Use steps, starting with Step 5 under Configure Zone Sets on page 6-17, to view 
zone members or add or remove zones from zone sets. Note that the zone set name 
cannot be changed in this dialog box. Choose the zone set in the Zoning Library 
dialog box, then choose File > Rename.

Copy Zones and Zone Sets

Copy zones and zone sets to a zone or zone set with a different name using the 
following steps.

Zones

1. Choose the Zones tab in the Zoning Library dialog box.

2. Click a zone to select it in the library.

3. Choose Edit > Copy Zone.

4. When the Copy Zone dialog box displays, enter a name of up to 64 characters (no 
spaces) for the zone.

5. Click OK and the new zone displays in the Zoning Library dialog box.

Zone Sets

1. Choose the Zone Sets tab in the Zoning Library dialog box.

2. Click a zone to select it in the library.

3. Choose Edit > Copy Zone.

4. When the Copy Zone Set dialog box displays, enter a name of up to 64 characters 
(no spaces) for the zone.

5. Click OK and the new zone set displays in the Zoning Library dialog box.
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Delete Zones and Zone Sets

Zones

1. Choose the Zones tab in the Zoning Library dialog box.

2. Click a zone to select it and choose File > Delete, or right-click the zone and 
choose Delete from the pop-up menu.

3. Click Yes when the Warning dialog box displays to confirm the deletion.

Zone Sets

1. Choose the Zone Sets tab in the Zoning Library dialog box.

2. Click a zone set to select it and choose File > Delete, or right-click the zone and 
choose Delete from the pop-up menu.

3. Click Yes when the Warning dialog box displays to confirm the deletion.

Rename Zones and Zone Sets

Delete zones and zone sets from the library using the following steps:

Zones

1. Choose the Zones tab in the Zoning Library dialog box.

2. Click a zone to select it and choose File > Rename, or right-click the zone and 
choose Rename from the pop-up menu.

3. When the Rename dialog box displays, enter a new name.

Names for zones and zone sets must follow specific rules. Refer to Naming 
Conventions for Zones and Zone Sets on page 6-5 for details.

4. Click OK, and the zone is renamed in the Zoning Library dialog box.

Zone Sets

1. Choose the Zone Sets tab in the Zoning Library dialog box.

2. Click a zone set to select it and choose File > Rename, or right-click the zone and 
choose Rename from the pop-up menu.

3. When the Rename dialog box displays, enter a new name of up to 64 characters.

4. Click OK, and the zone set is renamed in the Zoning Library dialog box.
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Import and Export Zone Sets

While using the Zone Sets tab, use these options from the File menu to export a 
zone set as an .xml file and import the zone set into another zoning library. Note 
that you cannot import the zone set if it contains zones that are already in new 
zoning library. If you do, an error message displays for all zones that are not 
compatible.

Export Zone Set

1. Choose the Zone Sets tab in the Zoning Library dialog box.

2. Choose a zone set for export.

3. Choose File > Export Zone Set.

The Export Zone Set dialog box displays. 

4. Enter a name in the dialog box for the .xml file in the File Name field, select a 
folder on your C: drive or network drive where you want to save the file, then click 
Save.

The file saves in the location with an “.xml” extension (for example, zoneset.xml).

Import Zone Set

1. Choose the Zone Sets tab in the Zoning Library dialog box.

2. Choose File > Import.

The Import Zone Set dialog box displays. 

3. Find the exported zone set file with the “.xml” extension by opening folders in the 
display area and selecting directories through the Look in drop-down list.

4. Click Import.

The zone set is added to the HAFM server’s zoning library.

If the imported zone set contains zones that are already in the library, an error message 
displays.

Display Zone and Zone Set Properties

Zone and Zone Set Properties boxes summarize details on selected zones and zone 
sets.
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Zones

1. Choose the Zones tab in the Zoning Library dialog box.

2. Click a zone to select it and choose File > Properties, or right-click the zone and 
choose Properties from the pop-up menu.

The Zone Properties dialog box displays (Figure 6–9).

Figure 6–9:  Zone Properties dialog box

The dialog box summarizes the number of zone sets containing the same zone and 
lists the zone members in the zone.

3. Click Close to close the dialog box.

Zone Sets

1. Choose the Zone Sets tab in the Zoning Library dialog box.

2. Click a zone set to select it and choose File > Properties, or right-click the zone 
and choose Properties from the pop-up menu.

The Zone Set Properties dialog box displays (Figure 6–10).
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Figure 6–10:  Zone Set Properties dialog box

The dialog box summarizes the number of zones and unique zone members in the 
zone set. The Zone Set Library, consisting of the zone set, its zones, and zone 
members, are displayed in a tree structure in the Zones In Set display area. Click 
the icon to the left of the zone set folder to expand the list of zones in the set. Click 
the icon to the left of a zone folder to expand the list of members in that zone.

3. Click Close to close the dialog box.

Find Zones

You can find zones by using the Find Zone option in the Edit menu (Zones tab). Use 
this option to get a quick view of which zone sets a selected zone is part of. Once you 
find a zone in a specific zone set, you can remove the zone from the zone set using the 
Remove button on the Find Zone dialog box. To find zones:

1. Choose the Zones tab in the Zoning Library dialog box.

2. Click a zone to select it.

3. Choose Edit > Find Zone.

The Find Zone dialog box displays listing all zone sets where the zone was found. 

4. If you want to remove the zone from zone sets, click Remove.

The Remove Zone dialog box displays with the radio button selected to remove 
the zone from the zone set that is currently selected in the Zone Sets tab.
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5. Perform one of the following tasks:

• Click OK to remove the zone from the selected zone set.

• Click the All Zone Sets radio button, then OK to remove the zone from all 
zone sets in the library.

Find Zone Members

Use this option to find zones where a zone member’s WWN or nickname (if 
configured) is located. Once located, you can remove the member from specific zones 
or all zones or replace the member with a different WWN or nickname.

1. While in either the Zones or Zone Sets tab, choose Edit > Find Member.

2. The Find WWN/Nickname dialog box displays.

3. Enter a valid WWN or nickname (if configured) and click OK.

The Find WWN/Nickname dialog box displays listing all zones where the 
member was found in the right part of the dialog box and zone sets where the 
zones were found in the left part of the dialog box. You can click the zone sets and 
zones that display in the dialog box to select them.

Figure 6–11:  Find WWN/Nickname dialog box

4. If you want to remove or replace the member in a specific zone or all zones, click 
a zone set and zone listed in the to select it. Note that the zone may be in more 
than one zone set. 

5. Click Remove. 

The Remove WWN/Nickname dialog box displays with the a radio button 
selected to remove the member from the selected zone.
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6. Perform one of the following tasks:

• Click OK to remove the member from the selected zone

• Click the All Zones button to remove the member from all zones in the library 
and click OK.

7. To replace the member in a specific zone with another member:

a. Choose a zone set and zone in the Find WWN/Nickname dialog box, then 
click the Replace button.

b. When the Replace WWN/Nickname dialog box displays, enter the WWN or 
nickname of the member that you want to substitute for the member in the 
selected zone, then click OK. The member is replaced with the one you 
entered into the dialog box.

Closing the Zoning Library

Choose File > Close to close the Zoning Library dialog box.

Activate Zone Sets

Choose the Activate Zone Set option from the Configure menu on the HAFM menu 
bar to activate a zone set to control access between devices in a fabric. Only one zone 
set in the fabric can be active at one time. Activating a zone set replaces the current 
active zone set with the one you activate.

Note that changing the configuration for an active zone set does not dynamically apply 
changes. For any change to a zone set, even modifying members in a zone that belongs 
to a zone set, activate the zone set using the following steps.

NOTE:  It is not necessary to deactivate the active zone set before activating a new zone set.

1. Choose the Fabrics tab.

2. Choose the fabric in the Fabric Tree area for which the zone set is to be activated.
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3. Open the Activate Zone Set dialog box (Figure 6–12) by choosing Configure > 
Activate Zone Set. The dialog box displays all zone sets currently configured for 
the fabric. 

Figure 6–12:  Activate Zone Set dialog box

4. Click a zone set to select it.

5. Click Next to begin the activation.

An Activate Zone Set screen (Figure 6–13 on page 6-28) displays that shows the 
differences between the zone set that you are activating and the old zone set. In the 
differences area, click the icon before the zone set name to expand the list of zones 
in the set.
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Figure 6–13:  Activate Zone Set (Differences) screen

Determine which zones will be added and removed when the previous zone set is 
replaced with the new zone set by the icons and text color displayed in the 
expanded list of zone names.

Table 6–4:  Icons and Text Indicators for Zone Set Differences

Icon Zone Name Text Color Meaning

Blue circle 
containing 
white plus (+) 
sign.

Blue Zone to be added for 
active zone.

Red circle 
containing 
white minus (-) 
sign.

Red Zone to be removed 
for active zone.
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6. Click Next.

An Activate Zone Set screen (Figure 6–14 on page 6-29) displays, listing the 
Directors and Switches affected by the change in active zone sets. The 
Switch/Director domain ID displays in the left panel and the WWN displays in the 
right panel. The domain ID is a unique domain identification of a Switch or 
Director product (for example, 1-31).

Messages may display in this screen warning you of possible consequences when 
activating the new zone set.

Figure 6–14:  Activate Zone Set (Directors/Switches Affected) screen

Click the radio buttons in the View By area to change the display in the right panel 
between Director/Switch WWN, the product name configured through the 
Product Manager, and the network address (or DNS host name).

7. Click Next.

A Status screen displays with further instructions.

8. Click Start to activate the zone set.

Messages appear in the screen about activation status in the fabric.

9. When the Activate zone Set complete message displays, click Close to 
close the dialog box and complete the process.
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Deactivate Zone Sets

To deactivate zone sets:

1. Select the fabric in the Fabric Tree area for which the zone set is to be 
deactivated.

2. Choose Configure > Deactivate Zone Set (Advanced Zoning submenu). The 
Deactivate Zone Set dialog box displays. Use this dialog box to deactivate the 
current active zone set. 

3. Click Start to begin the process and messages display to indicate deactivation 
status. When the Close button displays, you can close the dialog box. 

Configure the Default Zone

To configure the default zone:

1. Select the fabric in the Fabric Tree area for which the default zone is to be 
configured.

2. Choose the Configure > Configure Default Zone (Advanced Zoning submenu). 
The Configure Default Zone dialog box displays. Use this dialog box to enable 
and disable the default zone. 

3. The Configure Default Zone dialog box displays the current state of the default 
zone (enabled or disabled). Depending on the current state, press Start to enable 
or disable the zone. Messages display to indicate process status. When the Close 
button displays, you can close the dialog box.

A default zone consists of all devices that have not been configured as members of a 
zone in a currently-active zone set. When no zone set is active, then all devices are 
considered to be in the default zone. If a zone set is active, then all connected devices 
that are not included in at least one of the zones in the active zone set are included in 
the default zone.

Enabling the default zone allows any device in the default zone to see any other device 
in the default zone. If the default zone is disabled and no zone set is active, then 
devices connected to the product cannot communicate.
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Show Zone Members

To show zone members:

1. Select the fabric in the Fabric Tree area for which zone members are to be shown.

2. Click the Fabrics > Show Zone Members to display the Show Zone Members 
dialog box. 

This dialog box displays a tree of all products in the fabric in the left panel. 

3. Click an icon by a product name to expand the list of attached nodes. 

4. Select a node, and the WWNs (or nicknames, if configured) of nodes that are 
members of the same zone as the node selected display in the right panel. 

Refer to Chapter 6 for details on zoning and zoning configuration.

Backing Up Zoning Configurations

As long as a Zip disk is kept in the Zip drive on the HAFM server, configuration data 
and other critical information will be backed up to the disk automatically when the 
data directory contents change or the HAFM server is rebooted. This function is 
handled through the Iomega QuikSync application. Refer to Backing Up and Restoring 
Data on page 1-8 for more information.
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HAFM Logs

This chapter contains information on the High Availability Fabric Manager logs.

Using Logs
The Audit, Session, Product Status, and Fabric Logs store up to 1000 entries each. The 
most recent entry displays at the top of the log. After 1000 entries are stored, new 
entries overwrite the oldest entries.

The Event Log stores up to 500 entries. The most recent entry displays at the top of the 
log. After 500 entries are stored, new entries overwrite the oldest entries.

Sorting Logs

Sorting log entries is the same for all logs. Sort log entries in columns by clicking a 
column heading. For columns that contain text, the columns are sorted alphabetically. 
For columns with data, such as date and time, the columns are sorted by date. The 
default view for all logs is to show the most current event based on date and time when 
the event occurred.

A down arrow in the header indicates sorting in descending order. An up arrow 
indicates sorting in ascending order. Click once to sort. Click again to reverse the sort.

Button Function

Button function is the same for all logs:

• Export

Click Export to display the Save dialog box shown in Figure 7–6 on page 7-8. 
Click Home to display the folders that are stored in your home directory. If you 
choose, you may create a folder for your home directory and save the file there.

• Clear

Click Clear to clear all entries for all users. A Warning dialog box displays 
requesting confirmation that you want to clear all entries in the log.
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• Refresh

Click Refresh to update the display.

• Close

Click Close to close the log.

Expanding Columns

Expand columns in logs by placing the pointer over the line separating column 
headings until a double arrow displays, then drag the line to widen the column as 
necessary.

High Availability Fabric Manager Audit Log

The HAFM Audit Log displays a history of user actions performed through the 
HAFM. The log stores up to 1000 entries, the most recent displaying at the top of the 
log. After 1000 entries have been stored, new entries take the place of the log’s oldest 
entries. 

To display the Audit Log, choose Logs > Audit Log. The Audit Log displays 
(Figure 7–1 on page 7-2).

Figure 7–1:  High Availability Fabric Manager Audit Log

• The Date/Time column logs the date and time that the logged event took place.
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• The Event column describes the action that took place. Logged actions could 
include:

— Defining a new product

— Modifying product attributes

— Deleting product definitions

— Defining a new user

— Modifying user administration

— Deleting user administration

— Creating a zone set

— Modifying a zone set

— Modifying SNMP options

• The Parameter column describes the parameter affected by the event. For 
example, if a product is added or deleted, the product’s network address displays 
as shown in Figure 7–1. 

Note that the type of network address that displays—such as network IP address 
or host name—is determined on a product-by-product basis according to how the 
product is identified in the New Product dialog box.

• The Source column identifies the workstation from which the user performed the 
logged action. If the change was made locally from the HAFM server, the HAFM 
server address displays.

High Availability Fabric Manager Event Log
The HAFM Event Log displays events or error conditions recorded by the HAFM 
Services application. Entries reflect the status of the application and managed 
Switches or Directors. 

Information associated with a call-home failure is intended for use by maintenance 
personnel to fault isolate the problem (modem failure, no dial tone, etc.), while 
information provided in all other entries is generally intended for use by third-level 
support personnel to fault isolate more significant problems.

The log stores up to 500 entries, the most recent displaying at the top of the log. After 
500 entries are stored, new entries take the place of the oldest entries.
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To display the Event Log, choose Logs > Event Log. The Event Log displays 
(Figure 7–2).

Figure 7–2:  High Availability Fabric Manager Event Log

• The Date/Time column logs the date and time the event was reported to the 
HAFM server.

• The Event column lists an event number and brief description of the event. 
Includes both the event number and description when reporting an event to 
third-level customer support.

• The Product column lists the product associated with the event. Some events are 
associated with the HAFM Services application, while others are associated with a 
specific instance of the Product Manager application. In the latter case, the 
product (such as Director 2/64) and configured name (or IP address) associated 
with the instance are displayed.

• The Qualifier column provides an event qualifier for use by engineering 
personnel. Include this number when reporting an event to third-level customer 
support.

• The Data column includes additional event data for use in fault isolating a 
problem. Use the information when fault isolating a call-home problem, or 
include the information when reporting an event to third-level customer support.
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High Availability Fabric Manager Session Log
The HAFM Session Log provides the date/time, user name, and network address of 
each login and logout on the HAFM server. 

To display the Session Log, choose Logs > Session Log. The Session Log displays 
(Figure 7–3 on page 7-5).

Figure 7–3:  High Availability Fabric Manager Session Log

• The Date/Time column displays the date and time of the event.

• The Event column displays either login or logout.

• The User column displays the user name.

• The Network Address column displays the IP address of the remote workstation 
or HAFM server where the user logged in.
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High Availability Fabric Manger Product Status Log
The HAFM Product Status Log reflects the time and nature of significant events on all 
managed products, and indicates which specific Product Manager applications should 
be opened to further investigate product status changes.

To display the Product Status Log, choose Logs > Product Status Log or double click 
the Products icon on the HAFM status bar. The Product Status Log displays 
(Figure 7–4).

Figure 7–4:  High Availability Fabric Manager Product Status Log

• The Date/Time column displays the date and time of the change in the product’s 
operational status.

• The Network Address column displays the IP address or host name of the 
product.

• The Previous Status column displays the product’s old or previous operational 
status (Unknown, Operational, Degraded, or Failed). The Unknown status 
indicates that the HAFM has lost contact with the product and has initiated a 
call-home and/or e-mail (if configured).

• The New Status column displays the product’s current operational status.
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High Availability Fabric Manager Fabric Log
The HAFM Fabric Log reflects the time and nature of significant changes in the 
managed fabric.

To display the Fabric Log, choose Fabric Log from the Logs menu or double click the 
Fabrics icon on the HAFM status bar. The Fabric Log displays (Figure 7–5).

Figure 7–5:  High Availability Fabric Manager Fabric Log

• The Date/Time column displays the date and time of the change in the fabric.

• The Event column displays the type of change in the fabric (for example, a Switch 
was added or removed, an ISL was added or removed, the fabric was renamed or 
persisted, or a zone set became active).

• The Description column displays a description of the change in the fabric.

Export Log Files
To save a log file in American Standard Code for Information Exchange (ASCII) 
format to a location on your system’s hard drive or to a diskette, use the following 
steps. You can open this file in any desktop publisher for viewing or printing.

1. Click Export on the log window. 

The Save dialog box displays (Figure 7–6 on page 7-8).

NOTE:  The folders listed in this dialog box are those that are stored in your home directory.
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Figure 7–6:  Save dialog box

2. In the Save dialog box, browse to the folder where you want to save the file.

3. Type a file name and extension in the File name field.

4. Click Save.

The file saves to the specified folder as an ASCII text file.

Drive Go Up One Level Home List

Details

Create 
New 
Folder
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8
Optional Features

This chapter provides detailed information on using, administering, and configuring 
optional HAFM features through HAFM applications. There are two types of features 
covered in this chapter:

• “Keyed” features, requiring feature keys to be purchased and enabled through the 
Configure Feature Key dialog box in the product’s Product Manager application. 

• Features not requiring feature keys themselves, but requiring that specific keyed 
features be enabled before they can be accessed through HAFM or Product 
Manager applications.

FICON Management Server
The FICON Management Server is a keyed feature that allows host control and inband 
management of the Director or Switch through an IBM System/390 or zSeries 900 
Parallel Enterprise Server server attached to a Director or Switch port. The server 
communicates with the Switch or Director through a FICON channel. Control of 
connectivity and statistical product monitoring are provided through a host-attached 
console.

Installation

To install and enable this option, choose the Configure Feature Key option on the 
Product Manager Configure menu. 

Configuring the FICON Management Server

Use this procedure to configure whether the host is the controlling manager.

The optional FICON Management Server feature must be installed in order to perform 
this procedure.

• Enable Management Server 

Click this check box to add a check mark and enable the management server. 
Click the check mark to remove it and disable this feature.



8–2 ha-fabric manager user guide

Optional Features

• Switch Clock Alert Mode

Click this check box to display a check mark and enable clock alert mode. If this 
is enabled, the following occurs when users set the date and time through the 
Configure Date and Time dialog box (Configure menu):

— If you enable Periodic Date/Time Synchronization, an error message 
displays indicating that Clock Alert Mode must be cleared to enable 
automatic synchronization of the date and time.

— If you manually set the date and time (Periodic Date/Time Synchronization 
is not enabled), a confirmation dialog box will display. You must click OK on 
that dialog box to continue manual configuration.

• Host Control Prohibited

Click this check box to display a check mark and prohibit a host management 
program from changing configuration and connectivity parameters on the Switch. 
In this case, the host program will have read authorization only and cannot make 
changes. When the check mark is not displayed, a host program can change 
configuration and connectivity parameters on the Switch.

• Programmed offline state control

Click this check box to display a check mark and enable a host management 
program to control the Switch’s offline and online state. When a check mark is not 
displayed, a host program cannot set the Switch online or offline.

• Active=Saved

Click this check box to display a check mark and enable the active=saved 
function for the IPL address configuration.

— If Active=Saved is enabled (check mark), the IPL and the active address 
configuration are maintained as identical configurations. If a new 
configuration is activated through the Configure Addresses - “Active” dialog 
box, that configuration becomes the IPL address configuration.

— If Active=Saved is not enabled (no check mark), the IPL address 
configuration and the active configuration are not maintained as identical, and 
may be different configurations. If the feature is not enabled, you can modify 
the IPL configuration through the Configure Addresses - “Active” dialog 
box. If the feature is enabled, the IPL file is locked to modification through 
the Configure Addresses - “Active” dialog box.
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• Code Page

Consider the language required for the port name display that displays on the 
HAFM Server. Language support is provided through character set 697 for all 
Extended Binary-Coded Decimal Interchange Code (EBCDIC) pages. 

When planning the installation, select the EBCDIC code page for displaying 
host-assigned port names or the CUP name. As an example, if the code page for 
Italy is selected and a port name is assigned in Italian by the host management 
program, then the Italian language port name will display in the Product Manager.

This field lists the code pages that are available for configuration. The default 
code page is United States/Canada 00037. Refer to the following table for other 
code pages:

Table 8–1:  Available Code Pages
Code Page Name Code Page Hexadecimal CPGID

United States/Canada 00037 0025

Germany/Austria 00273 0111

Brazil 00275 0113

Italy 00280 0118

Japan 00281 0119

Spain/Latin America 00284 011C

United Kingdom 00285 011D

France 00297 0129

International #5 00500 01F4
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Procedure

To configure the FICON management server, use the following steps:

1. Choose Configure > Management Server from the Product Manager window. 
The Configure FICON Management Server dialog box displays, as shown in 
Figure 8–1.

Figure 8–1:  Configure FICON Management Server dialog box

2. Enable or disable the management server by clicking Enable Management 
Server check box. (To disable the management server, click the check box again 
to remove the check mark.)

3. Enable or disable Switch clock alert mode by clicking the Director Clock Alert 
Mode check box. When a check mark displays, the alert mode is enabled.

4. Allow or prohibit host control by clicking the check box in the Host Control 
Prohibited field. When a check mark displays, host control is prohibited.

5. Allow or prohibit offline state control by clicking the check box in the 
Programmed offline state control field. When a check mark displays, 
programmed control of the offline state is allowed.

6. Enable or disable Active=Saved mode by clicking the check box in the 
Active=Saved field. When a check mark displays, the Active=Saved mode is 
enabled.

7. If necessary, choose a code page from the Code Page drop-down list.

8. Activate changes and close the dialog box by clicking the Activate button.

9. If you are finished configuring the Switch, back up the configuration data.

Open Systems Management Server

The Open System Management Server (OSMS) is a keyed feature that allows host 
control and inband management of the Director or Switch through a management 
application that resides on an open-systems interconnection (OSI) device. This device 
is attached to a Director or Switch port. The device communicates with the Switch or 
Director through Fibre Channel common transport (FC-CT) protocol.
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Installation

To install and enable this option, choose the Configure Feature Key option on the 
Product Manager Configure menu.

Configuring the Open Systems Management Server

Use these procedures to configure the open systems inband management program to 
function with the Switch.

The optional Open Systems Management Server feature must be installed in order to 
perform this procedure.

Procedure

To configure open systems management server, use the following steps:

1. Choose Configure > Management Server from the Product Manager window. 
The Configure Open Systems Management Server dialog box displays, as 
shown in Figure 8–2.

Figure 8–2:  Configure Open Systems Management Server dialog box

2. Enable the management server by clicking the Enable Management Server 
check box. (To disable the management server, click the check box again to 
remove the check mark.)

3. Click the check box in the Host Control Prohibited field to display a check mark 
and to prohibit the host management program from changing configuration and 
connectivity parameters on the Switch. In this case, the host program has 
read-only access to configuration and connectivity parameters. Clicking the check 
box when it contains a check mark removes the check mark and allows a host 
program to change configuration and connectivity parameters on the Switch. 

4. To activate changes and close the dialog box, click Activate.

5. If you are finished configuring the Switch, you can back up the configuration data.
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SANtegrity Features
SANtegrity includes a set of features that enhance security in SANs (Storage Area 
Networks) that contain a large and mixed group of fabrics and attached devices. 
Through these features you can allow or prohibit Switch attachment to fabrics and 
device attachment to Switches. These features are enabled by purchasing a feature key, 
then enabling the key through the Configure Feature Key dialog box.

SANtegrity features include:

• Fabric Binding

• Switch Binding

Enterprise Fabric Mode — Although this is not a keyed feature, the SANtegrity 
Fabric Binding and Switch Binding must be installed before you can use the 
Enterprise Fabric Mode function through the HAFM Fabrics menu.

Fabric Binding

This feature is managed through the Fabric Binding option, available through the 
Fabrics menu in HAFM when the Fabrics tab is selected. Using Fabric Binding, you 
can allow specific Switches to attach to specific fabrics in the SAN. This provides 
security from accidental fabric merges and potential fabric disruption when fabrics 
become segmented because they cannot merge.

Enable/Disable and Online State Functions

In order for Fabric Binding to function, specific operating parameters and optional 
features must be enabled. Also, there are specific requirements for disabling these 
parameters and features when the Director or Switch is offline or online. Be aware of 
the following:

• Because Switches are bound to a fabric by World Wide Name (WWN) and 
domain ID, the Insistent Domain ID option in the Configure Switch Parameters 
dialog box is automatically enabled if Fabric Binding is enabled.

• If Fabric Binding is enabled and the Switch is online, you cannot disable Insistent 
Domain ID.

• If Fabric Binding is enabled and the Director or Switch is offline, you can disable 
Insistent Domain ID, but this will disable Fabric Binding.

• You cannot disable Fabric Binding or Switch Binding if Enterprise Fabric Mode is 
enabled. However, if Enterprise Fabric Mode is disabled, you can disable Fabric 
Binding, Switch Binding, or both. 
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Switch Binding

This feature is managed through the Switch Binding submenu options available on 
the Product Manager Configure menu. Using Switch Binding, you can specify 
devices and Switches that can attach to Director and Switch ports. This provides 
security in environments that include a large number of devices by ensuring that only 
the intended set of devices attach to a Switch or Director. 

Configuring Switch Binding Overview

To configure Switch binding, you must first activate the feature using the Switch 
Binding State Change dialog box while selecting the type of port where you want to 
restrict connection (connection policy). Possible selections are E_Ports, F_Ports, or all 
types. 

If the Director or Switch is online, activating Switch binding populates the 
Membership List in the Switch Binding - Membership List dialog box (Product 
Manager) with the following WWNs currently connected to the Director or Switch, 
depending on the connection policy set in the State Change dialog box:

• WWNs of devices connected to F_Ports (F_Port connection policy). The WWN is 
the WWN of the attached device's port.

• WWNs of Switches connected to E_Ports (E_Port connection policy). The WWN 
is the WWN of the attached Switch.

• WWNs of devices connected to F_Ports and Switches connected to E_Ports 
(all-ports connection policy).

Notes

• When the Switch Binding feature is first installed and has not been enabled, the 
Switch Membership List is empty. When you enable Switch Binding, the 
Membership List is populated with WWNs of devices, Switches, or both that are 
currently connected to the Switch. 

• If the Switch is offline and you activate Switch binding, the Membership List is 
not automatically populated. 

• Edits to the Switch Binding Membership list will be maintained when you enable 
or disable Switch Binding.

After enabling Switch Binding, you prohibit devices and/or Switches from connecting 
with Director or Switch ports by removing them from the Membership List in the 
Switch Binding Membership List dialog box. You allow connections by adding 
them to the Membership List. You can also add detached nodes and Switches. 
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Enable/Disable Switch Binding 

1. Choose the Configure > Switch Binding > Change State from the Product 
Manager window. The Switch Binding State Change dialog box displays, as 
shown in Figure 8–3. 

Figure 8–3:  Switch Binding State Change dialog box

2. Perform one of the following steps:

• To disable Switch Binding (a check mark displays in the Enable Switch 
Binding check box), click the Enable Switch Binding check box to remove 
the check mark, then click Activate.

• To enable Switch Binding (check mark is not in the Enable Switch Binding 
check box), click the Enable Switch Binding check box to add a check mark. 
Go on to step 3 to set the Connection Policy.

3. Click one of the Connection Policy options. 

• Restrict E_Ports — Select if you want to restrict connections from specific 
Switches to Switch E_Ports. Switch WWNs can be added to the Switch 
Membership List to allow connection and removed from the Membership List 
to prohibit connection. Devices are allowed to connect to any F_Port.

• Restrict F_Ports — Select if you want to restrict connections from specific 
devices to Switch F_Ports. Device WWNs can be added to the Switch 
Membership List to allow connection and removed from the Membership List 
to prohibit connection. Switches are allowed to connect to any E_Port.

• Restrict All — Select if you want to restrict connections from specific 
devices to Switch F_Ports and Switches to Switch E_Ports. Device and 
Switch WWNs can be added to the Switch Membership List to allow 
connection and removed from the Membership List to prohibit connection. 



ha-fabric manager user guide 8–9

Optional Features

4. Click Activate to enable the changes and close the dialog box.

5. Edit the Switch Membership List through the Switch Binding Membership List 
dialog box to add or remove Switches and devices that are allowed to connect with 
the Switch.

Editing the Switch Membership List

1. Choose the Configure > Switch Binding > Edit Membership List from the 
Product Manager window. The Switch Binding Membership List dialog box 
displays, as shown in Figure 8–4. 

The WWNs of devices and/or Switches that can currently connect to Switch ports 
are listed in the Switch Membership List panel. 

Figure 8–4:  Switch Binding Membership List dialog box

Refer to Configuring Switch Binding Overview on page 8–7 for information on how 
the Switch Membership List is populated with WWNs according to options set in the 
Switch Binding State Change dialog box.

2. If nicknames are configured for WWNs through HAFM and you want these to 
display instead of WWNs in this dialog box, click Display Options. The Display 
Options dialog box displays.
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3. Click Nickname, then click OK.

4. To prohibit connection to a Switch port from a WWN currently in the 
Membership List, click the WWN or nickname in the Membership List, then 
click Remove. The WWN or nickname will move to the Node List panel. WWNs 
can only be removed from the fabric if any of the following is true:

• The Switch is offline.

• Switch Binding is disabled.

• The Switch or device with the WWN is not connected to the Switch. 

• Switch Binding is not enabled for the same port type as enabled for the 
Connection Policy in the Switch Binding State Change dialog box. For 
example, a WWN for a Switch attached to an E_Port can be removed if the 
Switch Binding Connection Policy was enabled to Restrict F_Ports.

• The Switch or device with the WWN is connected to a port that is blocked.

5. The Switch or device with the WWN is not currently connected to the Switch 
(detached node).

6. WWNs can be added to the Switch Membership List (and thereby allowed 
connection) when Switch Binding is either enabled or disabled. To allow 
connection to a Switch port from a WWN in the Node List panel, select the 
WWN or nickname in the Node List panel, then click the Add button. The WWN 
or nickname will move to the Membership List panel.

7. To add a WWN for a device or Switch not currently connected to the Switch, click 
Detached Node. The Add Detached Node dialog box displays.

8. Enter the appropriate WWN or nickname (if configured through HAFM) and click 
OK. The WWN or nickname displays in the Switch Membership List. 

9. Click Activate to enable the changes and close the dialog box.

Enable/Disable and Online State Functions

In order for Switch Binding to function, specific operating parameters and optional 
features must be enabled. Also, there are specific requirements for disabling these 
parameters and features when the Director or Switch is offline or online. Be aware of 
the following:

• Switch Binding can be enabled or disabled whether the Switch is offline or online. 

• Enabling Enterprise Fabric Mode automatically enables Switch Binding.
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• You cannot disable Switch Binding if Enterprise Fabric Mode is enabled. 

• If Enterprise Fabric Mode is enabled and the Director or Switch is online, you 
cannot disable Switch Binding. However, if Enterprise Fabric Mode is disabled, 
you can disable Fabric Binding, Switch Binding, or both.

• If Enterprise Fabric Mode is enabled and the Director or Switch is offline you can 
disable Switch Binding, but Enterprise Fabric Mode will also disable. 

• WWNs can be added to the Switch Membership List when Switch Binding is 
enabled or disabled.

• WWNs can only be removed from the Switch Membership List if any of the 
following are true: 

— The Director or Switch is offline.

— Switch Binding is disabled.

— The Switch or device with the WWN is not connected to the Director or 
Switch. 

— Switch Binding is not enabled for the same port type as enabled for the 
Connection Policy in the Switch Binding State Change dialog box. For 
example, a WWN for a Switch attached to an E_Port can be removed if 
Switch Binding Connection Policy was enabled to Restrict F_Ports.

— The Switch or device with the WWN is connected to a port that is blocked.

— The Switch or device with the WWN is not currently connected to the 
Director or Switch (detached node).

• If the Director or Switch is online and Switch Binding is not enabled, all nodes 
and Switches attached to the Director or Switch are automatically added to the 
Switch Membership List.

Zoning with Switch Binding Enabled

Note that SANtegrity has no effect on existing zoning configurations. However, note 
that if a device WWN is in a specific zone, but the WWN is not in the Switch 
Membership List, the device cannot log in to the Director or Switch port and cannot 
connect to other devices in the zone with Switch Binding enabled.
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Enterprise Fabric Mode
Enterprise Fabric Mode is an option available on the Fabrics menu in the HAFM 
application if the SANtegrity feature key is installed. This option automatically 
enables the following features and operating parameters that are necessary in 
multiswitch Enterprise Fabric environments. Note that there are specific requirements 
for disabling these parameters and features when the Director or Switch is offline or 
online. 

Fabric Binding

This is a SANtegrity feature enabled through the Fabrics menu in HAFM that allows 
or prohibits Switches and Directors from merging with a selected fabric. Refer to 
Enable/Disable and Online State Functions on page 8-6 for details on 
enabling/disabling Fabric Binding with Enterprise Fabric Mode.

Switch Binding

This is a SANtegrity feature enabled through the Configure menu in the Product 
Manager that allows or prohibits Switches and/or Directors from connecting to Switch 
E_Ports, devices from connecting to F_Ports. Refer to Enable/Disable and Online 
State Functions on page 8-10 for details on enabling/disabling Switch Binding with 
Enterprise Fabric Mode enabled.

Rerouting Delay

Rerouting delay is a parameter in the Configure Switch Parameters dialog box, 
available from Configure menu in the Product Manager application. 

Rerouting Delay ensures that frames are delivered through the fabric in order to their 
destination. If there is a change to the fabric topology that creates a new path (for 
example, a new Switch is added to the fabric), frames may be routed over this new 
path if its hop count is less than a previous path with a minimum hop count. This may 
result in frames being delivered to a destination out of order since frames sent over the 
new, shorter path may arrive ahead of older frames still in route over the older path. If 
Rerouting Delay is enabled, traffic ceases in the fabric for the time specified in the 
E_D_TOV field of the Configure Fabric Parameters dialog box (Configure menu). 
This delay enables frames sent on the old path to exit to their destination before new 
frames begin traversing the new path.

If Enterprise Fabric Mode is enabled, this option is automatically enabled and cannot 
be disabled unless the Director or Switch is offline. In this case, disabling Rerouting 
Delay also disables Enterprise Fabric Mode.
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Domain RSCNs

This is a parameter in the Configure Switch Parameters dialog box, available from 
Configure menu in the Product Manager application. Domain register for state 
change notifications (domain RSCNs) are sent between end devices in a fabric to 
provide additional connection information to host bus adapters (HBA) and storage 
devices. As an example, this information might be that a logical path has been broken 
because of a physical event, such as a fiber optic cable being disconnected from a port. 

If Enterprise Fabric Mode is enabled, this parameter is automatically enabled and 
cannot be disabled unless the Director or Switch is offline. In this case, disabling 
Domain RSCNs also disables Enterprise Fabric Mode. 

Insistent Domain Identification (ID)

This is a parameter in the Configure Switch Parameters dialog box, available from 
Configure menu in the Product Manager application. Enabling this option sets the 
domain ID configured in the Preferred Domain ID field in the Configure Switch 
Parameters dialog box as the active domain identification when the fabric initializes. 
A static and unique domain identification is required by the Fabric Binding feature 
because the feature's Fabric Membership list identifies Switches by WWN and 
Domain ID. If a duplicate preferred domain ID is used, then insisted, warnings occur 
when Directors and Switches are added to a Fabric Membership List.

If Fabric Binding or Enterprise Fabric Mode is enabled, this option is automatically 
enabled and cannot be disabled unless these options are disabled when the Director or 
Switch is offline. If the Director or Switch is online, disabling Insistent Domain ID 
will disable Enterprise Fabric Mode and Fabric Binding.
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This appendix describes messages that may appear as you use the High Availability 
Fabric Manager. A description and action are provided for each message, which is 
listed in alphabetical order.

Table A–1:  High Availability Fabric Manager Messages

Message Description Action

A zone must have at 
least one zone 
member.

When creating a new zone, 
one or more zone members 
must be added.

Add one or more zone 
members to the new 
zone.

A zone set must have at 
least one zone.

When creating a new zone 
set, one or more zones 
must be added.

Add one or more zones 
to the new zone set using 
the Modify Zone Set 
dialog box.

All alias, zone, and 
zone set names must 
be unique.

When creating a new alias, 
zone, or zone set the name 
must be unique.

Choose a unique name 
for the new alias, zone, 
or zone set.

All zone members are 
logged.

Attempt was made to 
display all zone members 
not logged in using the 
Zone Set tab, but all 
members are currently 
logged in.

Informational message.

Are you sure you want 
to delete this network 
address?

The currently selected 
network address will be 
deleted.

Click Yes to delete or No 
to cancel.

Are you sure you want 
to delete this 
nickname?

The selected nickname will 
be deleted from the list of 
nickname definitions.

Click Yes to delete the 
nickname or No to 
cancel the operation.
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Are you sure you want 
to delete this product?

The selected product will be 
deleted from the list of 
product definitions.

Click Yes to delete the 
product or No to cancel 
the operation.

Are you sure you want 
to delete this user?

The selected user will be 
deleted from the list of user 
definitions.

Click Yes to delete the 
user or No to cancel the 
operation.

Are you sure you want 
to delete this zone?

Requesting confirmation to 
delete the specified zone.

Click Yes to confirm the 
deletion of the zone or 
No to cancel the 
operation.

Are you sure you want 
to overwrite this zone 
set?

The selected zone set will 
be overwritten in the zoning 
library.

Click Yes to overwrite or 
No to cancel.

Are you sure you want 
to remove all members 
from this zone?

All members will be deleted 
from the selected zone.

Click Yes to delete the 
members or No to cancel 
the operation.

Cannot add a switch to 
a zone.

The device that you are 
attempting to add to the 
zone is a Switch, which 
cannot be added to a zone.

Specify the port number 
or corresponding World 
Wide Name for the 
device you want to add to 
the zone.

Cannot connect to 
HAFM server.

The HAFM application at a 
remote workstation could 
not connect to the HAFM 
server. 

Verify the HAFM server 
internet protocol (IP) 
address is valid.

Cannot delete product. The selected product 
cannot be deleted.

Verify the HAFM 
server-to-product link is 
up.

• If the link is up, the 
HAFM server may be 
busy.

• Another Product 
Manager instance 
may be open.

• The user may not 
have permission to 
delete the product.

Message Description Action
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Cannot disable Fabric 
Binding while 
Enterprise Fabric Mode 
is active.

You attempted to disable 
Fabric Binding through the 
Fabric Binding dialog box, 
but Enterprise Fabric Mode 
was enabled.

Disable Enterprise Fabric 
Mode through the 
Enterprise Fabric Mode 
dialog box in HAFM 
before disabling Fabric 
Binding.

Cannot display route on 
a one switch fabric.

You cannot show routes 
between end devices in a 
fabric when configuring 
Show Routes (Fabrics 
menu).

Error displays when 
attempting to show 
routes on a fabric with 
only one Switch. 
Configure the Show 
Route option on a 
multiswitch fabric.

Cannot display route. 
All switches in route 
must be managed by 
the same server.

You cannot show the route 
between devices that are 
attached to Switches or 
Directors managed by a 
different HAFM server.

Make sure devices 
named in Show Routes 
dialog box are attached 
to products managed by 
this HAFM server.

Cannot display route. 
All switches in route 
must support routing.

You cannot show the route 
through a fabric that has 
Switches or Directors which 
do not support routing.

The route must contain 
only Edge Switch 2/16, 
Edge Switch 2/32 
Switches or Director 2/64 
directors.

Cannot display route. 
Device is not a member 
of a zone in the active 
zone set.

You cannot show the route 
for a device that is not a 
member of a zone in the 
active zone set. The source 
node that you have selected 
is not part of a zone in the 
active zone set.

Enable the default zone 
or activate the zone for 
the device before 
attempting to show the 
route.

Cannot display route. 
Error 9.

An internal error has 
occurred while you were 
trying to view routes. 

Contact the next level of 
support to report the 
problem.

Cannot display route. 
No active zone 
enabled.

You cannot show the route 
through a fabric with no 
active zone.

Enable the default zone 
or activate a zone set 
before attempting to 
show the route.

Message Description Action
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Cannot have spaces in 
field.

Spaces are not allowed as 
part of the entry for this 
field.

Delete spaces from the 
field entry.

Cannot modify a zone 
set with an invalid 
name. Rename zone 
set and try again.

A zone set must have a 
valid name to be modified.

Assign a valid name to 
the zone set, then you 
can modify through the 
Modify Zone Set dialog 
box.

Cannot modify a zone 
with an invalid name. 
Rename zone and try 
again.

Zone does not have a valid 
name.

Rename zone, then use 
Modify Zone dialog box 
to modify zone.

Cannot modify product. The selected product 
cannot be modified.

Verify the HAFM 
server-to-product link is 
up.

• If the link is up, the 
HAFM server may be 
busy.

• Another Product 
Manager instance 
may be open.

• The user may not 
have permission to 
modify the product.

Cannot perform 
operation. Fabric is 
unknown.

This message displays if no 
Switches in the fabric are 
connected to the HAFM 
server.

Ensure at least one 
fabric-attached Switch or 
Director has an Ethernet 
connection to the HAFM 
server and retry the 
operation.

Cannot perform 
operation. The list of 
attached nodes is 
unavailable.

This message displays 
when attached nodes are 
unavailable and the user 
attempts to modify a zone or 
create a new zone.

Verify an attached node 
is available and retry the 
operation.

Message Description Action
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Cannot retrieve current 
SNMP configuration.

The current SNMP 
configuration could not be 
retrieved.

Try again. If the problem 
persists, contact the next 
level of support.

Cannot save SNMP 
configuration.

The current SNMP 
configuration could not be 
saved.

Try again. If the problem 
persists, contact the next 
level of support.

Cannot set write 
authorization without 
defining a community 
name.

An SNMP community name 
has not been configured.

Enter a valid community 
name in the Configure 
SNMP dialog box.

Cannot show zoning 
library. No fabric exists.

You cannot show the zoning 
library if no fabric exists. You 
must have identified a 
Switch or Director to the 
HAFM for a fabric to exist.

Identify an existing 
Switch or Director to the 
HAFM using the New 
Product dialog box.

Click OK to remove all 
contents from log.

This action deletes all 
contents from the selected 
log.

Click OK to delete the log 
contents or Cancel to 
cancel the operation.

Connection to HAFM 
server lost. Click OK to 
exit application.

The HAFM application at a 
remote workstation lost the 
network connection to the 
HAFM server.

Re-start the HAFM 
application to connect to 
the HAFM server.

Connection to HAFM 
server lost.

The connection to the 
remote HAFM server has 
been lost.

Log in to the HAFM 
server again through the 
HAFM Login dialog box.

Could not export log to 
file.

A log file input/output (I/O) 
error occurred and the file 
could not be saved to the 
specified destination. The 
disk may be full or write 
protected.

If the disk is full, use 
another disk. If the disk is 
write protected, change 
the write-protect 
properties or use another 
disk.

Message Description Action
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Default zoning is not 
supported in Open 
Fabric Mode.

A default zone cannot be 
enabled when the product is 
enabled for Open Fabric 
mode. Open Fabric mode 
does not support zone 
members defined by port 
numbers.

Change the interop 
mode from Open Fabric 
mode to Homogeneous 
Fabric mode through the 
Configure Operating 
Mode dialog box in the 
Product Manager 
application. Or, redefine 
zone members by the 
WWN of attached 
devices.

Device is not a member 
of a zone in the active 
zone set.

The selected device is not a 
member of a zone in the 
active zone set and 
therefore cannot 
communicate with the other 
device in the route.

Enable the default zone 
or activate a zone set 
containing the member 
before attempting to 
show the route. 

Download complete. 
Click OK and restart the 
HAFM.

Download of the HAFM and 
Product Manager 
applications is complete.

Restart the HAFM 
application to continue.

Duplicate community 
names require identical 
write authorizations.

If configuring two 
communities with identical 
names, they must also have 
identical write 
authorizations.

Verify that both 
communities with the 
same name have the 
same write 
authorizations.

Duplicate Fabric Name. The fabric name that you 
have specified already 
exists.

Choose another name 
for the fabric.

Duplicate name in 
zoning configuration. All 
zone and zone set 
names must be unique.

Every name in the zoning 
library must be unique.

Modify (to make it 
unique) or delete the 
duplicate name.

Duplicate nickname in 
nickname configuration.

Duplicate nicknames cannot 
be configured.

Modify the selected 
nickname to make it 
unique.

Message Description Action
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Duplicate World-Wide 
Name in nickname 
configuration.

A World Wide Name can be 
associated with only one 
nickname.

Modify (to make it 
unique) or delete the 
selected World Wide 
Name.

Duplicate zone in zone 
set configuration.

More than one instance of a 
zone is defined in a zone 
set.

Delete one of the 
duplicate zones from the 
zone set.

Duplicate zone member 
in zone configuration.

More than one instance of a 
zone member is defined in a 
zone.

Delete one of the 
duplicate zone members 
from the zone.

Enterprise Fabric 
feature not installed. 
Please contact your 
sales representative

User selected Fabric 
Binding or Enterprise Fabric 
Mode from the Fabrics 
menu, but the SANtegrity 
feature was not installed.

Install the SANtegrity 
feature to use Fabric 
Binding or enable 
Enterprise Fabric Mode.

HAFM Management 
session is already 
active from this 
workstation.

A HAFM session already 
exists on the current 
workstation.

A workstation can have 
only one active HAFM 
session.

HAFM error < error 
number 1 through 8 >.

The HAFM application 
encountered an internal 
error (1 through 8 inclusive) 
and cannot continue 
operation.

Contact the next level of 
support to report the 
problem.

HAFM server could not 
log you on. Verify your 
username and 
password.

The incorrect user name 
and password (both case 
sensitive) were used while 
attempting to login to the 
HAFM application

Verify the user name and 
password with the 
customer’s network 
administrator and retry 
the operation.

HAFM server is 
shutting down. 
Connection will be 
terminated.

The HAFM application is 
closing and terminating 
communication with the 
attached product.

Reboot the HAFM 
server. If the problem 
persists, contact the next 
level of support.

Message Description Action
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Enabling this zone set 
will replace the 
currently active zone 
set. Do you want to 
continue?

Only one zone set can be 
active. By enabling the 
selected zone set, the 
current active zone set will 
be replaced.

Click OK to continue or 
Cancel to end the 
operation. 

Error creating zone set. The HAFM application 
encountered an internal 
error.

Try the operation again. If 
the problem persists, 
contact the next level of 
support.

Error creating zone. The HAFM application 
encountered an internal 
error.

Try the operation again. If 
the problem persists, 
contact the next level of 
support.

Error deleting zone set. The HAFM application 
encountered an internal 
error.

Try the operation again. If 
the problem persists, 
contact the next level of 
support.

Error deleting zone. The HAFM application 
encountered an internal 
error.

Try the operation again. If 
the problem persists, 
contact the next level of 
support.

Error reading log file. The HAFM application 
encountered an error while 
trying to read the log.

Try the operation again. If 
the problem persists, 
contact the next level of 
support.

Error removing zone or 
zone member.

The HAFM application 
encountered an internal 
error.

Try the operation again. If 
the problem persists, 
contact the next level of 
support.

Error transferring files < 
message >.

An error occurred while 
transferring files from the 
PC hard drive to the HAFM 
application. The message 
varies, depending on the 
problem.

Try the file transfer 
operation again. If the 
problem persists, contact 
the next level of support.

Message Description Action
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Fabric Log will be lost 
once the fabric 
unpersists. Do you want 
to continue?

When you unpersist a 
fabric, the corresponding 
fabric log is deleted.

Click Yes to unpersist the 
fabric or No to cancel the 
operation.

Fabric not persisted. The user attempted to 
refresh or clear the Log 
dialog, after a fabric was 
unpersisted. When you 
unpersist a fabric, the 
corresponding fabric log is 
deleted.

Clear the log dialog after 
the fabric is unpersisted.

Field cannot be blank. The data field requires an 
entry and cannot be left 
blank.

Enter appropriate 
information in the data 
field.

Field has exceeded 
maximum number of 
characters.

The maximum number of 
data entry characters 
allowed in the field was 
exceeded.

Enter the information 
using the proscribed 
number of characters.

File transfer aborted. The user aborted the file 
transfer process.

Verify the file transfer is 
to be aborted, then click 
OK to continue.

Invalid character in 
field.

An invalid character was 
entered in the data field.

Remove invalid 
characters from the 
entry.

Invalid name. One of the following invalid 
names was used: CON, 
AUX, COM1, COM2, 
COM3, COM4, COM5, 
COM6, COM7, COM8, 
COM9, LPT1, LPT2, LPT3, 
LPT4, LPT5, LPT6, LPT7, 
LPT8, LPT9, NUL, or PRN.

Choose a valid name 
and retry the operation.

Invalid network 
address.

The IP address specified for 
the product is unknown to 
the domain name server 
(invalid).

Verify and enter a valid 
product IP address.

Message Description Action
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Invalid port number. 
Valid ports are 
(0-< nn >).

You have specified an 
invalid port number.

Specify a valid port 
number, in the range 0 to 
the maximum number of 
ports on the product 
minus 1. For example, for 
a Switch with 32 ports, 
the valid port range is 
0–31

Invalid product 
selection.

At the New Product dialog 
box, an invalid product was 
selected.

Choose a valid product 
and retry the operation.

Invalid request. Three conditions result in 
this message:

• The user tried to add or 
modify a product from 
product view and the 
network address is 
already in use. (Network 
addresses must be 
unique.)

• The user tried to create 
a new user with a user 
name that already exists. 
(User names must be 
unique.)

• The user tried to delete 
default Administrator 
user. (The default 
Administrator user 
cannot be deleted.)

Choose the action that is 
appropriate to the activity 
that caused the error:

• Network address: 
Specify a unique 
network address for 
the product.

• User name: Specify a 
unique user name for 
the new user ID.

• Do not delete the 
default Administrator 
user.

Invalid UDP port 
number.

The specified user 
datagram protocol (UDP) 
port number is invalid. The 
number must be an integer 
from 1 through 65535 
inclusive.

Verify and enter a valid 
UDP port number.

Message Description Action



ha-fabric manager user guide A–11

Information and Error Messages

Invalid World Wide 
Name or nickname.

The World Wide Name or 
nickname that you have 
specified is invalid. The 
valid format for the World 
Wide Name is eight 
two-digit hexadecimal 
numbers separated by 
colons 
(xx:xx:xx:xx:xx:xx:xx:xx). 
The valid format for a 
nickname is non blank 
characters, up to 32 
characters.

Try the operation again 
using a valid World Wide 
Name or nickname. 

Invalid World-Wide 
Name. Valid WWN 
format is: 
xx:xx:xx:xx:xx:xx:xx:xx.

The specified World Wide 
Name format is invalid. The 
valid format is eight two-digit 
hexadecimal numbers 
separated by colons 
(xx:xx:xx:xx:xx:xx:xx:xx).

Enter a World Wide 
Name using the correct 
format.

Invalid zone in zone set. The defined zone no longer 
exists and is invalid.

Use a valid zone when 
creating the zone set.

Limit exceeded. You cannot add a new 
product or user to the HAFM 
if the maximum number of 
that resource already exists 
on the system.

Delete unneeded 
products or users from 
the system, before 
attempting to add any 
new ones.

No address selected. You cannot complete the 
operation because an 
address has not been 
selected.

Choose an address and 
retry the operation.

No attached nodes 
selected.

An operation was attempted 
without an attached node 
selected.

Choose an attached 
node and try the 
operation again.

No HAFM server 
specified.

An HAFM server is not 
defined to the HAFM 
application.

At the HAFM Login 
screen, type a server 
name in the HAFM 
Server field and click the 
Login button.

Message Description Action
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No nickname selected. No nickname was selected 
when the command was 
attempted.

Choose a nickname and 
try again.

No Product Managers 
installed.

No Director or Switch 
Product Manager 
application is installed on 
this workstation.

Install the appropriate 
Product Manager to this 
workstation.

No routing information 
available.

No information is available 
for the route selected.

Choose a different route 
and try the operation 
again.

No user selected. No user was selected when 
the command was 
attempted.

Choose a user and try 
again.

No zone member 
selected.

A zoning operation was 
attempted without a zone 
member selected.

Choose a zone member 
and try the operation 
again.

No zone selected or 
zone no longer exists.

A zoning operation was 
attempted without a zone 
selected, or the zone 
selected no longer exists in 
the fabric.

Choose a zone or use a 
valid zone and try the 
operation again.

No zone selected or 
zone no longer exists.

A zoning operation was 
attempted without a zone 
selected, or the zone 
selected no longer exists in 
the fabric.

Choose a zone or use a 
valid zone and try the 
operation again.

No zone selected. A zoning operation was 
attempted without a zone 
selected.

Choose a zone and try 
the operation again.

No zone set active. A zone set cannot be 
deactivated if there are no 
active zones.

Informational message 
only - no action is 
required.

No zone set selected or 
zone set no longer 
exists.

A zoning operation was 
attempted without a zone 
set selected, or the zone set 
you selected no longer 
exists in the fabric.

Choose a zone set and 
try the operation again.

Message Description Action
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No zone set selected. A zoning operation was 
attempted without a zone 
set selected.

Choose a zone set and 
try the operation again.

Only attached nodes 
can be displayed in this 
mode.

Users cannot display 
unused ports when adding 
ports by World Wide Name.

Change the add criteria 
to Add by Port.

Password and 
confirmation don’t 
match.

Entries in the password field 
and confirmation password 
field do not match. The 
entries are case sensitive 
and must be the same.

Enter the password and 
confirmation password 
again.

Product Manager 
instance is currently 
open.

A product cannot be deleted 
while an instance of the 
Product Manager 
application is open for the 
same product.

Close the Product 
Manager application, 
then delete the product.

Remote session 
support has been 
disabled.

The connection between the 
specified remote 
workstation and the HAFM 
server was disallowed.

Consult with the 
customer’s network 
administrator to 
determine if the 
workstation entry should 
be modified at the 
Configure Sessions 
dialog box.

Remote sessions are 
not allowed from this 
network address.

Only IP addresses of 
remote workstations 
specified at the Configure 
Sessions dialog box are 
allowed to connect to the 
HAFM server.

Consult with the 
customer’s network 
administrator to 
determine if the IP 
address is to be 
configured for remote 
sessions.

Resource is 
unavailable.

The specified operation 
cannot be performed 
because the product is 
unavailable.

Verify the HAFM 
server-to-product link is 
up. If the link is up, the 
HAFM server may be 
busy. Try the operation 
again later.

Message Description Action
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Selection is not a World 
Wide Name.

The selection made is not a 
World Wide Name.

Choose a valid World 
Wide Name before 
performing this 
operation.

Server shutting down. The HAFM application is 
closing and terminating 
communication with the 
attached product.

Reboot the HAFM 
server. If the problem 
persists, contact the next 
level of support.

SNMP trap address not 
defined.

If an SNMP community 
name is defined, a 
corresponding SNMP trap 
recipient address must also 
be defined.

Enter a corresponding 
SNMP trap recipient 
address.

The Administrator user 
cannot be deleted.

The administrator user is 
permanent and cannot be 
deleted from the Configure 
Users dialog box.

Informational message 
only - no action is 
required.

The Domain ID was not 
accepted. The World 
Wide Name and 
Domain ID must be 
unique in the Fabric 
Membership List.

User attempted to add a 
detached Switch to the 
Fabric Membership List 
through the Fabric Binding 
option (SANtegrity feature), 
but a Switch already exists 
in the fabric with the same 
domain ID.

Enter a unique domain 
ID for the Switch in the 
Add Detached Switch 
dialog box.

The HAFM server is 
busy processing a 
request from another 
Product Manager.

The HAFM server PC is 
processing a request from 
another instance of a 
Product Manager 
application, and cannot 
perform the requested 
operation.

Wait until the process is 
completes, then perform 
the operation again.

The link to the 
managed product is not 
available.

The Ethernet connection 
between the HAFM server 
and the managed product is 
down or unavailable.

Establish and verify the 
network connection.

Message Description Action
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The maximum number 
of open products has 
already been reached.

The maximum number of 
open products allowed was 
reached.

Close a Product 
Manager session 
(existing open product) 
before opening a new 
session.

The maximum number 
of products has already 
been configured.

The number of managed 
products (48) that can be 
defined to the HAFM 
application was reached.

Delete an existing 
product before adding a 
new product.

The maximum number 
of products of this type 
has already been 
configured.

The number of products of 
this type (48) that can be 
defined to the HAFM 
application was reached.

Delete an existing 
product of this type 
before adding a new 
product.

The maximum number 
of remote network 
addresses has already 
been configured.

A maximum of four IP 
addresses for remote 
workstations can be 
configured at the Session 
Options dialog box. That 
number was reached.

Delete an existing IP 
address before adding a 
new IP address.

The maximum number 
of members has 
already been 
configured.

The maximum number of 
unique members is 4097. 
The maximum number of 
members is 8192.

Delete members that are 
no longer needed to 
allow new members to be 
configured. 

The maximum number 
of users has already 
been configured.

The number of users (16) 
that can be defined to the 
HAFM application was 
reached.

Delete an existing user 
before adding a new 
user.

The maximum number 
of zone sets has 
already been 
configured.

The maximum number of 
zone sets that can be 
defined to the HAFM 
application was reached.

Delete an existing zone 
set before adding a new 
zone set.

The maximum number 
of zones allowed has 
already been 
configured.

The maximum number of 
zones that can be defined to 
the HAFM application was 
reached.

Delete an existing zone 
before adding a new 
zone.

Message Description Action
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The maximum number 
of zones per zone set 
has already been 
configured.

The maximum number of 
zones that can be defined in 
a zone set to the HAFM 
application was reached.

Delete an existing zone 
before adding a new 
zone to the zone set.

The nickname does not 
exist.

The entered nickname does 
not exist in the fabric.

Configure the nickname 
to the appropriate 
product or choose an 
existing nickname.

The nickname is 
already assigned. 
Either use a different 
name or do not save 
the name as a 
nickname.

The entered nickname 
already exists in the fabric. 
Each nickname must be 
unique.

Define a different 
nickname.

The software version 
on this HAFM server is 
not compatible with the 
version on the remote 
HAFM server.

A second HAFM server PC 
(client) connecting to the 
HAFM server must be 
running the same software 
version to log in.

Upgrade the software 
version on the downlevel 
HAFM server PC.

This Worldwide Name 
was not accepted. The 
World Wide Name and 
Domain ID must be 
unique in the Fabric 
Membership List.

User attempted to add a 
detached Switch to the 
Fabric Membership List 
through the Fabric Binding 
option (SANtegrity feature), 
but an entry already exists 
in the Fabric Membership 
List with the same World 
Wide Name (WWN).

Enter a unique World 
Wide Name for the 
Switch in the Add 
Detached Switch dialog 
box.

The zoning library 
conversion must be 
completed before 
continuing.

The zoning library 
conversion is incomplete 
and the requested operation 
cannot continue.

Complete the zoning 
library conversion, then 
retry the operation.

This fabric log is no 
longer valid because 
the fabric has been 
unpersisted.

The selected fabric log is no 
longer available because 
the fabric has been 
unpersisted.

To start a new log for the 
fabric, persist the fabric 
through the Persist 
Fabric dialog box.

Message Description Action
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This network address 
has already been 
assigned.

The specified IP address 
was assigned and 
configured. A unique 
address must be assigned.

Consult with the 
customer’s network 
administrator to 
determine a new IP 
address to be assigned 
and configured.

This product is not 
managed by this HAFM 
server.

The product selected is not 
managed by this HAFM 
server.

Choose a product 
managed by this HAFM 
server or go to the HAFM 
server that manages the 
affected product.

This switch is currently 
part of this fabric and 
cannot be removed 
from the Fabric 
Membership List. 
Isolate the switch from 
the fabric prior to 
removing it from the 
Fabric Membership 
List.

User attempted to remove a 
Switch from the Fabric 
Membership List using the 
Fabric Binding option, but 
the Switch is still part of the 
fabric.

Remove the Switch from 
the fabric by setting the 
Switch offline or blocking 
the E_Port where the 
Switch is connected.

This user name has 
already been assigned.

The specified user name is 
already assigned and 
configured.

Modify (to make it 
unique) or delete the 
duplicate name.

Too many members 
defined.

The maximum number of 
zone members that can be 
defined to the HAFM 
application was reached.

Delete an existing zone 
member before adding a 
new zone member.

You do not have rights 
to perform this action.

Configured user rights do 
not allow this operation to 
be performed.

Verify user rights with the 
customer’s network 
administrator and 
change as required using 
the Configure Users 
dialog box.

Message Description Action
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You must define an 
SMTP server address.

A simple mail transfer 
protocol (SMTP) server 
address must be defined 
and configured for e-mail to 
be activated.

Define the SMTP server 
address at the 
Configure E-Mail dialog 
box.

You must define at least 
one E-mail address.

At least one e-mail address 
must be defined and 
configured for e-mail to be 
activated.

Define an e-mail address 
at the Configure E-Mail 
dialog box.

You must define at least 
one remote network 
address.

At least one IP address for a 
remote workstation must be 
configured for a remote 
session to be activated.

Define an IP address for 
at least one remote 
workstation at the 
Configure Sessions 
dialog box.

You must download the 
HAFM client via the 
web install to continue.

An attempt was made to 
download the HAFM 
application to a remote 
workstation (client) using an 
improper procedure.

Download a compatible 
version of the HAFM 
application to the remote 
workstation (client) using 
the web install 
procedure.

Zones configured with 
port numbers are 
ignored in Open Fabric 
Mode.

While in Open Fabric mode, 
zones configured using port 
numbers are enforced 
through World Wide Name.

Informational message 
only - no action is 
required.

Zones must be defined 
before creating a zone 
set.

You cannot create a zone 
set without any zones 
defined for the HAFM.

Define zones using the 
New Zone dialog box.

Zoning by port number 
is not supported in 
Open Fabric Mode.

You cannot specify an item 
for zoning by port number if 
the HAFM is in Open Fabric 
Mode. 

Either define zones by 
WWN of device or 
change to Homogeneous 
Fabric mode in the 
Configure Operation 
Mode dialog box of 
Product Manager 
application.

Zoning name already 
exists.

Duplicate zone names are 
not allowed in the zoning 
library.

Modify (to make it 
unique) or delete the 
duplicate zone name.

Message Description Action
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B
Configuring Remote Workstations:

Windows Systems

This section describes the procedures for installing the high availability fabric 
manager on a remote workstation running Windows 95, Windows 98, Windows 2000, 
or Windows XP. To run the High Availability Fabric Manager on a remote 
workstation, you must first download and install the High Availability Fabric 
Manager application from the HAFM server.

The figures in this chapter show Netscape Navigator as the Internet browser; however, 
it is acceptable to use Microsoft Internet Explorer during these procedures.

Requirements
The download and installation process requires the use of a personal computer (PC) 
with the following minimum system requirements:

• Operating system (one of the following):

— Windows 95

— Windows 98

— Windows 2000

— Windows NT 

— Windows XP

• 400 megahertz (MHz) Pentium processor. 

• 128 megabyte (MB) random access memory (RAM) memory. 

• 28 MB available disk space.

• Video card supporting 256 colors at 800 x 600 resolution.

• Ethernet network adapter.
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• Java-enabled Internet browser, such as Microsoft Internet Explorer (version 3.0 or 
later) or Netscape Navigator (version 3.0 or later).

Newer versions of the High Availability Fabric Manager or Product Managers 
installed on the HAFM server will automatically download when the remote clients 
log in to the server.

Procedure
To install the High Availability Fabric Manager on a remote workstation: 

1. Open a World Wide Web (WWW) browser.

2. Type the address of the HAFM server in the Location (or Address) box on the 
browser, then press Enter.

For example;

http://HAFMserver

where “HAFMserver” is the network address of the HAFM server.

Obtain the HAFM server address from your network administrator

The HP StorageWorks HAFM remote client installation screen displays. 
Figure B–1 on page B-3 shows the upper portion of this page.
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Figure B–1:  Remote Client Installation screen

1. On the page, click Begin Windows Installation to begin the installation process. 
A security warning page prompts you to install the InstallAnywhere Web Installer 
(Figure B–2). 

Figure B–2:  Security Warning page
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2. If you have read the security agreement information and wish to continue, click 
Yes. The HP High Availability Fabric Manager (HAFM) InstallAnywhere 
Web Installer page displays. Figure B–3 illustrates a portion of this page.

Figure B–3:  InstallAnywhere Web Installer page

3. On the InstallAnywhere Web Installer page, click Start Installer for Windows. 
The system begins downloading the High Availability Fabric Manager installer.

When the download is complete, the Introduction screen displays (Figure B–4 on 
page B-5).
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Figure B–4:  High Availability Fabric Manager Installer — Introduction screen

4. Click Next.

At any time, you may return to the previous page by clicking Previous or quit the 
Installer by clicking Exit.

The License Agreement screen displays (Figure B–5 on page B-6).
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Figure B–5:  High Availability Fabric Manager Installer — License Agreement

5. If you have read the license agreement and agree to accept the terms, click I 
accept the terms of the License Agreement. Click Next.

The Important Information screen displays (Figure B–6).

Figure B–6:  High Availability Fabric Manager Installer — Important Information
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6. Click Next.

The Choose Install Folder screen displays (Figure B–7).

Figure B–7:  High Availability Fabric Manager Installer — Choose Install Folder

7. Select a folder on the remote workstation in which to store the HAFM software. 
You can accept the default location, type in the path to a new location, or click 
Choose to browse for an appropriate location. Click Restore Default Folder to 
change the location back to the default folder.

8. Click Next.

If the High Availability Fabric Manager is already installed on the system, you 
will be prompted to uninstall the existing version. If you want to uninstall the 
existing software, click the Yes radio button and press Next. When the Uninstall 
HAFM window displays, click Uninstall. When the Uninstall Complete screen 
displays, click Quit.

The Choose Shortcut Location screen displays (Figure B–8 on page B-8).
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Figure B–8:  High Availability Fabric Manager Installer — Choose Shortcut 
Location

9. Select a shortcut location. The options for the location of High Availability Fabric 
Manager icons are: 

• In a new Program Group—Adds a new program group on the Start menu 
for the High Availability Fabric Manager.

• In an existing Program Group—Enables you to choose from existing 
program groups on the Start menu for the High Availability Fabric Manager.

• In the Start Menu—Puts the High Availability Fabric Manager icon on the 
initial Start menu.

• On the Desktop—Puts the High Availability Fabric Manager icons on the 
Windows desktop.

• Other—Enables you to choose any location on your hard drive or network for 
the High Availability Fabric Manager files.

• Don’t create icons—Prevents the installation from creating an icon for the 
High Availability Fabric Manager.
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The Create Icons for All Users check box can be enabled for some of the 
shortcut options but not all. If the check box is enabled, the appropriate High 
Availability Fabric Manager icons are placed on the desktop and in the Programs 
folder of every Windows user. If the check box is cleared, the icons are created 
only for the current user and are not visible for other user IDs.

10. Click Next to begin the installation. 

The Pre-Installation Summary screen displays (Figure B–9).

Figure B–9:  High Availability Fabric Manager Installer — Pre-Installation 
Summary

11. Review the installation information and click Install.

The progress of the installation is tracked on the Installing HP StorageWorks 
HAFM screen (Figure B–10).
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Figure B–10:  Installing HP HAFM

12. When complete, the following screen displays (Figure B–11). Click Done to close 
the Install Complete dialog box. 

Figure B–11:  High Availability Fabric Manager Installer — Install Complete
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Running the High Availability Fabric Manager

1. If you chose icons to be created in step 9 of the installation procedure, access the 
icon installed in the windows Start menu or desktop to run HAFM.

2. If you did not create any icons in step 9 of the installation procedure, right -lick 
the My Computer icon and choose Exploring. In the Exploring window, browse 
to the directory in which you saved the High Availability Fabric Manager program 
(the default is a subdirectory named HAFM in your home directory). 

3. Double-click the High Availability Fabric Manager icon to run the High 
Availability Fabric Manager program.
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C
Configuring Remote Workstations:

Solaris Systems

This section describes the procedures for installing the High Availability Fabric 
Manager on a remote Solaris workstation. To run the High Availability Fabric 
Manager on a remote workstation, you must first download and install the High 
Availability Fabric Manager application from the HAFM server.

The figures in this chapter show Netscape Navigator as the Internet browser; however, 
it is acceptable to use Microsoft Internet Explorer during these procedures.

Requirements
The download and installation process requires the use of a workstation with the 
following minimum system requirements:

• Operating systems (one of the following): 

— SunOS version 5.5.1 or higher

— Solaris version 2.5.1 or higher

• 400 megahertz (MHz) UltraSPARC-II processor. 

• 128 megabyte (MB) random access memory (RAM) memory. 

• 60 MB available disk space.

• Video card supporting 256 colors at 800 x 600 resolution.

• Network connection.

• Internet browser, such as Microsoft Internet Explorer (version 3.0 or later) or 
Netscape Navigator (version 3.0 or later).

Newer versions of the High Availability Fabric Manager or Product Managers 
installed on the HAFM server will automatically download when the remote clients 
log in to the Server.
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Procedure
To install the High Availability Fabric Manager on a remote workstation: 

1. Open a World Wide Web (WWW) browser.

2. Type the address of the HAFM server in the Location (or Address) field of the 
browser, then press Enter.

For example;

http://HAFMserver

where “HAFMserver” is the network address of the HAFM server.

Obtain the HAFM server address from your network administrator

The HP StorageWorks HAFM page displays. Figure C–1 illustrates a partial page 
with the Windows installation section.

Figure C–1:  HP HAFM page
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3. On the page, click Begin Solaris Installation to begin the installation process. A 
security warning page prompts you to install the InstallAnywhere Web Installer 
(Figure C–2). 

Figure C–2:  Security Warning page

4. If you have read the security agreement information and wish to continue, click 
Yes. The HP High Availability Fabric Manager (HAFM) InstallAnywhere 
Web Installer page displays. 

5. On the HP HAFM InstallAnywhere Web Installer page, click Start Installer 
for Solaris SPARC. The system begins downloading the High Availability Fabric 
Manager installer.

When the download is complete, the Introduction screen displays (similar to 
Figure B–4 on page B-5).

6. Click Next.

At any time, you may return to the previous page by clicking Previous or quit the 
Installer by clicking Exit.

The License Agreement screen displays (similar to Figure B–5 on page B-6).

7. If you have read the license agreement and agree to accept the terms, click I 
accept the terms of the License Agreement. Click Next.

The Important Information screen displays (similar to Figure B–6 on page B-6).
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8. Click Next.

The Choose Install Folder screen displays (similar to Figure B–7 on page B-7).

9. Choose a folder on the remote workstation in which to store the HAFM software. 
You can accept the default location, type in the path to a new location, or click 
Choose to browse for an appropriate location. Click Restore Default Location to 
change the location back to the default.

10. Click Next.

NOTE:  If the High Availability Fabric Manager is already installed on the system, you will be 
prompted to uninstall the existing version of the High Availability Fabric Manager. If you want to 
uninstall the existing software, click Yes and press Next. In the Uninstall High Availability 
Fabric Manager window, click Uninstall. When the uninstallation process is done, click Quit.

The Choose Shortcut Location screen displays.

11. Select a shortcut location. The options for the location of High Availability Fabric 
Manager links are: 

• In your home folder—Adds a new program group on the Start menu for the 
High Availability Fabric Manager.

• Other—Enables you to choose any location on your hard drive or network for 
the High Availability Fabric Manager files.

• Don’t create links—Prevents the installation from creating a link for the 
High Availability Fabric Manager.

12. Click Next to begin the installation.

The Pre-Installation Summary screen displays (similar to High Availability 
Fabric Manager).

13. Review the installation information and click Install.

The progress of the installation is tracked on the Installing HP StorageWorks 
HAFM screen (similar to Figure B–10 on page B-10).

14. When complete, the screen shown in Figure B–11 on page B-10 displays. If 
desired, enable the Start the High Availability Fabric Manager check box to 
immediately open the High Availability Fabric Manager. Click Done to close the 
Install Complete dialog box.
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Running the High Availability Fabric Manager

Run the High Availability Fabric Manager program from the directory in which you 
saved it (the default is a subdirectory named HAFM in your home directory).

1. In the Terminal window, type cd HAFM.

2. Press Enter.

3. Then type HAFM_Manager.

4. Press Enter.

The High Availability Fabric Manager application opens.
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Configuring Remote Workstations: HP-UX,

AIX, and Linux

This appendix describes the procedures for installing the high availability fabric 
manager on a remote HP-UX, AIX, or Linux workstation. To run the High Availability 
Fabric Manager on a remote workstation, you must first download and install the High 
Availability Fabric Manager application from the HAFM server.

NOTE:  The figures in this chapter show Netscape Navigator as the internet browser; however, 
it is acceptable to use Microsoft Internet Explorer during these procedures.

Requirements
The download and installation process requires the use of a PC with the following 
minimum system requirements:

• Operating system (one of the following): 

— HP-UX 11.

— AIX minimum version 4.3.3.

— Linux minimum version 2.2.5.

• 400 MHz HA PA-RISC processor. 

• 128 MB RAM.

• Available disk space:

— 90 MB for HP-UX

— 40 MB for AIX minimum version 4.3.3.

— 55 MB for Linux minimum version 2.2.5.

• Video card supporting 256 colors at 800 x 600 resolution.
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• Ethernet network adapter.

• Java-enabled Internet browser, such as Microsoft Internet Explorer (version 3.0 or 
later) or Netscape Navigator (version 3.0 or later).

Newer versions of the High Availability Fabric Manager or Product Managers 
installed on the HAFM server will automatically download when the remote clients 
log in to the HAFM server.

Procedure
1. Open a Terminal window by choosing Terminal from the Personal Applications 

subpanel.

2. At the prompt (#), type netscape. Press Enter.

The Netscape browser opens.

3. Type the address of the HAFM server in the Location (or Address) box of the 
browser, then press Enter.

http://HAFMserver

where “HAFMserver” is the IP address and DNS host name of the HAFM server.

Obtain the HAFM server address from your network administrator.

The HP StorageWorks HAFM page displays. Figure D–1 on page D-3 illustrates the 
top portion of this page.
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Figure D–1:  HP StorageWorks HAFM page

4. Read the instructions for your operating system.

If a reference to fixes is made, click the hyperlink and verify that your system is 
up-to-date.

5. Click the appropriate button (Begin HP-UX Installation/Begin AIX Installation 
/Begin Linux Installation) to begin the installation process. A security warning 
page prompts you to install the InstallAnywhere Web Installer (Figure D–2 on 
page D-4). 
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Figure D–2:  Security Warning page

1. If you have read the security agreement information and wish to continue, click 
Yes. The HP High Availability Fabric Manager InstallAnywhere Web 
Installer page displays for HP-UX, AIX, and Linux. 

2. On the HP High Availability Fabric Manager InstallAnywhere Web Installer 
page, click Start Installer for <platform>, where <platform> is the type of 
operating system used by the system, for example, HP-UX. The system begins 
downloading the High Availability Fabric Manager installer.

3. A Save As dialog box displays automatically with the default filename 
hpClientInstall.bin. Change the filename to: /home/hpClientInstall.bin. Click OK.

Software download begins.

4. Close the Netscape window.

5. In the Terminal window, type cd home. Press Enter. Then type
sh hpClientInstall.bin. Press Enter.

When the download is complete, the Introduction screen displays (similar to 
Figure B–4 on page B-5).

Be aware that there may be a considerable delay.
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6. Click Next.

At any time, you may return to the previous page by clicking Previous or quit the 
Installer by clicking Exit.

The License Agreement screen displays (similar to Figure B–5 on page B-6).

7. If you have read the license agreement and agree to accept the terms, click I 
accept the terms of the License Agreement. Click Next.

The Important Information screen displays (similar to Figure B–6 on page B-6).

8. Click Next.

The Choose Install Folder screen displays (similar to Figure B–7 on page B-7).

9. Choose a folder on the remote workstation in which to store the High Availability 
Fabric Manager software. You can accept the default location, type in the path to a 
new location, or click Choose to browse for an appropriate location. Click 
Restore Default Location to change the location back to the default.

10. Click Next.

NOTE:  If the High Availability Fabric Manager is already installed on the system, you will be 
prompted to uninstall the existing version of the High Availability Fabric Manager. If you want to 
uninstall the existing software, click Yes and press Next. In the Uninstall High Availability 
Fabric Manager window, click Uninstall. When the uninstallation process is done, click Quit.

The Choose Shortcut Location screen displays.

11. Select a shortcut location from this screen. The options for the location of High 
Availability Fabric Manager links are: 

• In your home folder—Adds a new program group on the Start menu for the 
High Availability Fabric Manager.

• Other—Enables you to choose any location on your hard drive or network for 
the High Availability Fabric Manager files.

• Don’t create links—Prevents the installation from creating a link for the 
High Availability Fabric Manager.

12. Click Next to begin the installation.

The Pre-Installation Summary screen displays (similar to Figure B–9 on 
page B-9).
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13. Review the installation information and click Install.

The progress of the installation is tracked on the Installing High Availability 
Fabric Manager screen (similar to Figure B–10 on page B-10).

14. When complete, the screen shown in Figure B–11 on page B-10 displays. If 
desired, enable the Start the High Availability Fabric Manager check box to 
immediately open the High Availability Fabric Manager. Click Done to close the 
Install Complete dialog box.

Running the High Availability Fabric Manager

Run the High Availability Fabric Manager program from the directory in which you 
saved it.

1. In the Terminal window, type:

cd HAFM

2. Press Enter. 

3. Type:

./HAFM 

4. Press Enter.

The High Availability Fabric Manager application will open.
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Glossary

This glossary defines terms used in this guide or related to this product and is not a 
comprehensive glossary of computer terms.

access control
List of all devices that can access other devices across the network and the permissions 
associated with that access. See also persistent binding and zoning.

active zone set
Single zone set that is active in a multiswitch fabric. It is created when you enable a specified 
zone set. This zone set is compiled by checking for undefined zones or aliases.

agent
Software that processes queries on behalf of an application and returns replies.

alarm
SNMP message notifying an operator of a network or device problem.

alias server
Fabric software facility that supports multicast group management.

audit log
Log summarizing actions (audit trail) made by the user.

authentication
Verification of identity for a person or process.

beaconing
Use of light-emitting diodes on ports, port cards, field-replaceable units, and Directors to aid 
in the fault-isolation process; when enabled, active beaconing will cause LEDs to illuminate 
for faulty components.

BB_Credit
Also known as buffer-to-buffer credit. Indicates the maximum number of frames a port can 
transmit without receiving a receive ready signal from the receiving device.

BER
See bit error rate.
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bidirectional
In Fibre Channel, the capability to simultaneously communicate at maximum speeds (100 
Mbps) in both directions over a link.

bit error rate
Also known as BER. Ratio of received bits that contain errors to total of all bits transmitted.

blocked port
Devices communicating with the port are prevented from logging into the Director or 
communicating with other devices attached to the Director. A blocked port continuously 
transmits the offline sequence.

bridge
Device that connects and passes packets between two network segments that use the same 
communications protocol.

broadcast
Send a transmission to all N_Ports on a fabric.

broadcast frames
Data packet, also known as a broadcast packet, whose destination address specifies all 
computers on a network. See also multicast.

buffer
Storage area for data in transit. Buffers compensate for differences in processing speeds 
between devices. See also BB_Credit.

call-home
Product feature which enables the HAFM server to automatically dial out to a support center 
and report system problems. The support center server accepts calls from the HAFM server, 
logs reported events, and can notify one or more support center representatives.

central memory module card
Also known as CMM. Circuit card that provides the storage area for Fibre Channel ports to 
deposit and retrieve Fibre Channel frames. Each port is allocated a portion of this memory 
divided into a fixed number of frame buffers.

channel
Point-to-point link that transports data from one point to the other.

class of Fibre Channel service
Defines the level of connection dedication, acknowledgment, and other characteristics of a 
connection.

Class F Fibre Channel service
Used by Switches to communicate across interswitch links (ISLs) to configure, control, and 
coordinate a multiswitch fabric.
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Class 2 Fibre Channel service
Provides a connectionless (not dedicated) service with notification of delivery or nondelivery 
between two N_Ports. In-order delivery of frames is not guaranteed.

Class 3 Fibre Channel service
Provides a connectionless (not dedicated) service without notification of delivery or 
nondelivery between two N_Ports. Also known as a datagram.

CMM
See central memory module card.

community profile
Information that specifies which management objects are available to what management 
domain or SNMP community name.

concurrent maintenance
Ability to perform maintenance tasks, such as removal or replacement of field-replaceable 
units, while a hardware product is operating. See also nondisruptive maintenance.

configuration data
Configuration data includes: identification data, port configuration data, operating parameters, 
SNMP configuration, and zoning configuration. A configuration backup file is required to 
restore configuration data if the nonredundant CTP card in a Director is removed and replaced.

connectionless
Nondedicated link. Typically used to describe a link between nodes which allows the Switch to 
forward Class 2 or Class 3 frames as ports allow. Contrast this to the dedicated bandwidth that 
is required in a Class 1 Fibre Channel Service point-to-point link.

connector
See optical fiber connector.

control processor card
Also known as CTP. Circuit card that contains the Director microprocessor. The CTP card also 
initializes hardware components of the system after power-on. A 10 Mbps RJ-45 twisted pair 
connector is located on the CTP card to connect to the Ethernet LAN and communicate with 
the HAFM server or a specific management station.

CRC
See cyclic redundancy check.

CTP
See control processor card.
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cyclic redundancy check
Also known as CRC. System of error checking performed at both the sending and receiving 
station using the value of a particular character generated by a cyclic algorithm. When the 
values generated at each station are identical, data integrity is confirmed.

DASD
Direct access storage device such as a disk drive.

datagram
See Class 3 Fibre Channel service.

default
Pertaining to an attribute, value, or option that is assumed when none is explicitly specified. 

default zone
Contains all attached devices that are not members of a separate zone.

destination address
Address identifier that indicates the targeted destination of a data frame. 

device
Product, connected to a managed Director, that is not controlled directly by the Product 
Manager. See also node.

diagnostics
Procedures used by computer users and service personnel to diagnose hardware or software 
error conditions.

dialog box
A dialog box is a window containing informational messages or data fields to be modified or 
filled in with desired options.

D_ID
See destination address.

Director
An intelligent Fibre Channel switching device providing any-to-any port connectivity between 
nodes (end devices) on a switched fabric. The Director sends data transmissions (data frames) 
between nodes in accordance with the address information present in the frame headers of 
those transmissions.

DNS name 
Domain name system or (domain name service). Host or node name for a device or managed 
product that is translated to an IP address through a domain name server.

domain ID
Number (1 through 31) that uniquely identifies a Switch in a multiswitch fabric. A distinct 
domain ID is automatically allocated to each Switch in the fabric by the principal Switch.
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E_Port
See expansion port.

E_D_TOV 
See error detect time-out value.

error-detect time-out value
E_D_TOV defines the time the Switch waits for an expected response before declaring an 
error condition.

error message
Indication that an error has been detected. See also error message and information message.

Ethernet
A widely-implemented local area network (LAN) protocol that uses a bus or star topology and 
served as the basis for the IEEE 802.3 standard, which specifies the physical and software 
layers. Baseband LAN allows multiple station access to the transmission medium at will, 
without prior coordination, and avoids or resolves contention.

event code
Code that provides the operator with information concerning events.

event log
Record of significant events that have occurred on the Director, such as FRU failures, degraded 
operation, and port problems.

expansion port
Physical interface on a Fibre Channel Switch within a fabric, that attaches to an expansion 
(E_Port) on another Fibre Channel Switch to form a multiswitch fabric. See also segmented 
E_Port.

explicit fabric login 
Data field size, supported by an F-Port, that is agreed upon during fabric login. 

fabric
Entity that interconnects N_Ports and is capable of routing (switching) Fibre Channel frames 
using the destination ID information in the Fibre Channel frame header accompanying the 
frames.

fabric element
Any active Director or node in a switched fabric.

fabric port
Physical interface within the fabric that connects to an N_Port through a point-to-point full 
duplex connection.
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failover
Automatic and nondisruptive transition of functions from an active FRU that has failed to a 
backup FRU.

FCC-IOC
See Fibre Channel I/O controller.

FCP
A standard Fibre Channel protocol used to run SCSI over Fibre Channel.

FE-MIB
See Fibre Channel fabric element.

fiber optics
Branch of optical technology concerned with the transmission of light pulses through fibers 
made of transparent materials such as glass, fused silica, and plastic.

fiber
Physical media types supported by the Fibre Channel specification, such as optical fiber, 
twisted pair, and coaxial cable.

Fibre Channel
Integrated set of standards recognized by ANSI which defines specific protocols for flexible 
information transfer. Logically, a point-to-point serial data channel, structured for high 
performance.

Fibre Channel fabric element
Any device linked to a fabric. Information about these devices is recorded in a management 
information base (MIB) which can be accessed by fabric management software.

Fibre Channel I/O controller 
Controls the embedded Fibre Channel port on the message path controller card (MPC) and 
configures the ports’ ASICs.

field-replaceable unit
Assembly removed and replaced in its entirety when any one of its components fails.

firmware
Embedded program code that resides and executes on the Director.

F_Port
See fabric port. 

FRU
See field-replaceable unit.

gateway address
In TCP/IP, a device that connects two systems that use the same or different protocols. 



ha-fabric manager user guide Glossary–7

Glossary

generic port 
Also known as G_Port. Physical interface on a Director that can function either as a fabric port 
(F_Port) or an extension port (E_Port) depending on the port type to which it connects.

G_Port
See generic port.

G_Port module (GPM) card
Also known as GPM card. Port card that implements four G_Ports and provides the physical 
connection point for links to Fibre Channel devices.

HAFM Management Services
Software application that provides back-end product-independent services to the High 
Availability Fabric Manager application. HAFM Management Services runs only on the 
HAFM server (and cannot be downloaded to remote workstations).

HAFM server
PC shipped with a product to run the High Availability Fabric Manager, Product Manager, 
and SDC Fabric Manager applications.

hardware log
Record of FRU insertions and removals in the Director.

HBA
See host bus adapter.

high availability
A performance feature characterized by hardware component redundancy and support for 
hot-swapping (enabling non-disruptive maintenance). These systems maximize system uptime 
while providing superior reliability, availability, and serviceability.

hop
Data transfer from one node to another node.

host bus adapter
Logic card that provides a link between the server and storage subsystem, and that integrates 
the operating systems and I/O protocols to ensure interoperability.

hot-swapping
Removing and replacing a device’s components while the device continues to operate 
normally.

HP StorageWorks High Availability Fabric Manager
Software application that is the system management framework providing the user interface 
for managing HP Fibre Channel connectivity products. The High Availability Fabric Manager 
can run both locally on the HAFM server and remotely on a user workstation.
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hub
In Fibre Channel, a device that connects nodes into a logical loop by using a physical star 
topology.

IML
See initial machine load.

information message
Message telling a user that a function is performing normally or has completed normally. See 
also error message and warning message.

initial machine load
Also known as IML. Hardware reset for all installed CTP cards on the Director. It does not 
affect other hardware. It is initiated by pushing the IML button on a Director’s operating panel.

initial program load
Process of initializing the device and causing the operating system to start. Initiated through a 
menu in the Product Manager, this option performs a hardware reset on the active CTP only.

interface
Hardware, software, or both, linking systems, programs, or devices.

internet protocol address
Unique string of numbers (in the format xxx.xxx.xxx.xxx) that identifies a device on a 
network.

interoperability
Ability to communicate, execute programs, or transfer data between various functional units 
over a network.

interswitch link 
Also known as ISL. Physical E_Port connection between two Directors in a fabric.

IP address
See internet protocol address.

IPL
See initial program load.

ISL
See interswitch link.

jumper cable
Optical cable that provides physical attachment between two devices or between a device and 
a distribution panel. Contrast with trunk cable.
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latency
When used in reference to a Fibre Channel switching device, latency refers to the amount of 
time elapsed between receipt of a data transmission at a Switch’s incoming F_Port (from the 
originating node port) to retransmission of that data at the Switch’s outgoing F_Port (to the 
destination N_Port). The amount of time it takes for data transmission to pass through a 
switching device. 

LIN
See link incident.

link
Physical connection between two devices on a switched fabric.

link incident
Interruption to link due to loss of light or other causes.

load balancing
Ability to evenly distribute traffic over multiple interswitch links within a fabric. Load 
balancing on HP Directors takes place automatically.

logical unit number
Also known as LUN. In Fibre Channel addressing, a logical unit number is a number assigned 
to a storage device which, in combination with the storage device’s node port’s World Wide 
Name, represents a unique identifier for a logical device on a storage area network.

loopback plug
In a fiber optic environment, a type of duplex connector used to wrap the optical output signal 
of a device directly to the optical input.

loopback test
Test that checks attachment or control unit circuitry, without checking the mechanism itself, by 
returning the output of the mechanism as input.

LUN
See logical unit number.

MAC address 
See Media Access Control address.

maintenance port
Connector on the Director operator panel where a PC running an ASCII terminal emulator can 
be attached or dial-up connection made for specialized maintenance support.

managed product
Hardware product that can be managed with the Product Manager. For example, the HP 
StorageWorks Director 2/64 is a managed product. See also device.
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management information base
Related set of software objects (variables) containing information about a managed device and 
accessed via SNMP from a network management station.

management session
Management session exists when a user logs on to the High Availability Fabric Manager. 
HAFM can support multiple concurrent management sessions. The user must specify the 
network address of the High Availability Fabric Manager’s server at logon time.

Media Access Control address
Hardware address of a node (device) connected to a network.

message path controller card
Message path controller card (MPC) provides the mechanism for messages to be sent and 
received between ports on the Director. The card also provides a system clock source, and 
central control and distribution of clocks for MPC, GPM, and CMM cards. 

MIB
See management information base.

MPC
See message path controller card.

multicast
Delivery of a single transmission to multiple destination N_Ports. Can be one to many or many 
to many. All members of the group are identified by one IP address.

multiswitch fabric
Fibre Channel fabric created by linking more than one Director or fabric switching device 
within a fabric.

name server
Program that translates names from one form into another. Domain name servers (DNS) 
translate domain names into IP addresses.

name server zoning
N_Port access management that allows N_Ports to communicate if and only if they belong to a 
common name server zone. 

network address
Name or address that identifies a managed product, such as the HP StorageWorks Director 
2/64 on a TCP/IP network. The network address can be either an IP address in dotted-decimal 
notation (comprised of four three-digit octets in the format xxx.xxx.xxx.xxx), or a domain 
name (as administered on a customer network). 

nickname
Alternate name assigned to a World Wide Name for a node or Director in the fabric. 
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node
In Fibre Channel terminology, mode refers to an end device (Server or storage device) that is 
or can be connected to a switched fabric.

node port
Physical interface within an end device which can connect to an F_Port on a switched fabric or 
directly to another N_Port (in point-to-point communications).

nondisruptive maintenance
Ability to service FRUs (including maintenance, installation, removal and replacement) while 
normal operations continue without interruption. See also concurrent maintenance.

N_Port
See node port.

offline sequence (OLS)
Sequence sent by the transmitting port to indicate that it is attempting to initialize a link and 
has detected a problem in doing so.

optical cable
Fiber, multiple fibers, or a fiber bundle in a structure built to meet optical, mechanical, and 
environmental specifications. See also jumper cable, optical cable assembly, and trunk cable.

optical cable assembly
Optical cable that is connector-terminated. See jumper cable and optical cable.

optical fiber connector
Hardware component that transfers optical power between two optical fibers or bundles and is 
designed to be repeatedly connected and disconnected.

out-of-band management
Transmission of management information using frequencies or channels other than those 
routinely used for information transfer.

packet
Logical unit of information (usually in the form of a data frame) transmitted on a network. It 
contains a header (with all relevant addressing and timing information), the actual data, and a 
trailer (which contains the error checking function, usually in the form of a cyclic redundancy 
check), and frequently user data.

password
Unique string of characters known to the computer system and to a user who must specify it to 
gain full or limited access to a system and to the information stored within it.

path
In a network, any route between any two ports.
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persistent binding
A form of server-level access control that uses configuration information to bind a server to a 
specific Fibre Channel storage volume (or logical device) using a unit number.

port
Receptacle on a device to which a cable leading to another device can be attached.

port card
Field-replaceable hardware component that provides the port connections for fiber cables and 
performs specific device-dependent logic functions.

port name
Name that the user assigns to a particular port through the Product Manager.

POST 
See power-on self-test.

power-on self-test
Series of self-tests executed each time the unit is started or reset.

preferred domain ID
Domain ID assigned to a Switch is assigned by the principal Switch in a switched fabric. The 
preferred domain ID becomes the active domain ID except when configured otherwise by the 
user.

principal Switch
In a multiswitch fabric, the Switch that allocates domain IDs to itself and to all other Switches 
in the fabric. There is always one principal Switch in a fabric. If a Switch is not connected to 
any other Switches, it acts as its own principal Switch.

Product Manager
Application that implements the management user interface for the Director.

product name
User-configurable identifier assigned to a managed product. Typically, this name is stored on 
the product itself. For the HP StorageWorks Director 2/64, the product name can also be 
accessed by an SNMP manager as the system name. 

R_A_TOV 
See resource allocation time-out value.

redundancy
Performance characteristic of a system or product whose integral components are backed up 
by identical components to which operations will automatically failover in the event of a 
component failure. Redundancy is a vital characteristic of virtually all high-availability (24 
hr/7 days per week) computer systems and networks.
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remote access link
Connection to a device or program on a computer network via a (geographically) remote 
workstation.

remote notification
A process by which a system is able to inform remote users and/or workstations of certain 
classes of events that occur on the system. E-mail notification and the configuration of SNMP 
trap recipients are two examples of remote notification programs that can be implemented on 
director-class switches.

remote user workstation
Workstation, such as a PC, using High Availability Fabric Manager and Product Manager 
software that can access the HAFM server over a LAN connection. 

resource allocation time out value 
R_A_TOV is a value used to time out operations that depend on the maximum possible time 
that a frame could be delayed in a fabric and still be delivered.

SAN
See storage area network.

SC
Subscriber connectors.

segmented E_Port
E_Port that has ceased to function as an E_Port within a multiswitch fabric due to an 
incompatibility between the fabrics that it joins. See also expansion port.

SEL
System error light.

SNMP
Simple network management protocol.

SNMP community
Also known as SNMP community string. An SNMP community is a cluster of managed 
products (in SNMP terminology, hosts) to which the server or managed product running the 
SNMP agent belongs.

SNMP community name
The name assigned to a given SNMP community. Queries from an SNMP management station 
to a device running an SNMP agent will only elicit a response if those queries are addressed 
with the correct SNMP community name. 

SSP
See system services processor.
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storage area network
A high-performance data communications environment that interconnects computing and 
storage resources so that the resources can be effectively shared and consolidated.

subnet mask
Used by a computer to determine whether another computer with which it needs to 
communicate is located on a local or remote network. The network mask depends upon the 
class of networks to which the computer is connecting. The mask indicates which digits to 
look at in a longer network address and allows the router to avoid handling the entire address. 
Subnet masking allows routers to move the packets more quickly. Typically, a subnet may 
represent all the machines at one geographic location, in one building, or on the same local 
area network.

switch priority
Value configured into each Switch in a fabric that determines its relative likelihood of 
becoming the fabric’s principal Switch. 

system automation for OS/390 (SA OS/390)
IBM-licensed software that provides System/390 Parallel Sysplex management, automation 
capabilities, and integrated systems and network management. SA OS/390 manages host, 
remote processor, and I/O operations. SA OS/390 integrates the functions of Automated 
Operations Control for MVS, ESCON Manager, and Target System Control Facility.

system services processor
Controls the RS-232 maintenance port, the Ethernet port, and the operator panel of a Fibre 
Channel Director.

Tivoli
A suite of Enterprise management software products produced by a division of IBM.

topology
Logical and/or physical arrangement of stations on a network.

trap
Unsolicited notification of an event originating from a SNMP managed device and directed to 
an SNMP network management station.

trap host
SNMP management workstation that is configured to receive traps.

trunk cable
Cable consisting of multiple fiber pairs that do not directly attach to an active device. This 
cable usually exists between distribution panels and can be located within, or external to, a 
building. Contrast with jumper cable.
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unblocked port
Devices communicating with an unblocked port can log in to the Director and communicate 
with devices attached to any other unblocked port, assuming that this is supported by the 
current zoning configuration.

unicast
Communication between a single sender and a single receiver over a network. Compare to 
multicast (communication between a single sender and multiple receivers) and anycast 
(communication between any sender and the nearest of a group of receivers). Similar in 
meaning to point-to-point communication.

vital product data
System-level data stored by the backplane in the electrically erasable programmable read-only 
memory. This data includes serial numbers and identifies the manufacturer. 

VPD
See vital product data.

warning message
Indication that a possible error has been detected. See also error message and information 
message.

wrap plug
See loopback plug.

World Wide Names WWN)
Eight-byte address that uniquely identifies a Switch, or a node (end device), even on global 
networks.

zone
Set of devices that can access one another. All connected devices may be configured into one 
or more zones. Devices in the same zone can see each other. Those devices that occupy 
different zones cannot.

zone member
Specification of a device to be included in a zone. A zone member can be identified by the port 
number of the Director to which it is attached or by its device (or HBA) World Wide Name. In 
multiswitch fabrics, identification of end-devices/nodes by World Wide Name is preferable.

zone set
See zone.

zoning
Grouping of several devices by function or by location. All devices connected to a connectivity 
product, such as the Director, may be configured into one or more zones. See also zone.
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layout icons option, view menu  3–7
localhost, HAFM server name  1–4
logging in  1–3 to ??,  1–3
logout option, product menu  3–3
logs

audit log  7–2 to 7–3
event log  7–3 to 7–4
exporting  7–7
fabric log  7–7
product status log  7–6
saving  7–7
session log  7–5
sorting  7–1
using  7–1
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logs menu  3–22

M
maintenance menu  3–23
maintenance user rights  3–8
management

SNMP agent  1–1
web server  1–2

management server
FICON  8–1

configuring  8–1
installing  8–1

open systems  8–4
installing  8–5

menu bar options
available in fabrics view  5–17
available in products view  4–10

merging
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MIBs  3–19

mode
enterprise fabric  8–12

modify network address dialog box  4–5
modify option, product menu  3–2
modify user dialog box  3–13
modifying

network address  4–5
product properties  4–5
remote workstation address  3–18
session parameters  3–17
user information  3–13

monitor resolution  2–9
monitoring

errors  7–3 to 7–4
login/logout  7–5
product status  7–6
user actions  7–2 to 7–3

N
naming conventions
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network address
current user, viewing  1–8
displaying by  4–4
modifying  4–5

new option, product menu  3–1
new product button  2–3
new product dialog box  4–4
new user dialog box  3–11
new zone dialog box  6–15

adding zone members  6–16
new zone set dialog box  6–18

adding zones  6–19
nicknames

configuring  3–14,  5–9
deleting  3–17
description  3–14
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nicknames option, configure menu  3–14
node pop-up menu  5–9
node properties dialog box, illustration  5–9
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open product button  2–3
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configuring  8–5
installing  8–5
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modify network address dialog box  4–5
Product Manager  4–7
properties dialog box  4–6

operating systems for remote workstations  1–7
operational state  2–11
operational status  4–7
operator user rights  3–8

P
password, default  1–3
passwords

case sensitivity  1–6
default  1–6

persist fabric topology button  2–5
persist fabric topology option  5–5
persist fabric topology option, fabrics menu  3–4,  

5–14
persisted fabric

illustration  5–15
ISLs in  5–15

persistent binding  6–4
persistent fabrics  5–14
persisting a fabric topology  5–12
platforms for remote workstations  1–7
pop-up menus  5–10
port number, node properties dialog box  5–9
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interoperability mode  6–6
zone members  6–7
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product administrator user rights  3–8
product icon pop-up menu  5–11
product icons

adding  4–4

description  4–2
illustrated  4–2
maximum displayed  2–9
pop-up menu  4–5

Product Manager
backup  1–9
closing  4–9,  5–8
main window  4–8,  5–7
opening  4–7
options, list of  1–15
uses  1–1,  4–8,  5–7

product manager
non-English language support  8–3

product menu  3–1
product name, displaying by  4–4
product pop-up menu  5–7
product properties dialog box  4–6
product properties, viewing  4–6
product status icons  5–5
product status log  7–6
products

deleting, caution  3–2,  4–6
modifying  4–5
operational status  4–7
properties  4–6

products icons, maximum number of  4–2
products status box  2–12
products tab  2–8,  4–1
products view  4–1

illustration  2–9,  4–1
menu bar options available  4–10
overview  2–8
pop-up menu  4–3

programmed offline state control  8–2
properties button  2–4
properties option, product menu  3–3
properties, product  4–6

Q
QuikSync application

description  1–8
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managing  1–7

remote HAFM servers, accessing  1–6
remote management sessions, specifying number 

of  3–18
remote notification, testing  3–24
remote sessions, displaying  1–8
remote users, maximum  1–7,  4–9,  5–8
remote workstation address. changing  3–18
remote workstations

configuring
AIX systems  D–1
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Solaris systems  C–1
Windows systems  B–1

installation
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HP-UX systems  D–2
Linux systems  D–2
Solaris systems  C–2
Windows systems  B–2

installing software on  1–7
requirements  1–7

AIX systems  D–1
HP-UX systems  D–1
Linux systems  D–1
Solaris systems  C–1
Windows systems  B–1

removing, nicknames  3–17
rename option, fabrics menu  3–3
renaming

fabrics  5–5
zone sets  6–20

rerouting delay
enterprise fabric mode  8–12

restore data
procedure  1–11

rights, user  3–8
routes

displaying  5–22
showing  5–9

S
SANtegrity feature  8–6

fabric binding  8–6
SANtegrity features

switch binding  8–7
saving, log files  7–7
segmented E_Ports  6–9
server status  2–13
server-level access control  6–4
server-level access, controlling  6–4
session log, illustrated  7–5
session parameters, modifying  3–17
session, definition of  1–7
sessions option, configure menu  3–17
sessions, blocking  3–18
show fabric tree option, fabrics menu  3–5
show route dialog box  5–21
show route option, fabrics menu  3–4
show view port button  2–7
show view port option, fabrics menu  3–5
show zone members option, fabrics menu  3–5
show zoning library button  2–6
showing

routes  5–9
zone members  5–10

SMTP server  3–23
SMTP server address  3–24
SNMP

introduction  1–1
SNMP agent option, configure menu  3–19
SNMP community names  3–20
sorting, logs  7–1
square symbol  2–11
status icons  5–4
storage-level access control  6–5
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enable and disable  8–8
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online state functions  8–10
zoning function  8–11

switch binding membership list dialog box  8–9
switch clock alert mode  8–2
switch clock alert mode field  8–4
system administrator user rights  3–8

T
test remote notification dialog box  3–24
test remote notification option, maintenance menu  

3–24
testing

call-home notification  3–24
e-mail notification  3–24
remote notification  3–24

text panel  2–13
tool bar  2–3
tool bar options, available in fabrics view  5–27
topology tab  2–10,  5–2

illustration  5–1
using  5–4

topology view area  5–10
topology view, persisted fabric  5–15
trap recipients, maximum number of  3–19
triangle symbol  2–11

U
UDP port number, trap recipient  3–20
United States/Canada 00037 code page  8–3
unknown operational state  2–11
unpersist fabric topology, fabrics menu  3–4
unpersisting fabrics  5–17
user datagram protocol port number  3–20
user name, default  1–3
user names

case sensitivity  1–6
default  1–6

user parameters, modifying  3–13
user rights  3–8
user sessions dialog box  1–8,  3–6

user sessions option, view menu  3–6
user sessions, displaying  1–8
users

adding  3–11
deleting  3–14
maximum  3–8
modifying  3–12
number of  1–1

users option, configure menu  3–8

V
view area  5–1

displaying menu options  5–12
fabrics view  2–10
topology tab  5–10

view menu  3–6
view pop-up menu  4–3
view port window  3–5
view port, using  5–13
view rights  3–8

default  3–12

W
web server

introduction  1–2
Windows dial-up networking  3–26
WWNs

interoperability mode  6–6
zone members  6–6

X
XML file example  5–19

Y
yellow triangle symbol  2–11

Z
zone

description  6–1
zone members

finding  6–25
interoperability mode  6–6
maximum number  6–6
port numbers  6–7



Index–8 ha-fabric manager user guide

Index

replacing  6–26
showing  5–10,  6–31
types  6–6
WWNs  6–6

zone properties dialog box  6–23
zone properties, displaying  6–22
zone set library  6–8
zone set properties dialog box  6–24
zone set properties, displaying  6–22
zone set tab  2–10,  5–2

using  5–29
zone sets  6–20

activating  3–20,  6–26
active  6–8
configuring  6–17
copying  6–20
deactivating  3–21,  6–30
deleting  6–21
description  6–8
importing and exporting  6–22
maximum  6–17
modifying  6–19
naming conventions  6–5
renaming  6–21

zone sets tab, illustration  5–3
zoned fabrics, merging  6–8
zones

configuring  6–14
copying  6–20
default, configuring  3–21,  6–30

deleting  6–21
description  6–6
displaying  6–14
finding  6–24
identifying by port number  6–7
identifying by WWN  6–6
maximum  6–17
members

adding  6–15
modifying  6–19
naming conventions  6–5,  6–6
removing members  6–17
renaming  6–21

zoning
benefits  6–1
concepts  6–1,  6–5
configuring  6–11
multiple products, illustrated  6–3
single product, illustrated  6–2

zoning configurations
backing up  6–31
compatibility  6–9

zoning library  6–8
using  6–11

zoning library dialog box  6–11
zoning library option, configure menu  3–21
zoom in button  2–7
zoom option, view menu  3–7
zoom out button  2–8


	Contents
	About this Guide
	Intended Audience
	Related Documentation
	Document Conventions
	Table 1: Document Conventions

	Symbols in Text
	Symbols on Equipment
	Rack Stability
	Getting Help
	HP Technical Support
	HP Website

	HP Authorized Reseller

	Introduction and General Information
	Introduction to High Availability Fabric Management
	Figure 1-1: Out-of-Band product management
	HAFM Server Information

	High Availability Fabric Manager Overview
	Logging in to the High Availability Manager
	Figure 1-2: High Availability Fabric Manager Login dialog box
	Figure 1-3: High Availability Fabric Manager main window

	Accessing Remote HAFM Servers
	Figure 1-4: High Availability Fabric Manager Login dialog box

	Managing Remote Access to the HAFM Server
	Requirements for Remote Workstations
	Installing Software on Remote Workstations
	Displaying Remote Sessions
	Figure 1-5: User Sessions dialog box


	Backing Up and Restoring Data
	Backup
	Using QuikSync
	Figure 1-6: QuikSync icon in Windows system tray
	Enabling QuikSync
	QuikSync Settings
	Figure 1-7: Iomega QuikSync dialog box (Advanced tab)


	Restore

	HAFM Menu Options
	High Availability Fabric Manager
	View Tabs
	Products Menu
	Fabrics Menu
	View Menu
	Configure Menu
	Logs Menu
	Maintenance Menu
	Help Menu

	Product Manager
	View Tabs
	Product Menu
	Configure Menu
	Logs Menu
	Maintenance Menu
	Help Menu




	Using the HAFM Window
	Window Overview
	Illustrations Used in this Manual
	Layout of Elements
	Figure 2-1: High Availability Fabric Manager main window

	Window Elements
	Title Bar
	Menu Bar
	Tool Bar
	Main Panel
	Status Bar


	Tool Bar
	New Product Icon
	Figure 2-2: New Product icon

	Open Product Icon
	Figure 2-3: Open Product icon

	Properties Icon
	Figure 2-4: Properties icon

	Display Drop-Down List
	Figure 2-5: Display drop-down list

	Persist Fabric Topology Icon
	Figure 2-6: Persist Fabric Topology icon

	Export Fabric Topology Icon
	Figure 2-7: Export Fabric Topology icon

	Show Zoning Library Icon
	Figure 2-8: Show Zoning Library icon

	Layout Icons
	Figure 2-9: Layout Icons icon

	Show View Port Icon
	Figure 2-10: Show View Port icon

	Zoom In Icon
	Figure 2-11: Zoom In icon

	Zoom Out Icon
	Figure 2-12: Zoom Out icon

	Fit Topology in View Icon
	Figure 2-13: Fit Topology in View icon


	Main Panel
	Products View
	Figure 2-14: Products view

	Fabrics View
	Figure 2-15: Fabrics view


	Status Bar
	Table 2-1: Operational States and Symbols
	Products Status
	Fabrics Status
	HAFM Status
	Text Panel


	Using the Menu Bar
	Product
	New
	Open
	Delete
	Modify
	Properties
	Logout
	Exit

	Fabrics
	Rename
	Persist Fabric Topology
	Unpersist Fabric Topology
	Export Fabric Topology
	Show Route
	Hide Route
	Show Zone Members
	Show View Port
	Show Fabric Tree
	Enterprise Fabric Mode
	Fabric Binding

	View
	User Sessions
	Figure 3-1: User Sessions dialog box

	Zoom
	Arrange Icons
	Layout Icons
	Center in Topology
	Clear ISL Alert
	Clear All ISL Alerts
	Enable Fly-Over Display

	Configure
	Users
	User Rights
	User Rights for Specific Functions
	Table 3-1: User Rights for HAFM Functions


	Open the Configure User Dialog Box
	Figure 3-2: Configure Users dialog box

	Add New User
	Figure 3-3: New User dialog box

	Open the Modify User Dialog Box
	Figure 3-4: Modify User dialog box

	Modify User Parameters
	Delete User
	Figure 3-5: Delete User Warning


	Nicknames
	Figure 3-6: Configure Nicknames dialog box
	Figure 3-7: Add Nickname dialog box (Detached Node)
	Figure 3-8: Add Nickname dialog box (Attached Node)

	Sessions
	Figure 3-9: Configure Sessions dialog box

	SNMP Agent
	Figure 3-10: Configure SNMP dialog box

	Activate Zone Set
	Zoning Library
	Advanced Zoning

	Logs
	Audit Log
	Event Log
	Session Log
	Product Status Log
	Fabric Log
	Maintenance
	Configure E-Mail
	Figure 3-11: Configure E-Mail dialog box

	Test Remote Notification
	Figure 3-12: Test Remote Notification dialog box
	Figure 3-13: Results of Remote Notification Test

	Configure Ethernet Events
	Figure 3-14: Configure Ethernet Events dialog box

	Configure Call-Home Event Notification

	Help

	Using the Products View
	Overview
	Figure 4-1: Products view

	Product Icon Display
	Figure 4-2: Director 2/64 Product icon
	Icon Description

	View Context Menus
	View Pop-Up Menu
	New
	Figure 4-3: New Product dialog box

	Display Options
	Sort Options

	Product Icon Pop-Up Menu
	Open
	Modify
	Figure 4-4: Modify Network Address dialog box

	Delete
	Properties
	Figure 4-5: Product Properties dialog box



	Accessing a Product Manager
	Figure 4-6: Director 2/64 Product Manager window

	Available Tool Bar Options
	Available Menu Bar Options
	Product Menu
	View Menu


	Using the Fabrics View
	Overview
	Figure 5-1: Fabrics view - Topology tab
	Topology Tab
	Zone Set Tab
	Figure 5-2: Fabrics view - Zone Sets tab

	Fabric Tree

	Using the Topology Tab
	Fabric Tree
	Status Icons
	Fabric
	Product

	Fabric Pop-Up Menu
	Rename
	Persist Fabric Topology
	Unpersist Fabric Topology
	Properties
	Figure 5-3: Fabric Properties dialog box


	Product Pop-Up Menu
	Open
	Figure 5-4: Director 2/64 Product Manager window

	Center in Topology
	Properties

	Node Pop-Up Menu
	Properties
	Figure 5-5: Node Properties dialog box

	Show Route
	Nickname
	Show Zone Members


	Topology View Area
	Fly-Over Display
	Pop-Up Menus
	Product Icon
	ISL
	Figure 5-6: ISL Properties dialog box

	View Area

	Adjusting the Fabric Display

	Persistent Fabrics
	Figure 5-7: Persisted fabric in Topology view
	Graphic Indicators in View
	Fabric Log
	Unpersisting Fabrics

	Available Menu Bar Options
	Product
	Open
	Properties
	Logout
	Exit

	Fabrics
	Rename
	Persist Fabric Topology
	Unpersist Fabric Topology
	Export Fabric Topology
	.XML File Example

	Show Route
	Figure 5-8: Show Route dialog box
	Figure 5-9: Route displayed in Topology tab

	Hide Route
	Show Zone Members
	Show View Port
	Show Fabric Tree
	Enterprise Fabric Mode
	Fabric Binding

	View
	User Sessions
	Zoom
	Layout Icons
	Center in Topology
	Clear ISL Alert
	Clear All ISL Alerts
	Enable Fly Over Display

	Configure
	Users
	Nicknames
	Sessions
	SNMP Agent
	Activate Zone Set
	Zoning Library
	Advanced Zoning


	Active Tool Bar Options
	Open Product
	Properties
	Display Drop-Down Box
	Persist Fabric Topology
	Export Fabric Topology
	Show Zoning Library
	Layout Icons
	Show View Port
	Zoom In
	Zoom Out
	Fit Topology in View


	Using the Zone Set Tab
	View Area Features
	Available Menu Bar Options
	For More Information


	Fabric Zoning
	Zoning Basics
	Controlling Access Across a Fabric
	Figure 6-1: Zoning through a single Fibre Channel managed product
	Figure 6-2: Zoning through a multiswitch fabric

	Controlling Access at the Switch
	Controlling Access at the Server or Storage Device
	Zoning Concepts
	Naming Conventions for Zones and Zone Sets
	Zones
	Using WWNs
	Using Port Numbers

	Default Zone
	Zone Sets
	Active Zone Set
	Zoning Library

	Merging Zoned Fabrics
	Configurations of Merged Zoned Fabrics
	Rules for Merging Zoned Fabrics
	Table 6-1: Merging Fabrics - Results for Zone Configurations



	Configuring Zoning through the HAFM
	Using the Zoning Library
	Figure 6-3: Zoning Library dialog box
	Table 6-2: Zoning Configuration Limits for High Availability Fabric Manager
	Menus
	Table 6-3: Menu Options in Zoning dialog boxes

	Display Configured Zone Sets and Zones
	Configure Zones
	Figure 6-4: New Zone dialog box
	Figure 6-5: New Zone dialog box - Adding Zone Members
	Figure 6-6: Add Detached Nodes dialog box

	Configure Zone Sets
	Figure 6-7: New Zone Set dialog box
	Figure 6-8: New Zone Set dialog box - Adding Zones

	Modify Zones and Zone Sets
	Zones
	Zone Sets

	Copy Zones and Zone Sets
	Zones
	Zone Sets

	Delete Zones and Zone Sets
	Zones
	Zone Sets

	Rename Zones and Zone Sets
	Zones
	Zone Sets

	Import and Export Zone Sets
	Export Zone Set
	Import Zone Set
	Display Zone and Zone Set Properties
	Zones
	Figure 6-9: Zone Properties dialog box


	Zone Sets
	Figure 6-10: Zone Set Properties dialog box


	Find Zones
	Find Zone Members
	Figure 6-11: Find WWN/Nickname dialog box

	Closing the Zoning Library

	Activate Zone Sets
	Figure 6-12: Activate Zone Set dialog box
	Figure 6-13: Activate Zone Set (Differences) screen
	Table 6-4: Icons and Text Indicators for Zone Set Differences
	Figure 6-14: Activate Zone Set (Directors/Switches Affected) screen
	Deactivate Zone Sets
	Configure the Default Zone
	Show Zone Members
	Backing Up Zoning Configurations



	HAFM Logs
	Using Logs
	Sorting Logs
	Button Function
	Expanding Columns
	High Availability Fabric Manager Audit Log
	Figure 7-1: High Availability Fabric Manager Audit Log


	High Availability Fabric Manager Event Log
	Figure 7-2: High Availability Fabric Manager Event Log

	High Availability Fabric Manager Session Log
	Figure 7-3: High Availability Fabric Manager Session Log

	High Availability Fabric Manger Product Status Log
	Figure 7-4: High Availability Fabric Manager Product Status Log

	High Availability Fabric Manager Fabric Log
	Figure 7-5: High Availability Fabric Manager Fabric Log

	Export Log Files
	Figure 7-6: Save dialog box


	Optional Features
	FICON Management Server
	Installation
	Configuring the FICON Management Server
	Table 8-1: Available Code Pages
	Procedure
	Figure 8-1: Configure FICON Management Server dialog box


	Open Systems Management Server
	Installation
	Configuring the Open Systems Management Server
	Procedure
	Figure 8-2: Configure Open Systems Management Server dialog box




	SANtegrity Features
	Fabric Binding
	Enable/Disable and Online State Functions

	Switch Binding
	Configuring Switch Binding Overview
	Enable/Disable Switch Binding
	Figure 8-3: Switch Binding State Change dialog box

	Editing the Switch Membership List
	Figure 8-4: Switch Binding Membership List dialog box

	Enable/Disable and Online State Functions
	Zoning with Switch Binding Enabled


	Enterprise Fabric Mode
	Fabric Binding
	Switch Binding
	Rerouting Delay
	Domain RSCNs
	Insistent Domain Identification (ID)


	Information and Error Messages
	Table A-1: High Availability Fabric Manager Messages

	Configuring Remote Workstations: Windows Systems
	Requirements
	Procedure
	Figure B-1: Remote Client Installation screen
	Figure B-2: Security Warning page
	Figure B-3: InstallAnywhere Web Installer page
	Figure B-4: High Availability Fabric Manager Installer - Introduction screen
	Figure B-5: High Availability Fabric Manager Installer - License Agreement
	Figure B-6: High Availability Fabric Manager Installer - Important Information
	Figure B-7: High Availability Fabric Manager Installer - Choose Install Folder
	Figure B-8: High Availability Fabric Manager Installer - Choose Shortcut Location
	Figure B-9: High Availability Fabric Manager Installer - Pre-Installation Summary
	Figure B-10: Installing HP HAFM
	Figure B-11: High Availability Fabric Manager Installer - Install Complete
	Running the High Availability Fabric Manager


	Configuring Remote Workstations: Solaris Systems
	Requirements
	Procedure
	Figure C-1: HP HAFM page
	Figure C-2: Security Warning page
	Running the High Availability Fabric Manager


	Configuring Remote Workstations: HP-UX, AIX, and Linux
	Requirements
	Procedure
	Figure D-1: HP StorageWorks HAFM page
	Figure D-2: Security Warning page
	Running the High Availability Fabric Manager


	Glossary
	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Y
	Z


